Business Intelligence Launch Pad User Guide
# Table of Contents

1 Document history. ................................................................. 7

2 Getting started with the BI launch pad. ......................................................... 10
   2.1 Who should use this documentation. .................................................. 10
   2.2 What is the BI launch pad. ............................................................... 10
   2.3 What’s new in the BI launch pad ....................................................... 11
   2.4 Licensing ................................................................. 12
   2.5 Key concepts ................................................................. 12
   2.6 Key tasks ................................................................. 13
   2.7 Logging on to the BI launch pad ..................................................... 13

3 User interface. ............................................................................. 15
   3.1 Header panel ................................................................. 15
   3.2 Home tab ................................................................. 15
   3.3 Documents tab ................................................................. 16
      3.3.1 Toolbar ................................................................. 16
      3.3.2 Navigation panel ........................................................... 17
      3.3.3 Drawers ................................................................. 17
      3.3.4 List panel ................................................................. 18
      3.3.5 Details panel ............................................................... 18

4 Personal preferences. ................................................................ 20
   4.1 Setting general preferences .......................................................... 20
   4.2 Changing your password ............................................................... 21
   4.3 Preferred viewing locales ............................................................. 21
      4.3.1 Setting locale and time zone preferences ..................................... 22
   4.4 Setting Crystal report viewing preferences ........................................ 22
   4.5 Web Intelligence preferences .......................................................... 23
      4.5.1 Selecting a reading interface for Web Intelligence documents .............. 23
      4.5.2 Selecting a modification interface for Web Intelligence documents .......... 24
      4.5.3 Selecting a default universe for Web Intelligence documents ............. 24
      4.5.4 Selecting a formatting locale for Web Intelligence documents .......... 25
      4.5.5 Drill options for data in Web Intelligence documents ...................... 25
      4.5.6 Selecting an Excel format for Web Intelligence documents .................. 27
   4.6 Setting Analysis, edition for OLAP, preferences ........................................ 27
   4.7 Setting BI workspaces preferences .................................................. 28

5 Viewing objects. .......................................................................... 29
   5.1 Viewing an object ........................................................................ 29
   5.2 Refreshing an object .................................................................... 29
5.3 Viewing an historical instance ...................................................... 30
5.4 Pinning a tab for future viewing ................................................... 30
5.4.1 Unpinning a tab ................................................................. 30
5.5 Viewing Crystal reports ............................................................. 30
5.5.1 Crystal report viewers ........................................................... 31
5.5.2 Opening the group tree in a Crystal report viewer ....................... 37
5.5.3 Drilling on data in a Crystal report ........................................... 38
5.5.4 Viewing and editing parameters of Crystal reports in a web viewer .. 38
5.5.5 Viewing alerts in a Crystal report ............................................. 38
5.5.6 Printing Crystal reports ......................................................... 39
5.5.7 Exporting Crystal reports ...................................................... 39
5.5.8 Interactively sorting data in a Crystal report ................................. 40
5.6 Viewing Web Intelligence documents ............................................ 41
5.6.1 Web Intelligence viewer toolbar .............................................. 41
5.6.2 Opening the navigation map in a Web Intelligence document .......... 42
5.6.3 Showing user prompts in a Web Intelligence document .................. 42
5.6.4 Finding text in a Web Intelligence document ................................. 43
5.6.5 Drilling on data in a Web Intelligence document ............................ 43
6 Working with content objects ............................................................. 44
6.1 Organizing content objects with folders and categories ..................... 44
6.1.1 Creating a folder or category ................................................... 45
6.1.2 Setting the properties of a folder or category ................................ 46
6.1.3 Assigning a content object to a category .................................... 46
6.2 Setting mobile properties for an object .......................................... 46
6.3 Adding a document from your machine to the BI launch pad ............... 47
6.4 Replacing third-party source documents ........................................ 47
6.5 Sorting content objects in the BI repository .................................... 48
6.6 Filtering content objects in the BI repository .................................. 48
6.6.1 Removing a filter ............................................................... 49
6.7 Copying a content object ............................................................ 49
6.8 Moving a content object ............................................................ 49
6.9 Deleting a content object ........................................................... 49
6.10 Quick access to content objects .................................................. 50
6.10.1 Creating a shortcut to a content object ..................................... 50
6.10.2 Creating a hyperlink to a content object .................................... 50
6.11 Sharing content objects with recipients ....................................... 50
6.11.1 Sending a content object or an instance to a destination ............... 50
6.11.2 Creating an OpenDocument link to a content object ..................... 51
6.11.3 Creating a URL link to a public folder or a category ..................... 51
6.12 Searching for content objects ..................................................... 52
6.12.1 What the search looks for per content object ............................... 54
6.12.2 Search techniques .......................................................... 56
6.12.3 Finding a content object in the BI repository ................. 58

7 Scheduling objects .............................................................. 60
7.1 Scheduling an object ....................................................... 60
  7.1.1 Labeling a scheduled instance .................................. 60
  7.1.2 Selecting a recurrence pattern .................................. 61
  7.1.3 Specifying database logon information ...................... 63
  7.1.4 Selecting an instance format .................................... 63
  7.1.5 Selecting a destination ............................................. 68
  7.1.6 Applying a record selection formula ......................... 79
  7.1.7 Scheduling an object with parameters (prompts) ....... 80
  7.1.8 Scheduling an object with events ............................. 80
  7.1.9 Selecting the scheduling server group for an object .... 81
  7.1.10 Selecting a cache format for a Web Intelligence document 81
  7.1.11 Selecting print settings for a Crystal report ............ 82
  7.1.12 Selecting a language for Crystal report instances .... 83

8 Scheduling object packages ................................................... 84
8.1 Scheduling an object package ........................................ 84

9 Working with instances ......................................................... 85
9.1 Viewing the latest instance of an object .......................... 85
9.2 Viewing an historical instance of an object ..................... 85
9.3 Pausing or resuming an instance ................................... 86
  9.3.1 Pausing an instance ............................................... 86
  9.3.2 Resuming a paused instance .................................. 86
9.4 Deleting instances from your BI Inbox ............................ 86

10 About publishing ............................................................... 87
10.1 What is a publication ..................................................... 87
10.2 Access rights required for publishing ............................. 87
  10.2.1 Publishers and recipients: Who has rights to view what .. 91
10.3 Publishing concepts ....................................................... 91
  10.3.1 Report bursting .................................................... 91
  10.3.2 Delivery rules ..................................................... 92
  10.3.3 Dynamic recipients .............................................. 95
  10.3.4 Publication delivery destinations ............................ 96
  10.3.5 Publication formats ............................................. 101
  10.3.6 Personalization .................................................. 103
  10.3.7 Publication extensions ......................................... 105
  10.3.8 Subscriptions .................................................... 106
  10.3.9 PDF-file merging for Crystal reports ...................... 106
### 10.4 Publication results—how to view. ................................................... 107

### 11 Working with publications. ............................................................... 109

#### 11.1 Creating a publication in the BI launch pad. .................................... 109

#### 11.2 Creating a publication in the CMC. .................................................. 109

#### 11.3 Publications for Enterprise or dynamic recipients. ......................... 110
   - **11.3.1** Creating a publication for Enterprise recipients. .................. 110
   - **11.3.2** Creating a publication for dynamic recipients. .................... 111

#### 11.4 Publications for SAP recipients. ................................................... 112

#### 11.5 Publications for Live Office. ......................................................... 113

#### 11.6 Designing publications. ................................................................. 113
   - **11.6.1** Opening a publication. ........................................................... 113
   - **11.6.2** Defining general properties for a publication. ...................... 114
   - **11.6.3** Adding source documents. .................................................... 114
   - **11.6.4** Selecting a destination for a publication. .............................. 114
   - **11.6.5** Selecting a recurrence pattern. ............................................ 121
   - **11.6.6** Selecting personalized placeholders for publication source documents. ........................ 124
   - **11.6.7** Selecting personalized placeholders for email fields. ............ 124
   - **11.6.8** Embedding content from a dynamic source document in an email. ........................ 125
   - **11.6.9** Designing Crystal reports. .................................................... 125
   - **11.6.10** Designing Web Intelligence documents. ................................. 137
   - **11.6.11** Optional publication tasks. .................................................. 138

#### 11.7 Running publications and working with published instances. ........... 143
   - **11.7.1** Testing a publication. ........................................................... 143
   - **11.7.2** Scheduling a publication to run. ............................................ 143
   - **11.7.3** Subscribing to or unsubscribing from a publication. ............... 144
   - **11.7.4** Viewing publications sent to the Default Enterprise Location. ... 145
   - **11.7.5** Viewing publications sent to a BI Inbox. ................................ 145
   - **11.7.6** Redistributing a publication instance. ..................................... 146
   - **11.7.7** Retrying a failed publication. ............................................... 146

#### 11.8 Publication performance. .............................................................. 147
   - **11.8.1** Recommendations for adding source documents. .................. 149
   - **11.8.2** Recommendations for using dynamic recipient sources. ........... 150
   - **11.8.3** Recommendations for sending and receiving email publication instances. ... 151

### 12 Collaboration. .................................................................................. 152

#### 12.1 Collaboration column ................................................................. 152
   - **12.1.1** Icons in the Collaboration column. ................................. 153
   - **12.1.2** Showing the Collaboration column. .................................... 153
   - **12.1.3** Hiding the Collaboration column. ....................................... 153

#### 12.2 Feed panel .................................................................................. 153
   - **12.2.1** Collaboration drawer. ......................................................... 154
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.2.2</td>
<td>Opening the feed panel</td>
<td>154</td>
</tr>
<tr>
<td>12.2.3</td>
<td>Resizing the feed panel</td>
<td>155</td>
</tr>
<tr>
<td>12.3</td>
<td>Access rights for collaboration applications</td>
<td>155</td>
</tr>
<tr>
<td>12.4</td>
<td>Displaying an SAP StreamWork custom home page</td>
<td>155</td>
</tr>
<tr>
<td>12.5</td>
<td>Document feeds</td>
<td>156</td>
</tr>
<tr>
<td>12.5.1</td>
<td>Refreshing a feed</td>
<td>156</td>
</tr>
<tr>
<td>12.5.2</td>
<td>Following a feed</td>
<td>156</td>
</tr>
<tr>
<td>12.5.3</td>
<td>Viewing collaboration comments for an instance on a new tab</td>
<td>156</td>
</tr>
<tr>
<td>12.5.4</td>
<td>Viewing collaboration comments via an OpenDocument link</td>
<td>157</td>
</tr>
<tr>
<td>12.5.5</td>
<td>Posting a comment to a feed</td>
<td>158</td>
</tr>
<tr>
<td>12.5.6</td>
<td>Stopping following a feed</td>
<td>158</td>
</tr>
<tr>
<td>12.6</td>
<td>Scheduling content to SAP StreamWork</td>
<td>158</td>
</tr>
<tr>
<td>12.7</td>
<td>Sending content to SAP StreamWork</td>
<td>159</td>
</tr>
<tr>
<td>13</td>
<td>Alerting</td>
<td>161</td>
</tr>
<tr>
<td>13.1</td>
<td>Alerting concepts</td>
<td>161</td>
</tr>
<tr>
<td>13.1.1</td>
<td>Alert sources</td>
<td>162</td>
</tr>
<tr>
<td>13.1.2</td>
<td>Differences between alerting and Crystal report alert notifications</td>
<td>162</td>
</tr>
<tr>
<td>13.1.3</td>
<td>Alerting workflow</td>
<td>163</td>
</tr>
<tr>
<td>13.1.4</td>
<td>Access rights required for alerting</td>
<td>164</td>
</tr>
<tr>
<td>13.1.5</td>
<td>Alert source objects</td>
<td>165</td>
</tr>
<tr>
<td>13.1.6</td>
<td>Alert notifications</td>
<td>166</td>
</tr>
<tr>
<td>13.2</td>
<td>Subscribing to an alert</td>
<td>166</td>
</tr>
<tr>
<td>13.2.1</td>
<td>Unsubscribing from an alert</td>
<td>167</td>
</tr>
<tr>
<td>13.3</td>
<td>Subscribing other users to an alert</td>
<td>167</td>
</tr>
<tr>
<td>13.4</td>
<td>Excluding users from an alert</td>
<td>168</td>
</tr>
<tr>
<td>13.5</td>
<td>Managing custom alerting settings for an alert source</td>
<td>168</td>
</tr>
<tr>
<td>14</td>
<td>Applications and the BI launch pad</td>
<td>170</td>
</tr>
<tr>
<td>14.1</td>
<td>Working with applications in the BI launch pad</td>
<td>170</td>
</tr>
<tr>
<td>14.2</td>
<td>Starting an application in the BI launch pad</td>
<td>170</td>
</tr>
<tr>
<td>14.3</td>
<td>BEx web applications in the BI launch pad</td>
<td>170</td>
</tr>
<tr>
<td>14.3.1</td>
<td>Accessing BEx web applications in the BI launch pad</td>
<td>171</td>
</tr>
<tr>
<td>14.3.2</td>
<td>Saving BEx web applications as bookmarks</td>
<td>171</td>
</tr>
<tr>
<td>15</td>
<td>Working with discussions</td>
<td>172</td>
</tr>
<tr>
<td>15.1</td>
<td>Opening the Discussions drawer</td>
<td>172</td>
</tr>
<tr>
<td>15.2</td>
<td>Adding a note</td>
<td>172</td>
</tr>
<tr>
<td>15.3</td>
<td>Editing a note</td>
<td>173</td>
</tr>
<tr>
<td>15.4</td>
<td>Replying to a note</td>
<td>173</td>
</tr>
<tr>
<td>15.5</td>
<td>Deleting a note</td>
<td>173</td>
</tr>
</tbody>
</table>
## 1 Document history

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| SAP BusinessObjects Business Intelligence Platform 4.1 | May, 2013 | - Support for SAP Jam was added. When integrated, SAP Jam adds social media and collaboration features to the BI launch pad.  
- Additional collaboration access rights were added for users and groups. The collaboration feed panel includes a drop-down list of instances and times and a button for following or unfollowing a feed. Automatically follow all related instances when you follow a template document in SAP Jam or SAP StreamWork. Comments on instances are posted only for the instance.  
- You can open OpenDocument links to documents and instances on a tab or via the link. When viewing a document or instance via an OpenDocument link, open the SAP StreamWork feed panel to monitor or reply to a document feed.  
- An Add File Extension check box was added to the Destinations dialog box. |
| SAP BusinessObjects Business Intelligence Platform 4.1 Support Package 1 | August, 2013 | This guide was updated to include the following information:  
You can run one session of the BI launch pad at a time. Use tabs (or windows, depending on your configuration) to view multiple objects and applications. |
<p>| SAP BusinessObjects Business Intelligence Platform 4.1 Support Package 2 | November, 2013 | Information about subscribing to scheduled publications and publication instances was added. |</p>
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| SAP BusinessObjects Business Intelligence Platform 4.1 Support Package 3 | March, 2014| • A Folder Link option was added to the context menu for public folders and categories. It generates a URL link for the folder or category that you can send to recipients.  
• Information was added about using the DHTML web viewer for online access to Crystal reports via the Central Management Console (CMC) in the BI platform.  
• Instructions were added about designing publications for dynamic recipients and for Enterprise recipients.  
• A reminder was added that the BI launch pad displays preferences configured for only one user group, regardless of the number of user groups a user belongs to in the platform. |
| SAP BusinessObjects Business Intelligence Platform 4.1 Support Package 4 | May, 2014  | • The "Opening a report in a larger viewing area" topic was removed from this guide.  
• Web Intelligence documents based on BEx queries can contain mandatory variables in SAP Business Warehouse (SAP BW) data sources. The "Scheduling an object with parameters (prompts)" topic was revised to include information about Web Intelligence documents based on BEx queries.  
• The "Scheduling an object" topic was revised to include information about contexts in Web Intelligence documents.  
• SAP Design Studio content objects open on a tab in the same window as the BI launch pad. |
### Version History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
</table>
| SAP BusinessObjects Business Intelligence Platform 4.1 Support Package 5 | October, 2014| • In "Output file formats for instances" section, for **Web Intelligence file formats** table, updated the **Format** and **Notes** Columns  
• Added a Note in "Searching for content objects" section  
• Added "Analysis Office" and "Lumira document" as new object types in "What the search looks for per content object" section  
• Added new information (about Lumira documents) in "Viewing Objects" section. |
2 Getting started with the BI launch pad

This documentation provides information about and instructions for using the SAP BusinessObjects Business Intelligence (BI) platform and the BI launch pad.

The BI launch pad runs in a web browser and is the main interface for working with objects in the BI platform. You can log on to one session of the launch pad at a time. (That is, you cannot run multiple sessions of the launch pad in separate browser tabs or windows.)

Your administrator may deploy different types of objects, such as Crystal reports and Web Intelligence documents, that are created from platform plug-in components. You use the launch pad to view, organize, and work with the objects.

Because the appearance and functionality of the launch pad can be customized, your user interface may be different from images shown in this documentation. Depending on your configuration, you can usually apply the information to your user interface.

2.1 Who should use this documentation

This documentation is intended for users who work with objects over the web in the BI platform and the BI launch pad.


2.2 What is the BI launch pad

The BI launch pad is a web application that acts as a window to business information about your company.

You use the launch pad to perform the following tasks:

- Access and organize Crystal reports, Web Intelligence documents, and other objects
- View information in a web browser, export it to other business applications (such as Microsoft Excel or SAP Jam), and save it to a specified location
- Use analytic tools to explore business information in detail

Features of the launch pad vary by content type, and the applications available in the launch pad depend on your access rights. For information about the features of your BI platform deployment, contact your system administrator.
2.3 What's new in the BI launch pad

SAP Jam

SAP Jam was added as a collaboration option for the BI launch pad. When integrated, SAP Jam adds social media and collaboration features to the launch pad.

Collaboration improvements

With the addition of SAP Jam, the BI launch pad supports two collaboration options. Your administrator must configure your collaboration application in the Central Management Console (CMC) in the BI platform, before you can use it.

The following enhancements are supported by both collaboration applications:

- New viewer options
- Improved integration with the BI launch pad
- New access rights
- Add comments to a feed when opening a document or instance via an OpenDocument link

Open the details panel in any viewer

You can open the details panel from anywhere in the BI launch pad—and in a viewer when using an OpenDocument link.

Automatically add file extensions when scheduling

When scheduling reports and publications, the Add File Extension check box in the Destinations dialog box automatically adds the file extension to a file name. The check box is selected by default to ensure that each file name has a file extension. (If a file name does not have a file extension, you may be unable to open the document.)

You can also add a file-extension placeholder when scheduling to the following destination locations:

- BI Inbox
- Email
- FTP server
- File system
2.4 Licensing

Each type of user license in the BI platform grants or restricts access to particular tasks and applications. Depending on which license you have, you may be unable to access some applications or to perform some tasks in the BI repository.

The platform supports the following types of user licenses:

- BI Viewer
- BI Analyst
- Concurrent user
- Named user

To determine which license you have, contact your system administrator.


2.5 Key concepts

Familiarize yourself with key concepts in the BI launch pad. Depending on which tasks you perform, some concepts may not apply to you.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objects</td>
<td>An object is a document or file created in the BI platform or other software that is stored and managed in the platform repository.</td>
</tr>
<tr>
<td>Categories</td>
<td>A category is an organizational alternative to a folder. Use categories to label objects.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>Scheduling is the process of automatically running an object at a specified time. Scheduling refreshes dynamic content or data in an object, creates instances, and distributes the instances to users or stores them locally.</td>
</tr>
</tbody>
</table>
| Events    | An event is an object that represents an occurrence in the BI platform system. Events can be used for the following purposes:  
  - As scheduling dependencies that trigger actions after a scheduled job runs  
  - To trigger alert notifications  
  - To monitor the performance of the platform |
### Calendars
A calendar is a customized list of run dates for scheduling jobs.

### Instances
An instance is a snapshot of an object that contains data from the time an object was run.

### Publishing
Publishing is the process of making personalized dynamic content publicly available for mass consumption.

### Profiles
A profile is an object that associates users and groups with personalization values. Profiles are used with publishing to create personalized content and distribute it to recipients.

### Alerting
Alerting is the process of notifying users and administrators when events occur in the BI platform.

## 2.6 Key tasks
Depending on your user license and access rights, you can perform the following tasks in the BI launch pad:

- View objects
- Add objects
- Modify and manage the objects you add
- Distribute content to users
- Collaborate on content with SAP Jam or SAP StreamWork
- Set personal preferences for the launch pad user interface

## 2.7 Logging on to the BI launch pad
You can log on to only one session of the BI launch pad. (It is not possible to run multiple sessions of the launch pad in separate browser tabs or windows.)

Before you can log on to the launch pad, you must have Microsoft Internet Explorer, Firefox, or Safari (for Macintosh users) installed on your computer.

1. In a web browser, enter the URL for the launch pad.
   
   The URL should be `http://<WebServer>:<PortNumber>/BOE/BI/`, where `<WebServer>` is the name of the web server for the BI platform and `<PortNumber>` is the port number for the platform.

   If your system administrator has configured a custom URL for the launch pad, you may need to ask the administrator for the name of the web server, the port number, or the URL to enter.
If you have BI platform client tools installed on a Windows operating system, select Start > Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Java BI Launch Pad.

By default, you do not need to enter a system name. However, some Enterprise systems may require it.

2. If prompted, in the System box, enter the name of your Central Management Server (CMS).

3. In the User name box and the Password box, enter your logon credentials.
   By default, you are not prompted to choose an authentication type. However, some Enterprise systems may require it.

4. If prompted, in the Authentication list, select an authentication type.
   Enterprise authentication is the default authentication method. LDAP, Windows AD, Windows NT, and other third-party authentication types require a special configuration. If you are unsure of which authentication type to use, contact your system administrator. For information about authentication types, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

5. Click Log On.

The launch opens with the default Home tab displayed.
3 User interface

When you open an object or an application, it appears on a tab. Multiple tabs (that is, multiple objects and applications) can be open at one time in the BI launch pad.

3.1 Header panel

The header panel displays the name of the user account that is logged on to the BI launch pad and contains system menus.

The header panel contains the following menus:

- The Applications menu provides access to plug-in applications for the launch pad (such as BI workspaces). The applications available depend on your access rights.
- The Preferences menu provides options for configuring how information appears in the launch pad. These preferences override the default preferences set in the Central Management Console (CMC), until the BI platform is updated. (Updates to the platform reset all options to the default values.)
- The Help Menu menu provides access to the BI Launch Pad Help and the About dialog box that contains product information.
- A Log Off button that you click to quit the launch pad.

3.2 Home tab

You use the Home tab to manage documents and BI launch pad features. The default Home tab includes the following areas:

- My Recently Viewed Documents lists the last 10 documents that you viewed, sorted by view date, with the most recently viewed document at the top.
- Unread Messages in My Inbox lists the 10 most recent unread messages in your BI Inbox. To view all messages, click See More in the lower-right corner of the module.
- My Recently Run Documents lists the last 10 documents in the repository that you scheduled or ran, with the status of each document instance. To view successful instances or details of failed instances, click an instance link.
- Unread Alerts shows the last 10 unread alert notifications. To view all alert notifications, click See More in the lower-right corner of the module.
- My Applications provides quick access to the applications in the BI launch pad.

Your document viewing preferences may be set to open objects in windows instead of on tabs.
Custom home tabs

System administrators can create custom home tabs for users and groups that include objects such as a customized dashboard, a frequently used Crystal report, a web site, or the SAP Jam module. If you have the appropriate access rights, you can select a custom home tab in your BI launch pad preferences.

SAP Jam or SAP StreamWork custom home tab

If you have the appropriate access rights, you can select a SAP Jam or SAP StreamWork custom home tab in your BI launch pad preferences.

3.3 Documents tab

Use the Documents tab to view and to manage objects in the BI repository.

Your document viewing preferences may be set to open objects in windows instead of on tabs.

3.3.1 Toolbar

Use the toolbar buttons to view and to manage objects.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View menu</td>
<td>Use this menu to view objects, the latest instance of an object, and object properties.</td>
</tr>
<tr>
<td>New menu</td>
<td>Use this menu to upload documents and create the following types of new objects:</td>
</tr>
<tr>
<td></td>
<td>● Local documents</td>
</tr>
<tr>
<td></td>
<td>● Publications</td>
</tr>
<tr>
<td></td>
<td>● Hyperlinks</td>
</tr>
<tr>
<td></td>
<td>● Folders</td>
</tr>
<tr>
<td></td>
<td>● Categories</td>
</tr>
<tr>
<td>Organize menu</td>
<td>Use this menu to manage object shortcuts, to cut, copy, paste, and delete objects (for example, messages), and to replace static documents (for example, Microsoft Word, Adobe PDF, and Microsoft Excel files) with a new version of the document.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Send menu</td>
<td>Use this menu to send a document or instance to a destination. The available destinations depend on your BI launch pad configuration.</td>
</tr>
<tr>
<td>More Actions menu</td>
<td>Use this menu to perform the following tasks:</td>
</tr>
<tr>
<td></td>
<td>● Schedule objects</td>
</tr>
<tr>
<td></td>
<td>● View the history of an object</td>
</tr>
<tr>
<td></td>
<td>● Add objects to categories</td>
</tr>
<tr>
<td></td>
<td>● View categories that objects belong to</td>
</tr>
<tr>
<td></td>
<td>● Create OpenDocument links to objects</td>
</tr>
<tr>
<td></td>
<td>● Follow documents (if collaboration is enabled in the Central Management Console in the BI platform)</td>
</tr>
<tr>
<td></td>
<td>The available actions vary, depending on the object type and on your access rights.</td>
</tr>
<tr>
<td>Details button</td>
<td>Click this button to show or to hide the details panel for a document.</td>
</tr>
<tr>
<td></td>
<td>Alternately, you can click &lt; on the left edge of the details panel to expand it. The button changes to &gt; when the panel is expanded. Click &gt; to minimize the details panel.</td>
</tr>
<tr>
<td></td>
<td>When the BI launch pad is integrated with SAP Jam or with SAP StreamWork, the panel is called the feed panel.</td>
</tr>
</tbody>
</table>

### 3.3.2 Navigation panel

The navigation panel provides a top-level view of folders and categories in the BI platform.

### 3.3.3 Drawers

Drawers are expandable panes on the navigation panel and on the details panel.

Click a drawer to expand or to minimize it. (Depending on your access rights, you may be unable to view some objects in drawers.) The following drawers are available on the navigation panel:

- The **My Documents** drawer contains the user's **My Favorites** folder, **BI Inbox**, **My Alerts** folder, **Subscribed Alerts** folder, and personal categories.
- The **Folders** drawer displays a folder view of the repository.
- The **Categories** drawer displays a category view of the repository.
- The **Search** drawer displays search options and results.

The following drawers are available on the details panel:
3.3.4 List panel

The list panel displays a list view of the objects in a folder or a category.

3.3.5 Details panel

The details panel contains drawers that display summary information about an object. You click a drawer to access the information in the drawer.

The Summary drawer on the details panel displays the following information about an object:

- Owner
- Description
- Object type
- Number of instances
- Last run date (for objects that can be scheduled)

If SAP Jam or SAP StreamWork is integrated with the BI launch pad, the panel is called the feed panel and includes a Collaboration drawer. Click the drawer to view feeds and to add comments for a document.

By default, discussions are disabled in the launch pad. However, if discussions are enabled and view rights are assigned to objects and associated notes, the Discussions drawer is available on the details panel. Click the Discussions drawer to show posted comments about a document. To enable discussions, contact your system administrator.

3.3.5.1 Opening the details panel

You can open the details panel from anywhere in the BI launch pad and when viewing a document via an OpenDocument link.

If collaboration with SAP Jam or SAP StreamWork is enabled for the launch pad, the details panel is called the feed panel.

Click < on the left edge of the details panel.
You can also click Details on the toolbar.

The details panel appears, with the Summary drawer open. You can click a document or instance to display its summary information. If SAP Jam or SAP StreamWork is integrated with the launch pad, a Collaboration drawer appears instead. If discussions are enabled, a Discussions drawer appears instead.
3.3.5.2 Resizing the details panel

You can resize the details panel from anywhere in the BI launch pad.

When the launch pad is configured for SAP Jam or for SAP StreamWork, this panel is called the feed panel.

Click the left edge of the panel, and drag it to the width you want.

3.3.5.3 Closing the details panel

You can close the details panel from anywhere in the BI launch pad and when viewing a document via an OpenDocument link.

Click > on the left edge of the details panel.
You can also click Details on the toolbar.
4 Personal preferences

Your personal preferences determine how you log on to the BI launch pad, which views appear, and which settings apply to viewed objects.

The access rights assigned by your system administrator determine whether you can set your own preferences. Before you start using the launch pad, check whether your preferences have been set—and configure them, if needed.

Note
If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the “Change preferences for objects that the user owns” right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

4.1 Setting general preferences

BI launch pad general preferences determine what appears in the default view of the software.

Your administrator configures default values for preferences in the Central Management Console (CMC) in the BI platform. You can optionally modify some preferences in the BI launch pad. However, if the administrator updates the default preferences for your user group in the CMC, the launch pad reverts to those preferences.

Note
If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the “Change preferences for objects that the user owns” right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click Preferences. The Preferences dialog box appears, showing general preference options.
2. In the Preferences dialog box, click General.
3. Clear the Use Default Settings (Administrator defined) check box.
   To restore the default BI launch pad preferences set in the CMC by your administrator (and apply any updates implemented after you customized BI launch pad preferences), select Use Default Settings (Administrator defined). The options in the Preferences dialog box revert to their default values and are read-only.
4. Choose the view to display when the launch pad starts:
   a) To display the Home tab, select Home tab, and choose one of the following options:
      - To choose the default view that your administrator configured, select Default Home tab. If your administrator did not configure a default BI launch pad view, the BI platform Home tab is used.
      - To choose a custom view, select Select Home tab, click Browse Home tab, choose a tab in the Select a Custom Home tab dialog box, and click Open. If a BI workspaces view was created for SAP Jam or SAP StreamWork, it is listed in the Select a Custom Home tab dialog box.
   b) To display the Documents tab, select Documents tab, and select the drawer and folder to open by default.
You can select the My Documents, Folders, or Categories drawer. For example, if you want the My Documents drawer to open to your BI Inbox when you log on, select My Documents and My Inbox.

5. Under Choose columns displayed in Documents tab, select which column headings to display in the summary information, for each object.
   For example, to display a column for SAP Jam or SAP StreamWork collaboration, select the Collaboration / Discussion Status check box.

6. Under Set document viewing location, choose whether to open documents on a new browser tab or in a new browser window.

7. In the Set the maximum number of items per page box, enter the maximum number of objects to display per page when viewing a list of objects.

8. Click Save & Close.

4.2 Changing your password

You must have appropriate access rights to change passwords. If you have access rights but cannot change your password, contact your system administrator.

Note
If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the “Change preferences for objects that the user owns” right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click Preferences.
2. In the Preferences dialog box, click Change Password.
3. In the Old Password box, enter your old password.
4. In the New Password box, enter your new password.
5. In the Confirm New Password box, enter your new password again.
6. Click Save & Close.

4.3 Preferred viewing locales

The preferred viewing locale (PVL) determines how dates, times, and numbers are formatted in the BI launch pad.

For multilingual objects, the PVL also sets the language used to display an object's name and description. If an object has multiple translated names and descriptions, the display language is determined as follows:

1. The system displays the name and description that correspond to the user’s PVL. The BI platform may use a default fallback locale, but it is typically a variation of the user’s PVL. For example, if the PVL is French (Canada) and the object does not have a translated name and description in Canadian French, the platform will use French (France).
2. If no PVL is set, the platform displays the name and description in the same language as the product locale.
3. If option 1 or 2 is not feasible, the platform displays the name and description in the object’s source language.

4.3.1 Setting locale and time zone preferences

Select the locale and PVL to ensure that scheduled objects are processed in the time zone you are working in.

Before scheduling objects, check the time zone selected for the BI launch pad. The default time zone is local to the web server that is running the BI platform, not to the Central Management Server (CMS) computer that your machine connect to.

**Note**

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the “Change preferences for objects that the user owns” right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click Preferences.
2. In the Preferences dialog box, click Locales and Time Zone.
3. In the Product Locale list, select a language for the launch pad user interface.
   This option determines in which language the names and descriptions of multilingual objects will appear when viewing objects.
4. In the Preferred Viewing Locale list, select a locale.
   This option determines the formatting convention used for dates, numbers, and time when viewing objects.
5. In the Current Time Zone list, select your time zone.
6. Click Save & Close.

4.4 Setting Crystal report viewing preferences

**Note**

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the “Change preferences for objects that the user owns” right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click Preferences.
2. In the Preferences dialog box, click Crystal Reports in the navigation list.
3. Under Select a default view format, select a viewer for displaying Crystal reports:
   - Web (no downloading required)
     Use this viewer for reports created in Crystal Reports. It does not download files and will work without Java or ActiveX.
   - Web ActiveX (ActiveX required)
4. If you selected the Web (no downloading required) viewer, under Select printing control (for Web), perform one of the following actions:
   ○ Select PDF one-click printing (Adobe Acrobat required) to export reports to PDF for printing. If a report has Flash objects, you must export the report to a PDF file before it can be printed.
   ○ Select ActiveX one-click printing (ActiveX required) to print reports from the viewer. You must install a small ActiveX component.

5. If you selected the Web (no downloading required) viewer, under Select a rendering resolution (for Web), choose a viewing resolution.

6. Under Select a default measuring unit, select Inches or Millimeters.

7. Select the Show SAP Variable Technical Name (SAP Crystal Reports 2011 only) check box to display the technical names of SAP variables when working with reports in SAP Crystal Reports 2011 format.

8. Click Save & Close.

4.5 Web Intelligence preferences

4.5.1 Selecting a reading interface for Web Intelligence documents

All reading interfaces, except PDF, have view and design modes. Use the view mode to perform basic viewing tasks and the design mode to modify a document.

All reading interfaces have similar features and capabilities. The only difference is that some of them require a downloaded component.

Note

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the ’Change preferences for objects that the user owns” right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click Preferences.
2. In the Preferences dialog box, click Web Intelligence.
3. Under View, choose a reading interface:
   ○ Select HTML (no download required) to view documents over the Internet, without downloading components.
   ○ Select Applet (download required) to view documents with a Java applet that must be downloaded.
   ○ Select Desktop (Rich Client, Windows only, installation required) (installation required) to view documents with a desktop application that must be downloaded. Select this option if you plan to work offline occasionally.
   ○ Select PDF to view documents in PDF.
4. Click **Save & Close**.

### 4.5.2 Selecting a modification interface for Web Intelligence documents

Use the modification interface to create and/or edit Web Intelligence documents.

All modification interfaces have similar features and capabilities. The only difference is that some of them require a downloaded component.

**Note**

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the "Change preferences for objects that the user owns" right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click **Preferences**.
2. In the Preferences dialog box, click **Web Intelligence**.
3. Under **Modify (creating, editing and analyzing documents)**, choose a modification interface:
   - Select **HTML (no download required)** to create and modify documents over the Internet, without downloading components.
   - Select **Applet (download required)** to create and modify documents with a Java applet that must be downloaded.
   - Select **Desktop (Rich Client, Windows only, installation required)** (installation required) to create and modify documents with a desktop application that must be downloaded. Select this option if you plan to work offline occasionally.
4. Click **Save & Close**.

### 4.5.3 Selecting a default universe for Web Intelligence documents

Select a universe as the default data source for creating Web Intelligence documents.

**Note**

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the "Change preferences for objects that the user owns" right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click **Preferences**.
2. In the Preferences dialog box, click **Web Intelligence**.
3. Under **Select a default Universe**, click **Browse**, and select a universe.
4. Click **OK**, and click **Save & Close**.

© 2014 SAP SE or an SAP affiliate company. All rights reserved.
4.5.4 Selecting a formatting locale for Web Intelligence documents

The preferring viewing locale (PVL) determines how dates, times, and numbers are formatted in Web Intelligence documents.

Note

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the “Change preferences for objects that the user owns” right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click Preferences.
2. In the Preferences dialog box, click Web Intelligence.
3. Under When viewing a document, choose a locale:
   - Select Use the document locale to format the data to retain the locale used when a document was created.
   - Select Use my preferred viewing locale to format the data to use your PVL.
4. Click Save & Close.

4.5.5 Drill options for data in Web Intelligence documents

Drilling on a document filters which data appears in it. You can specify how Web Intelligence documents behave when you drill up or drill down on data.

When you start the drill mode, the drill toolbar appears at the top of a document and displays the value(s) that you drill on. Each table, chart, or free-standing cell in a document represents a specific block of data. When a document has multiple blocks of data, you can drill on a single block or on all of the blocks at the same time.

The following examples drill on a table to analyze detailed results per service line and to show how each drilling option affects the document. In the first example, Synchronize drill on report blocks is selected. Both the table and the chart display the drilled values:

<table>
<thead>
<tr>
<th>Service Line</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accommodation</td>
<td>$673,564.00</td>
</tr>
<tr>
<td>Food &amp; Drinks</td>
<td>$169,680.00</td>
</tr>
<tr>
<td>Recreation</td>
<td>$129,100.00</td>
</tr>
</tbody>
</table>
In the second example, **Synchronize drill on report blocks** is not selected. The drill is performed only on the selected block, and only the table displays the drilled values:

<table>
<thead>
<tr>
<th>Service Line</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accommodation</td>
<td>$573,664.00</td>
</tr>
<tr>
<td>Food &amp; Drinks</td>
<td>$169,880.00</td>
</tr>
<tr>
<td>Recreation</td>
<td>$120,100.00</td>
</tr>
</tbody>
</table>

You must have the necessary access permissions to drill out of the scope of analysis in a drill session. For example, when you drill on results in a document, you may want to drill to higher-level or lower-level information than is included in the scope of the document. This requires a new query to retrieve additional data from the data source, and you will be prompted to decide whether to run the additional query. For example, if you drill on year 2001, the results on the drilled table are for Q1, Q2, Q3, and Q4 of 2001. This means the quarterly values that you drilled to are filtered by 2001. The **drill** toolbar displays “2001,” the value that filters the drilled results.

You can use the **drill** toolbar to select other values and filter the results differently. For example, if you use the **drill** toolbar to select “2002,” the results on the drilled table will be for Q1, Q2, Q3, and Q4 of year 2002.

If a drilled report includes dimensions from multiple queries, when you point the cursor at a value on the filter, a tooltip indicates the name of the query and the dimension for the value.

### 4.5.5.1 Setting drill options for Web Intelligence documents

**Note**

If the **Preferences** menu is not available on the header panel in the BI launch pad, you do not have the "Change preferences for objects that the user owns" right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click **Preferences**.
2. In the **Preferences** dialog box, click **Web Intelligence**.
3. Under **View**, select either **HTML (no download required)** or **Desktop (Rich Internet, Windows only, installation required)** (installation required).
4. Under **Drill options**, choose general options for drilling on data:
   a) To be prompted when a drill action requires a new query to add data to a document, select **Prompt when drill requires additional data**.
      
      When prompted, you may be able to apply filters to the extra dimensions in the new query. The filters restrict the size of a query to the data necessary for your analysis.
   b) To synchronize drilling on all report blocks, select **Synchronize drill on report blocks**.
To hide the drill toolbar when you switch to drill mode, select *Hide Drill toolbar on startup*. Select this option when filters are not needed.

5. **Under Start drill session**, choose an option to apply to drill sessions:
   a) **To retain a copy of the original document so that you can compare drilled results to the original data**, select *On duplicate report*. A duplicate of the original report is created. When you quit drill mode, both the original report and the drilled report remain in the document for viewing.
   b) **To drill on the current report so that it is modified by your drill actions**, select *On existing report*. When you end drill mode, the report displays the drilled values.

6. Click *Save & Close*.

### 4.5.6 Selecting an Excel format for Web Intelligence documents

The Microsoft Excel format determines the appearance of data in Web Intelligence document instances, when scheduling and exporting the documents to Excel.

**Note**

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the "Change preferences for objects that the user owns" right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click *Preferences*.
2. In the Preferences dialog box, click *Web Intelligence*.
3. **Under Select a priority for saving to MS Excel**, choose an option:
   - To display data in a format that is similar to Web Intelligence, select *Prioritize the formatting of the documents*.
   - To display data in a text format, select *Prioritize easy data processing in Excel*.
4. Click *Save & Close*.

### 4.6 Setting Analysis, edition for OLAP, preferences

**Note**

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the "Change preferences for objects that the user owns" right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. Log on to the BI launch pad.
2. On the header panel, click *Preferences*. 
3. In the Preferences dialog box, click **Analysis edition for OLAP** in the navigation list.

4. Select the **Accessibility Mode** check box to use a screen reader with the OLAP edition of the SAP BusinessObjects Analysis software.

5. Click **Save & Close**. The Preferences Changed dialog box appears, indicating that some changes will take place after the page reloads.

6. Click **OK**.

The next time you use Analysis, edition for OLAP, it will use a screen reader.

### 4.7 Setting BI workspaces preferences

**Note**

If the Preferences menu is not available on the header panel in the BI launch pad, you do not have the “Change preferences for objects that the user owns” right assigned in the Central Management Console (CMC) in the BI platform. To request access, contact your system administrator.

1. On the header panel, click **Preferences**.

2. In the Preferences dialog box, click **BI workspaces**.

3. Under **BI workspaces**, in the Default style sheet to use when creating a new workspace list, select a page format to apply to new BI workspaces.

4. Under **Backgrounds for style sheets**, in the Select a style sheet list, select a style sheet to apply to new BI workspaces.

5. To select a background image, select the **Image** check box, click **Change Image** , and locate and select the image.

   Image files must be smaller than 2 MB. Image formats can be JPG, GIF, or PNG.

6. To select a background color, select the **Color** check box, and enter the color information.

7. Repeat steps 3 to 6 for each style sheet that will be used to create new BI workspaces.

8. Click **Save & Close**.

Before you can edit a BI workspace, you must open the workspace on a tab in the BI launch pad.
5 Viewing objects

Use the Documents tab in the BI launch pad to view and edit objects.

When you double-click an object, it opens on a new tab. From there, you can open the document in a new window, if necessary.

When you view a Crystal report or a Web Intelligence document, your access rights and the default settings configured by your administrator determine which data you see. You can view report data from the source, in the latest instance of an object, or in a report’s saved data. Depending on your access rights, you may be able to refresh a report or a document with new data from its source.

The way that you view an object determines which information you see. For example:

- When you double-click an object to view dynamic content (for example, a Crystal report or a Web Intelligence document), the latest instance of the document opens. If the latest instance is unavailable, the object itself opens.

- When you select View View, the object opens.

- When you select View View Latest Instance, the latest object instance opens.

- When you view a publication or a program object, the launch pad displays the object properties, if the latest instance is unavailable.

- You can access Lumira documents (.lums) in BI launch pad. However, to view these Lumira documents, you need to have SAP Lumira Desktop 1.21 installed.

If an option is not available, you do not have access rights to that option.

5.1 Viewing an object

If an object has dynamic content (for example, a Crystal report or a Web Intelligence document), the latest instance of the document opens when you view an object.

If the latest instance is unavailable, the object itself opens. If the latest instance of a publication or program object is unavailable, the object properties open.

On the Documents tab, locate and double-click the object to view.

5.2 Refreshing an object

Refreshing an object enables you to view data on demand. However, refreshing may use a considerable amount of system resources.

Before you can refresh data in an object, you must have refresh rights for the object, and the server must contain the data source information.

As a rule, refresh objects only when data has changed.
5.3 Viewing an historical instance

Historical instances open on a new tab.

1. Right-click the object to view an instance for, and select **History**.
2. In the **History** dialog box, double-click the instance.

5.4 Pinning a tab for future viewing

You can pin a document or instance that you frequently view to a tab.

Before pinning a tab, BI launch pad preferences must be configured to enable tabbed document viewing.

1. Perform one of the following actions to open an object or instance:
   - To open an object, right-click the object or instance and select **View**.
   - To open the latest instance of an object, right-click the object or instance and select **View Latest Instance**.
   - To open an older instance of an object, right-click the object and select **History**, and then select the instance in the **History** dialog box.

   The object or instance opens on a new tab.

2. Click ![pin icon](image) in the upper-right corner of the tab to pin it.

   The icon on the ![pinning button](image) button points down, indicating that the tab is pinned. The document or instance automatically opens on a tab the next time you log on to the launch pad.

5.4.1 Unpinning a tab

When pinned, the icon on the toolbar button points down.

To unpin a tab, click ![unpin icon](image) in the upper-right corner of the tab. When unpinned, the icon on the toolbar button points sideways.

5.5 Viewing Crystal reports

When you click a Crystal report, the report appears in a viewer.

The type of viewer you have determines which tasks you can perform.
5.5.1  Crystal report viewers

Use Crystal report viewers to view reports, navigate multiple pages, refresh data, drill down to details behind charts and summarized data, select parameters, print, and export data.

Crystal report viewers support ActiveX, Java, and web-only viewing formats. Typically, your system administrator selects the viewer type that is best suited to your company’s needs. However, you can manually select a viewer in the BI launch pad preferences. Some features of Crystal report viewers may be disabled by your administrator. For more information, contact your administrator.

You can use Crystal report viewers to display reports even when you are not logged on to the BI platform.

For online access to Crystal reports through the Central Management Console (CMC), use the default DHTML web viewer. Do not use the legacy Java viewer, which does not provide the same functionality as the DHTML viewer.

5.5.1.1  Web viewer

Use this viewer to view, refresh, and print reports, edit parameters, and export reports to a variety of formats.

You can access the web viewer in a browser, without downloading a plug-in. It is the only Crystal report viewer that can access the parameter panel or that displays SAP Crystal Reports for Enterprise reports.

For online access to Crystal reports through the Central Management Console (CMC), use the default DHTML web viewer. Do not use the legacy Java viewer, which does not provide the same functionality as the DHTML viewer.

5.5.1.1.1  Web viewer toolbar

<table>
<thead>
<tr>
<th>Toolbar option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File menu</td>
<td>Use this menu to open a Crystal report from the BI repository, send a report to a recipient, create a shortcut in the My Favorites folder, schedule a report, and view report history.</td>
</tr>
<tr>
<td>Previous/Next</td>
<td>Click to go to the previous page in a Crystal report or to go to the next page.</td>
</tr>
<tr>
<td>Print</td>
<td>Click to print a Crystal report.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click to refresh a Crystal report to the most current data from the report’s data source.</td>
</tr>
<tr>
<td>Export</td>
<td>Click to export a Crystal report to your computer or to a location on a network.</td>
</tr>
<tr>
<td>Toolbar option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Previous Page" /> <img src="image" alt="Next Page" /></td>
<td>Click <img src="image" alt="Previous Page" /> to go to the previous page in a Crystal report or <img src="image" alt="Next Page" /> to go to the next page, select <strong>Go to First Page</strong> and <strong>Go to Last Page</strong> in the list to go to the first or last page in a report, or enter a page number in the box to go to that page.</td>
</tr>
<tr>
<td><img src="image" alt="Percentage" /></td>
<td>Select a percentage in the list to zoom or reduce text in a Crystal report by that percentage.</td>
</tr>
<tr>
<td><img src="image" alt="Group Tree" /></td>
<td>Click to display the group tree, which you use to navigate through data in a Crystal report.</td>
</tr>
<tr>
<td><img src="image" alt="Parameter Panel" /></td>
<td>Click to show or hide the parameter panel, which you use it to change data in a report and to configure how data is displayed. You can access the parameter panel only in the web viewer.</td>
</tr>
</tbody>
</table>

### 5.5.1.2 Web ActiveX viewer

Use this viewer to view, refresh, and print reports and to export reports to various formats.

The web ActiveX viewer can be used with Microsoft Internet Explorer versions that support ActiveX controls. You must download and install the ActiveX component. If ActiveX is not installed, you cannot use this viewer. For assistance, download ActiveX or contact your system administrator.
5.5.1.2.1  Web ActiveX viewer toolbar

<table>
<thead>
<tr>
<th>Toolbar option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Export Icon" /></td>
<td>Click to export a Crystal report to your computer or to a location on a network.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Print Icon" /></td>
<td>Click to print a Crystal report.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Group Tree Icon" /></td>
<td>Click to show or hide the group tree, which you use to navigate through data in a Crystal report.</td>
</tr>
<tr>
<td>Toolbar option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Previous Page" /></td>
<td>Click to go to the previous page in a Crystal report or to go to the next page. Select <strong>Go to First Page</strong> and <strong>Go to Last Page</strong> in the list to go to the first or last page in a report, or enter a page number in the box to go to that page.</td>
</tr>
<tr>
<td><img src="image" alt="Stop Loading" /></td>
<td>Click to stop loading a Crystal report.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Click to refresh a Crystal report to the most current data from the report’s data source.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Enter text in the box, and click <img src="image" alt="Search" /> to search for the text in a Crystal report.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td>Select a percentage in the list to zoom or reduce text in a Crystal report by that percentage.</td>
</tr>
</tbody>
</table>

### 5.5.1.3 Web Java viewer

Use this viewer to view, refresh, and print reports and to export reports to a variety of formats.

You can access the web Java viewer in any browser that supports Java Virtual Machine. Some browsers may experience minor issues when scrolling through reports in the web Java viewer. The issues are due to the implementation of Java Virtual Machine. If your browser experiences problems, repeatedly click the scroll buttons to scroll—do not hold down the scroll buttons.

For online access to Crystal reports through the Central Management Console (CMC), use the default DHTML web viewer. Do not use the legacy Java viewer, which does not provide the same functionality as the DHTML viewer.
5.5.1.3.1 **Web Java viewer toolbar**

<table>
<thead>
<tr>
<th>Toolbar option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Printer icon" /></td>
<td>Click to print a Crystal report.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh icon" /></td>
<td>Click to refresh a Crystal report to the most current data from the report’s data source.</td>
</tr>
<tr>
<td><img src="image" alt="Download icon" /></td>
<td>Click to export a Crystal report to your computer or to a location on a network.</td>
</tr>
<tr>
<td><img src="image" alt="Stop icon" /></td>
<td>Click to stop loading a Crystal report.</td>
</tr>
<tr>
<td><img src="image" alt="Tree icon" /></td>
<td>Click to show or hide the group tree, which you use to navigate through data in a Crystal report.</td>
</tr>
<tr>
<td>Toolbar option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Click a button to go to a page in a Crystal report:  
   - Click to go to the first page.  
   - Click to go to the previous page.  
   - Click to go to the next page.  
   - Click to go to the last page. | |
| Displays the number of pages in a Crystal report. To go to a particular page in a report, enter the page number in the box. | |
| Click to search for text in a Crystal report. | |
| Select a percentage in the list to zoom or reduce text in a Crystal report by that percentage. | |

### 5.5.1.4 Crystal Reports viewer 2011

Use SAP Crystal Reports viewer 2011 to view downloaded Crystal reports, without connecting to the BI platform.

SAP Crystal Reports viewer 2011 is installed on your computer automatically. Use it to perform the following tasks:

- Print or export reports
- Save reports
- Select data to view
- Drill down on data in reports
- View multiple reports

SAP Crystal Reports viewer 2011 functions the same as Crystal report viewers in the BI launch pad. For more information about SAP Crystal Reports viewer 2011, see the SAP Crystal Reports Viewer 2011 Help.

### 5.5.1.4.1 Installing Crystal Reports viewer 2011

When you install the Crystal Reports viewer 2011, it resides as a client-software viewer on your computer.

This task applies only to the English-language version of the www.sap.com web site.

2. In the Search box on the web page, search for Crystal Reports Viewer.
3. In the search results, double-click the first result called **SAP Crystal Reports Viewer**.
The SAP Crystal Reports viewer web page appears, with a **Download Now** link on the right side of the page.

4. Download and run the SAP Crystal Reports Viewer 2011 installation program.

5. Follow the on-screen instructions, accepting the default values.

6. Click **Finish**.

SAP Crystal Reports viewer 2011 opens when you double-click a Crystal report (.rpt) file on your computer. However, if SAP Crystal Reports is installed on your computer, it takes precedence over SAP Crystal Reports viewer 2011 and displays reports by default.

### 5.5.1.4.2 Crystal Reports viewer 2011 toolbar

<table>
<thead>
<tr>
<th>Toolbar option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cloud icon" /></td>
<td>Click to export a Crystal report to your local computer or to a location on a network.</td>
</tr>
<tr>
<td><img src="image" alt="Printer icon" /></td>
<td>Click to print a Crystal report.</td>
</tr>
<tr>
<td><img src="image" alt="Folder and arrow icon" /></td>
<td>Click to show or hide the group tree, which you use to navigate through data in a Crystal report.</td>
</tr>
<tr>
<td><img src="image" alt="Page break icon" /></td>
<td>Click <img src="image" alt="Page break icon" /> to go to the previous page in a Crystal report or <img src="image" alt="Page break icon" /> to go to the next page. Select <strong>Go to First Page</strong> and <strong>Go to Last Page</strong> in the list to go to the first or last page in a report, or enter a page number in the box to go to that page.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh icon" /></td>
<td>Click <img src="image" alt="Refresh icon" /> to refresh a Crystal report to the most current data from the report’s data source.</td>
</tr>
<tr>
<td><img src="image" alt="Search icon" /></td>
<td>Enter text in the box, and click <img src="image" alt="Search icon" /> to search for the text in a Crystal report.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom icon" /></td>
<td>Select a percentage in the list to zoom or reduce text in a Crystal report by that percentage.</td>
</tr>
</tbody>
</table>

### 5.5.2 Opening the group tree in a Crystal report viewer

Use the group tree to navigate through data in a Crystal report.

Click ![Folder and arrow icon](image) on the left side of the web viewer.
5.5.3 Drilling on data in a Crystal report

You can drill on a Crystal report to see the data under charts and summarized groups.

In a Crystal report viewer, double-click a link in a report.

5.5.4 Viewing and editing parameters of Crystal reports in a web viewer

You must use a web viewer to view and edit parameters in Crystal reports.

1. Locate and select the Crystal report to view.
2. Select View ➤ View.
3. If prompted to enter report values, enter the values.
   You must enter report values before you can view the report.
4. Select the data to view, and click OK.
5. To select the parameters to access in the report, click .
   The parameter panel displays the report parameters.
6. Select a parameter.
7. To edit the parameter value, perform either of the following actions:
   ○ On the parameter panel, enter a new value.
   ○ Click > to open an editing dialog box, enter a new value, and click OK.
8. Edit the remaining parameters as needed.
9. To view the report with the new parameter values, click Apply.

5.5.5 Viewing alerts in a Crystal report

You can view alerts for a Crystal report in the Central Management Console (CMC).

1. Go to the Folders management area of the CMC.
2. Locate the folder or category that contains the Crystal report to view, and select the report.
   The Alerts dialog box appears, displaying the instances that triggered the alert.
4. Double-click an instance title to open an instance.
5.5.6 Printing Crystal reports

You can print successful instances of Crystal reports and of reports viewed on demand.

Depending on the Crystal report viewer you use, the steps in this task may vary. However, the general instructions for printing reports are the same. If on-screen instructions are provided, follow them instead of performing this task.

Note
The person who designs a report chooses the page orientation. You cannot change it in the Print dialog box.

1. Open the document to print.
2. On the viewer toolbar, click .
3. In the Print dialog box, under Print range, select All or enter the page range to print.
4. Under Copies, enter the number of copies to print.
   Select the Collate check box to print pages in numerical order. For example, if you are printing two copies of a four-page report, your report prints pages one, two, three, and four of the first copy and then prints pages one, two, three, and four of the second copy.
5. (Web viewer and web ActiveX viewer) Under Printer Paper, select the paper size and the paper source options.
6. (Web viewer and web ActiveX viewer) Under Options, if a Crystal report is wide but should print on one page, click Fit Horizontal Pages to One Page.
7. To print Flash objects embedded in a Crystal report, select Print Flash Objects for Current Page.
8. Click OK.

5.5.7 Exporting Crystal reports

You can export successful instances of Crystal reports and of reports viewed on demand to multiple formats.

For reports that you can drill down on, export the drilled-down view. For example, you can export data that predicts sales trends to an Excel spreadsheet and then email it to the sales team.

1. Open the Crystal report to view.
2. On the viewer toolbar, click .
3. In the Export dialog box, in the File Format list, select a file format to export the Crystal report to.
4. Under Page Range, select All Pages or enter the range of pages to export.
5. Click Export.
5.5.7.1 Export format options

You can export Crystal reports to these file formats.

When you export a Crystal report to a file format other than .rpt, the report may lose some or all of its formatting. The BI launch pad attempts to preserve as much formatting as each export format allows.

Flash objects only appear if you export to a Crystal report format (.rpt or .rptr) or to .pdf. Fallback images appear when exporting to all other formats. For information about scheduling a Crystal report to a specific format, see exporting information in the SAP Crystal Reports 2011 User Guide.

<table>
<thead>
<tr>
<th>File format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal Reports</td>
<td>.rpt format. You cannot export to this file format from a drilled-down view.</td>
</tr>
<tr>
<td>Crystal Reports (RPTR)</td>
<td>.rptr format. This read-only file format attempts to preserve the appearance of the original Crystal report.</td>
</tr>
<tr>
<td>Microsoft Excel (97-2003)</td>
<td>.xls format</td>
</tr>
<tr>
<td>Microsoft Excel (97-2003) (Data Only)</td>
<td>.xls format. This file format is data-only.</td>
</tr>
<tr>
<td>Microsoft Word (97-2003)</td>
<td>.doc format</td>
</tr>
<tr>
<td>PDF</td>
<td>.pdf format</td>
</tr>
<tr>
<td>Rich Text Format (RTF)</td>
<td>.rtf. This file format can be displayed only in the web viewer.</td>
</tr>
<tr>
<td>Microsoft Word - Editable (RTF)</td>
<td>.doc format. This file format preserves less formatting than the Microsoft Word (97-2003) format. Text appears in lines, and images are placed inline with text.</td>
</tr>
<tr>
<td>Separated Values (CSV)</td>
<td>.csv format</td>
</tr>
<tr>
<td>XML</td>
<td>.xml format</td>
</tr>
</tbody>
</table>

5.5.8 Interactively sorting data in a Crystal report

1. Open a Crystal report that uses interactive sorting.
2. Select the value to sort on.
3. Click an arrow to sort data in the report:
   - To sort data in ascending order, click ➝.
   - To sort data in descending order, click ➞.
5.6  Viewing Web Intelligence documents

When you open a Web Intelligence document, the document appears in a viewer. Depending on the type of viewer and the functions enabled by your system administrator, you can perform different activities in the viewer.

The following sections provide information about the Web Intelligence toolbar and instructions for working with the navigation map, displaying user prompts, finding text, and drilling down on data in documents. For instructions on performing analysis on Web Intelligence documents, see the Web Intelligence documentation.

5.6.1  Web Intelligence viewer toolbar

<table>
<thead>
<tr>
<th>Toolbar option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Intelligence menu</td>
<td>Use this menu to show or hide parts of the BI launch pad user interface. You can select the Filter Bar, Outline, Side Panel (Normal, Minimized, or Off), Report Tabs, and Status Bar launch pad options.</td>
</tr>
<tr>
<td>![File icon]</td>
<td>Click to create a new Web Intelligence document.</td>
</tr>
<tr>
<td>![Open icon]</td>
<td>Click to open a Web Intelligence document for viewing.</td>
</tr>
<tr>
<td>![Save icon]</td>
<td>Use this menu to save changes to a Web Intelligence document to various file formats, with a new name, locally on your computer.</td>
</tr>
<tr>
<td>![PDF icon]</td>
<td>Click to create a PDF version of a Web Intelligence document for printing.</td>
</tr>
<tr>
<td>![Search icon]</td>
<td>Click to search for text in a Web Intelligence document.</td>
</tr>
<tr>
<td>![Date icon]</td>
<td>Click to show the dates for Web Intelligence document instances.</td>
</tr>
<tr>
<td>![Export icon]</td>
<td>Use this menu to export a Web Intelligence document, the current report, or data to your computer in the format you choose. You can export a document or the current report to PDF, Excel, Excel 2007, or text format or export data to CSV format.</td>
</tr>
<tr>
<td>![Send icon]</td>
<td>Use this menu to send a Web Intelligence document to an email address, to a particular user, or via an FTP server. The available destinations vary, depending on how the BI launch pad is configured.</td>
</tr>
<tr>
<td>![Undo icon]</td>
<td>Click to undo the previous action.</td>
</tr>
<tr>
<td>![Redo icon]</td>
<td>Click to redo the previous action.</td>
</tr>
</tbody>
</table>
### 5.6.2 Opening the navigation map in a Web Intelligence document

Use the navigation map to locate reports in a Web Intelligence document.

1. Open the Web Intelligence document that contains the reports you want to locate.
2. On the viewer toolbar, select `Web Intelligence > Side Panel > Normal`.
3. On the side panel, click 📁.

The navigation map appears on the side panel.

### 5.6.3 Showing user prompts in a Web Intelligence document

Click the **user prompt input** icon to gather user information in a Web Intelligence document.

The information that prompts gather from users may determine which data appears in a Web Intelligence document. For example, in a document used by sales, a prompt may ask users to choose a region. When a user chooses a region, the document includes results for that region instead of results for all regions in the document.

1. Open the Web Intelligence document that contains user prompts.
2. On the viewer toolbar, click `Web Intelligence > Side Panel > Normal`.
3. On the side panel, click 🌐.

The **User Prompt Input** pane appears on the side panel.
5.6.4 Finding text in a Web Intelligence document

1. Open the Web Intelligence document that contains the text to locate.
2. On the viewer toolbar, click \( \text{Search Bar} \). The Search Bar panel appears under the document.
3. In the search box, enter the text to locate.
4. Click the arrow on the icon, and select Ignore case or Match case.
5. Click \( \text{beside the search box.} \)
6. (Optional) Click Find Previous to search for the previous occurrence or Find Next to search for the next occurrence.

5.6.5 Drilling on data in a Web Intelligence document

You can drill on data to see the information beneath charts and summarized groups in Web Intelligence documents.

1. Open the Web Intelligence document that contains the data to drill on.
2. On the viewer toolbar, select \( \text{Drill} \) Start Drill Mode, and click the link to drill on.
3. Once the viewer is in drill mode, select \( \text{Drill} \) Snapshot to take a photograph of the drilled view and open it on a new tab.
4. To apply filters to your view of the document, click Filter Bar on the viewer toolbar, and set the filters.
5. Select \( \text{Drill} \) End Drill Mode.
6 Working with content objects

All documents and files in the BI platform—hyperlinks, shortcuts, Crystal reports, and Web Intelligence documents—are considered objects.

The platform uses folders and categories to organize objects. Objects must belong to one folder, but they can be assigned to no or several categories. Folders and categories can be either public (that is, corporate) or personal. The BI launch pad users with appropriate access rights can view public folders and categories and add and edit objects in public folders and categories.

Personal categories and your My Favorites folders are for your use; you can create new folders and categories and arrange objects in them as needed. Personal categories and your My Favorites folders are private and cannot be viewed or altered by other BI launch pad users, but your administrator can edit them.

The platform allows you to send objects and instances (or shortcuts to objects and instances) to other users via a BI Inbox, an email address, an FTP server, an activity in SAP Jam or SAP StreamWork, or a default file location. (Available locations may vary, depending on what your system administrator has enabled.) You send objects from the Documents tab when you browse or view a document, and you send instances from an object's history. To view objects that have been sent to you, on the Documents tab, expand the My Documents drawer, and click My Inbox.

Tip
You can right-click an object title to access all actions that you can perform on the object. For example, to view the history of an object, right-click the object and select History.

You must have appropriate access rights before you can create objects in and add objects to the BI launch pad. Depending on which access rights your system administrator assigned to you, you may be unable to access some folders and categories. For example, your administrator may disable categories if they are not used in your company.

6.1 Organizing content objects with folders and categories

The BI platform supports both public and personal folders and categories.

Public folders and categories (accessible to all users) are typically created by a system administrator. Depending on your access rights, you may be able to create personal folders and categories in the BI launch pad. You create personal folders under the My Favorites folder.
Public folders are created by the administrator or by users who have appropriate access rights. If you have the appropriate rights, you can create public folders that contain objects viewable by other users who have the appropriate rights.

To view public folders, expand the Folders drawer.

You can create any number of folders under My Favorites to organize objects. The folders you create are available when you expand the My Documents drawer and click My Favorites. You can add objects to your My Favorites folders, create shortcuts to or copies of objects in public folders, and create objects.

You are the only user with access to your My Favorites folders in the launch pad, although administrators can manage them.

Corporate categories are typically created by the administrator or by users who have appropriate access rights. If you have the appropriate rights, you can create corporate categories. To view corporate categories, expand the Categories drawer.

You can create any number of personal categories to organize your objects. The categories you create are available when you expand the My Documents drawer and click Personal Categories.

### 6.1.1 Creating a folder or category

1. On the Documents tab, go to the location where you want to create a folder or category:
   - To create a personal folder, expand the My Documents drawer, and click My Favorites.
   - To create a public folder, expand the Folders drawer.
   - To create a personal category, expand the My Documents drawer, and click Personal Categories.
   - To create a corporate category, expand the Categories drawer.
2. Select [New Folder] or [New Category].
3. When prompted, enter a name for the new folder or category.
4. Click OK.

After the folder or category is created, you can add objects to it, if you have appropriate access rights to the object(s).
6.1.2  Setting the properties of a folder or category

You can edit the properties of folders and categories that you created or for which you have access rights. You can change the folder or category name, description, and keyword properties. (You use keywords to search for folders and categories.)

1. On the **Documents** tab, locate the folder or category to set properties for:
   - To edit the properties of a personal folder, expand the **My Documents** drawer, and click **My Favorites**.
   - To edit the properties of a public folder, expand the **Folders** drawer.
   - To edit the properties of a personal category, expand the **My Documents** drawer, and click **Personal Categories**.
   - To edit the properties of a corporate category, expand the **Categories** drawer.

2. Select the folder or category, and select **View**  **Properties**.

3. (Optional) In the **Properties** dialog box, edit the folder name, description, and keywords.

4. Click **OK**.

6.1.3  Assigning a content object to a category

1. Go to the folder that contains the content object to assign to a category.

2. Select the object, and select **More Actions**  **Categories**.

3. In the **Categories** dialog box, choose categories to assign the object to.
   - To expand a category, click the plus sign (+) beside the category name.

4. Click **OK**.

6.2  Setting mobile properties for an object

You must have appropriate access rights to an object before you can change the mobile properties for the object. To view a BI Inbox document on mobile devices, you must set the properties before sending the document to a BI Inbox.

1. On the **Documents** tab, expand the **Folders** drawer, and locate the object for which to set mobile properties.

2. Right-click the object and select **Mobile Properties**.

3. (Optional) In the **Mobile Properties** dialog box, perform any of the following actions:
   - To view the object on mobile devices, select the **Display on mobile** check box.
   - To view the object while you are connected to Mobile server, select the **Disable saving on mobile** check box.
     - You cannot save a local copy of a document.
   - To view Web Intelligence documents in page layout mode on mobile devices, select the **Designed for mobile** check box.
4. (Optional) To view the object in PDF on mobile devices, select the Display document as a PDF on the supported mobile devices check box.

5. In the Time to Live box, enter the number of days the object should be available on mobile devices before it expires.

6. Click Save & Close.

6.3 Adding a document from your machine to the BI launch pad

You must have appropriate access rights before you can add objects to the BI launch pad.

For example, a business analyst creates a report on how a recent merger affected sales and needs to share it with the rest of the company. The business analyst can add the report to the platform so that everyone in the company with appropriate access rights can view it.

1. On the Documents tab, expand the Folders drawer, and select the folder to add a document to. The folder contents are displayed.

2. Select New Local Document.

3. In the New Local Document in dialog box, beside the File Name box, click Browse to locate the document to add, and select the document. The file name of the document appears in the Title box.

4. (Optional) Enter a description and keywords for the document.

5. If the document is a Crystal report:
   a) To retain the report summary information, click Use description from report.
   b) To retain the report’s saved data, click Keep saved data.

6. (Optional) In the MIME box, enter the MIME type of the file.

7. (Optional) Under Select one or more categories to add the object to, choose a category to assign the document to.

   You can add a document to more than one category or to no category at all. Depending on your access rights, you may be unable to add the document to some categories.

8. Click Add.

6.4 Replacing third-party source documents

A third-party (also called “agnostic”) source document does not originate in the BI launch pad. For example, it may be a Microsoft Word, Adobe PDF, or Microsoft Excel file.

Before you can replace a third-party source document, you must have Edit access rights for the document.

Although you cannot update the content of third-party documents, you can replace a third-party document with a more recent version of it. This enables you to view the latest source information in documents that originate outside of the launch pad.
1. Right-click a third-party document and select **Organize > Replace File**.

   If the **Replace File** menu option is unavailable for a third-party document, you do not have Edit rights for the document.

2. In the **Replace File** dialog box, click **Browse**, and select a more recent version of the source document file on your computer.

   If a message appears, stating that the file does not match the source document’s file format, you have chosen a file in a different format than the original source document. Click **OK** to close the message, and then click **Browse**, and select the correct source document.

3. Click **Replace**.

4. In the confirmation message, click **OK** to update the third-party document.

### 6.5 Sorting content objects in the BI repository

By default, content objects are sorted alphabetically by title, but you can sort the objects by other criteria.

To sort content objects in ascending order by a particular column, click the column heading.

Click the column heading again to sort the objects in descending order.

### 6.6 Filtering content objects in the BI repository

By default, when you view the contents of a folder or a category, the BI launch pad displays all content objects that you have access rights to view. Content objects are sorted alphabetically by title, but you can filter them by column heading.

To filter content objects by data you choose, point to the column heading that you want to base the filter on. A **funnel** icon appears in the column heading. Click the icon to configure the filter options, which vary for each column.

1. On the **Documents** tab, point to the column heading to filter on, and click the icon in the heading.

   The filter options for that column appear.

2. Configure filter options as needed:

   ○ To filter by title, in the **Title** column, enter an object title in the text box, and click **OK**.

   ○ To filter by object type, in the **Type** column, select the check box for each object type(s) to view, and click **OK**.

   ○ To filter by the time when the object last ran, in the **Last Run** column, select the start time and the end time, and click **OK**.

   ○ To filter by the object creator, in the **Created By** column, select **Everyone** or **Me**, and click **OK**.

   ○ To filter by the time when the object was created, in the **Created On** column, select the start time and the end time, and click **OK**.

Only filtered content objects in the folder or category appear.
6.6.1 Removing a filter

Click on the column heading that the view is filtered on, select the Clear Filter check box, and click OK.

For example, if your view is filtered by object type, click on the Type column, select the All Types check box, and click OK.

6.7 Copying a content object

You can copy content objects and save the copies in folders that you have access rights to. This enables you to edit a new object while keeping the original version of the object.

The Copy command copies objects to a clipboard; it does not create a copy of the object in the same folder.

1. On the Documents tab, expand the Folders drawer, and select the content object to copy.
   To simultaneously copy multiple objects, hold down the Ctrl or Shift key and click objects to select them.
2. Select Organize > Copy.
   The object is copied to a clipboard.
3. Locate and select the folder where you want to put the copy.
4. Select Organize > Paste.

6.8 Moving a content object

1. On the Documents tab, expand the Folders drawer, and select the content object to move.
2. Select Organize > Cut.
   The object is copied to the clipboard.
3. Locate and select the folder where you want to put the object.
4. Select Organize > Paste.
   The content object exists only in the folder where you pasted it. Shortcuts to the object continue to function properly.

6.9 Deleting a content object

You must have appropriate access rights before you can delete objects.

1. On the Documents tab, select the content object to delete.
2. Select Organize > Delete.
3. When prompted for confirmation, click **OK**.

6.10 Quick access to content objects

6.10.1 Creating a shortcut to a content object

To save navigation time, create shortcuts to frequently viewed content objects.

For example, to create a shortcut to a frequently viewed object in your **My Favorites** folder, right-click the object and select | Organize | Create Shortcut In My Favorites |

1. On the **Documents** tab, expand the **Folders** drawer.
2. Right-click the object to create a shortcut to and select | Organize | Copy Shortcut |
3. Right-click the folder where you want to put the shortcut and select | Organize | Paste Shortcut |

6.10.2 Creating a hyperlink to a content object

To save time, create hyperlinks to frequently viewed documents in the **My Favorites** folder, on the **My Documents** drawer.

1. On the **Documents** tab, expand the **Folders** drawer.
2. Right-click the folder to create a hyperlink to and select | New | Hyperlink |
3. In the **Hyperlink** dialog box, click | General Properties |
4. Enter a title, a description, and keywords for the hyperlink.
5. Click **URL**, and enter the URL of the web page to create a hyperlink to.
   For example, enter | http://www.sap.com |
6. (Optional) Click **Categories**, and choose one or more categories to assign the hyperlink to.
7. Click **OK**.

6.11 Sharing content objects with recipients

6.11.1 Sending a content object or an instance to a destination

You can send an object or instance to a destination, without running the object to create new instances or refreshing data for a report instance.

You can send instances with a status of Success or Failed. (Instances with a status of Recurring or Pending are scheduled but do not contain data.) You can send a copy of or a shortcut to the object or instance, and you can
select the destination—for example, an FTP server or a BI Inbox. (Not all types of objects can be sent to all destinations.) If you are viewing an object or an instance on a tab, you can send the object or instance from that tab.

1. On the **Documents** tab, locate the object or the instance to send.
2. Select the object or instance:
   - To send an object, right-click the object and select **Send**, click a destination location, and set the destination options.
   - To send an instance, select the object that contains the instance, right-click the object and select **History**, select one or more instances in the **History** dialog box, and click **Send**.
3. Press **SHIFT** + click or **CTRL** + click to select multiple objects.
4. Click **Send**.

### 6.11.2 Creating an OpenDocument link to a content object

OpenDocument links provide a direct link to a content object so that recipients do not need to navigate folders or categories.

When a recipient clicks an OpenDocument link in a browser, the BI launch pad logon dialog box appears. After the recipient enters valid logon credentials, the document opens.

1. On the **Documents** tab, right-click the document to send and select **Document Link**.
   - An OpenDocument link is generated, and the **Document Link** dialog box appears. The link that you created appears in the **Link** box.
2. Copy the OpenDocument link, and click **OK** to close the **Document Link** dialog box.

Paste the copied OpenDocument link in an email message to send to recipients.

### 6.11.3 Creating a URL link to a public folder or a category

URL links provide a direct link to a public folder or a category in the BI launch pad. (URL links are not available for the **My Favorites** folder because it is a private folder.)

Recipients must have access rights to a folder or category in order to open its URL link.

When a recipient opens a URL link in a browser, the BI launch pad logon dialog box appears. After entering valid logon credentials, the recipient is directed to the folder or category. If the **Folders or Categories** drawer is not available in the navigation list, the recipient does not have access rights to the drawer. By default, a URL link to either drawer will go to **My Favorites** in the **My Documents** drawer. When a URL link goes to **Public Folders** in the **Folders** drawer or to **Corporate Categories** in the **Categories** drawer, the recipient does not have access rights to a specific folder or category. In both cases, recipients should contact a system administrator. When a URL link to a folder in **Public Folders** is created but the recipient doesn’t have access rights to **Public Folders**, an notification dialog box appears, and the URL link defaults to the **My Favorites** folder.

1. On the **Documents** tab, expand the **Folders or Categories** drawer, and locate the folder or category to create a URL link for.
2. Right-click the folder or category and select *Folder Link*. A URL link is generated for the folder or category, and the *Folder Link* dialog box appears. The URL link that you created appears in the *Link* box.

3. Copy the URL link, and click *OK* to close the dialog box.

4. You can share the copied URL link with recipients.

### 6.12 Searching for content objects

The search in the BI launch pad starts looking for matches as you enter search text, suggests an alternate spelling for search text, proposes documents when no results are found, and groups long lists of results.

The following facets may appear in the *Search* drawer and provide filtered views of the search results:

- **Location**
- **Type**
- **Refresh Time**
- **Author**
- **Data Source**

If a search generated more than five facets, click *More* to view the remaining facets. Facet grouping by object type may include objects of other types. For example, if you view search results under the Crystal report facet, the results may show a Crystal report, a PDF document, and a Word document of the same name. This behavior occurs because the other objects are instances of the same Crystal report.

**Note**

When working in Hebrew or Arabic locale, if you search for content objects in BI launch pad, the search result does not display facets.

#### Search string recognition as you type

You can search for a user or user group by typing part or all of a user name, full name, or email address. As you type, the search looks for results that match words in the search text. Matches to search text are based on an object’s keyword, title, description, owner information, and content. Search results appear in the *Search* drawer, and you can view them at any time. For example, when scheduling to the *BI Inbox* destination, you can enter a user’s full name in the *Find title* box to quickly locate the user in the *Available Recipients* list.

#### Suggestions for alternate spelling

The BI platform suggests an alternate spelling for search text when the text was misspelled or produced no results and a suggested search term will provide successful matches. The alternate spelling is determined by substituting search words with similarly spelled words in the platform. For example, if you search for "Euroe sales trent," the platform recognizes the misspelled words and provides a suggestion of "Europe sales trend."
This functionality does not apply to text in Chinese, Japanese, or Korean.

**Suggested query**

The BI platform automatically suggests documents based on your search text. When running a search, if no documents contain the search text or no results were found, the platform suggests documents that may meet your search criteria. Suggested documents are in the format of an Web Intelligence document only.

The platform selects documents to suggest by interpreting your search input and comparing it to the structure of universes and data in existing documents. For example, if you search for "Mexico sales 2006," the search may see that "sales" is a measure in a universe that houses sales data for your company; that the field "country" is equal to "Mexico" in another document; or that "2006" is a predefined filter—and use the information to filter data. BI platform then creates a document using data from the universe and filters it identified. You can then view and edit the new document.

Click **Run Query** to view and save the generated document, or click **Edit Query** to open the document and further refine the query.

**Matched word highlighting**

When the search text matches words in an object’s title or description, matched words appear in bold type.

**Facets and search result grouping**

Facet grouping by report field is available only for Crystal reports and Web Intelligence documents.

When a search produces many results, the BI platform classifies the result information in facets (that is, groups). You can select a facet and view search results for it. Search results are classified in the following facets:

- Document type
- Public category
- Data in reports
- Aspects of the report content

Each facet is assigned objects that appear in search results. For example, the public category facet might include three objects: HR reports, legal documents, and sales reports. You can search for "2006 sales by employee" and then click the sales reports object in the search results to see only results for sales reports in the public category facet.

Facets are generated from metadata and document content. Content-based facets are based on fields or variables in documents. For example, if the "product" variable is used in many sale reports, the search creates a facet for it. You can refine the search by product name to see only results related to that product.

After refining a search, you can view the results or further refine the results by selecting options from other facets. The current refinements appear at the top of the search refinement panel.
Facet grouping by object type may include objects of other types, such as instances. For example, if you view search results under a Crystal report facet, the results may show a Crystal report, a PDF document, and a Word document with the same name. This behavior occurs because the other objects are instances of the same Crystal report.

**Search result ranking**

Each object in the search results is assigned a score ranging from one to five bars, based on its relevance to the search text. A score of five bars indicates an object is a strong match, and a score of one bar indicates a weak match.

**Related Information**

*What the search looks for per content object* [page 54]  
*The BI launch pad search looks for particular object types and for particular content within those object types.*  
*Search techniques* [page 56]

### 6.12.1 What the search looks for per content object

The BI launch pad search looks for particular object types and for particular content within those object types.

<table>
<thead>
<tr>
<th>Object type</th>
<th>Searchable content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal report</td>
<td>• Titles</td>
</tr>
<tr>
<td></td>
<td>• Descriptions</td>
</tr>
<tr>
<td></td>
<td>• Selection formulas</td>
</tr>
<tr>
<td></td>
<td>• Saved data</td>
</tr>
<tr>
<td></td>
<td>• Text fields</td>
</tr>
<tr>
<td></td>
<td>• Parameter values</td>
</tr>
<tr>
<td></td>
<td>• Subreports</td>
</tr>
<tr>
<td>Web Intelligence document</td>
<td>• Titles</td>
</tr>
<tr>
<td></td>
<td>• Descriptions</td>
</tr>
<tr>
<td></td>
<td>• Universe filter names</td>
</tr>
<tr>
<td></td>
<td>• Saved data</td>
</tr>
<tr>
<td></td>
<td>• Constants in filter conditions that are defined in a document</td>
</tr>
<tr>
<td></td>
<td>• Universe measure names</td>
</tr>
<tr>
<td></td>
<td>• Universe object names</td>
</tr>
<tr>
<td>Object type</td>
<td>Searchable content</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Microsoft Excel file</td>
<td>• Data</td>
</tr>
<tr>
<td></td>
<td>• Document properties (title, subject, author, company, category, keywords, and comments)</td>
</tr>
<tr>
<td></td>
<td>• Header and footer text</td>
</tr>
<tr>
<td></td>
<td>• Calculation or formula values</td>
</tr>
<tr>
<td></td>
<td>• Number and date/time values</td>
</tr>
<tr>
<td>Microsoft Word document</td>
<td>• Text</td>
</tr>
<tr>
<td></td>
<td>• Document properties (title, subject, author, company, category, keywords, and comments)</td>
</tr>
<tr>
<td></td>
<td>• Header and footer text</td>
</tr>
<tr>
<td></td>
<td>• Numerical values</td>
</tr>
<tr>
<td>RTF file</td>
<td>Text</td>
</tr>
<tr>
<td>PDF file</td>
<td>Text</td>
</tr>
<tr>
<td>Microsoft PowerPoint file</td>
<td>Text</td>
</tr>
<tr>
<td>TXT file</td>
<td>Text</td>
</tr>
<tr>
<td>Agnostic object</td>
<td>Metadata</td>
</tr>
<tr>
<td>Analysis view</td>
<td>An agnostic object is a non-BusinessObjects object that the launch pad can access. The data in an agnostic object does not change, and the object cannot be scheduled.</td>
</tr>
<tr>
<td>Analysis Office</td>
<td></td>
</tr>
<tr>
<td>Lumira</td>
<td></td>
</tr>
<tr>
<td>BI workspaces</td>
<td></td>
</tr>
<tr>
<td>Dashboard and Xcelsius object</td>
<td></td>
</tr>
<tr>
<td>Discussion</td>
<td></td>
</tr>
<tr>
<td>Event</td>
<td></td>
</tr>
<tr>
<td>Flash object</td>
<td></td>
</tr>
<tr>
<td>Hyperlink</td>
<td></td>
</tr>
<tr>
<td>Lifecycle management console job</td>
<td></td>
</tr>
<tr>
<td>Metadata (from Information Designer)</td>
<td></td>
</tr>
<tr>
<td>Module</td>
<td></td>
</tr>
<tr>
<td>Object package</td>
<td></td>
</tr>
<tr>
<td>Profile</td>
<td></td>
</tr>
<tr>
<td>Program object</td>
<td></td>
</tr>
<tr>
<td>Publication</td>
<td></td>
</tr>
<tr>
<td>Query (from Query As a Web Service)</td>
<td></td>
</tr>
<tr>
<td>Universe</td>
<td></td>
</tr>
<tr>
<td>Widget</td>
<td></td>
</tr>
<tr>
<td>Workspace (created in SAP BusinessObjects Analysis edition for OLAP)</td>
<td></td>
</tr>
</tbody>
</table>
### 6.12.2 Search techniques

<table>
<thead>
<tr>
<th>Technique</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separate search terms with spaces</td>
<td>finance report</td>
<td>Separating search terms with a space implies an &quot;AND&quot; separation. This technique produces results when all words in the search text are found in a document.</td>
</tr>
<tr>
<td>Use an asterisk (*) or a question mark (?) as a wild card character</td>
<td>sales 199* L?st</td>
<td>Do not use a mix of lowercase and uppercase letters in search text. The first example produces results that contain the word &quot;sales&quot; and any year from 1990 to 1999. The second example produces results that contain the words &quot;last,&quot; &quot;list,&quot; or &quot;lost.&quot;</td>
</tr>
<tr>
<td>Put search text in quotation marks (&quot;)</td>
<td>&quot;total sales growth&quot;</td>
<td>This technique produces results when the exact search text is found in a document.</td>
</tr>
<tr>
<td>Technique</td>
<td>Example</td>
<td>Example</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>--------------------------------</td>
<td>--------------------------------</td>
</tr>
</tbody>
</table>
| Precede search terms with a plus sign (+)| episode +I                      | episode +I                      | This technique produces results when all words in the search text are found in a document.
<p>|                                          |                                |                                | Precede search terms with a plus sign (+) to search for words that are typically filtered out during a search (for example, &quot;a,&quot; &quot;for,&quot; &quot;by,&quot; &quot;is,&quot; &quot;the&quot;). |
| Precede search terms with a minus sign (-)| Europe sales -revenue          | Europe sales -revenue          | This technique produces results when the word after the minus sign (-) is not found and the remaining search text is found in a document. |
| Separate search terms with &quot;OR&quot;          | bug OR defect count report      | bug OR defect count report      | This technique produces results when the word before or after &quot;OR&quot; is found and the remaining search text is found in a document. |</p>
<table>
<thead>
<tr>
<th>Technique</th>
<th>Example</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search for attributes.</td>
<td>Type: &quot;Crystal Reports&quot; Country: USA</td>
<td>Type: &quot;Crystal Reports&quot; Country: USA</td>
<td>This technique searches for attribute values in metadata or content. To perform an attribute search, type the attribute, a colon, and the value you want to search for. Enclose attribute values of more than one word in quotation marks. The first example produces results with an object type value of Crystal Reports. The second example produces results with a country value of USA.</td>
</tr>
<tr>
<td>Combine search techniques.</td>
<td>marketing OR sales -finance “increase OR decrease trend”</td>
<td>marketing OR sales -finance &quot;increase OR decrease trend&quot;</td>
<td>This example produces results if a document contains either the word &quot;marketing&quot; or &quot;sales&quot; and contains the phrase &quot;increase or decrease trend&quot; but does not contain the word &quot;finance.&quot;</td>
</tr>
</tbody>
</table>

### 6.12.3 Finding a content object in the BI repository

When a search produces many results, the BI platform groups the results into facets (categories).

1. On the **Documents** tab, enter the search text in the **search** box.

   If you pause while typing, the launch pad’s quick-search functionality displays the top six matches, based on the text entered. If matches do not appear immediately, continue entering the search text.
2. Click on the toolbar. Search results appear on the list panel.

3. Double-click an object link to view search results, or click a facet in the Search drawer to refine the results and then double-click an object link.

In an HTML viewer, when you double-click a Web Intelligence document or a Crystal report, a viewer opens and displays the first match of the search text in the report.
7  Scheduling objects

You can schedule an object to automatically run at specified times. When a scheduled object runs successfully, an instance is created.

An instance is a version of the object that contains data from the time the object ran. You can view a list of instances in an object’s history. If you have access rights to view objects on demand, you can view and refresh any instance to retrieve the latest data from the data source. Scheduling and viewing instances ensures that objects have the most up-to-date information available for viewing, printing, and distributing.

The default time zone is local to the web server that runs the BI platform, not to the Central Management Server (CMS) that your machine connects to. Before scheduling objects, confirm that your local time zone is selected in the BI launch pad preferences. If you do not have access rights to view or to set your preferences, contact your system administrator.

Related Information

Personal preferences [page 20]
  Your personal preferences determine how you log on to the BI launch pad, which views appear, and which settings apply to viewed objects.

7.1  Scheduling an object

For object options with a default setting, you can keep the default or change the setting when scheduling an object.

Before scheduling a Web Intelligence document, confirm that a context is set in the document. If there are multiple contexts in the Web Intelligence document, refresh the document with the correct context before scheduling it. Documents without a context cannot be scheduled.

1. On the Documents tab, right-click the object to schedule and select Schedule.
2. In the Schedule dialog box, click a category in the navigation list, and then set options in that category for the object.
   Repeat this step for each category that you want to set scheduling options for.
3. Click Schedule.
   The History dialog box appears, displaying your scheduled job as an instance with a status of Running.

7.1.1  Labeling a scheduled instance

1. On the Documents tab, right-click the object for which to assign a name to a scheduled instance and select Schedule.
2. In the Schedule dialog box, click Instance Title.
3. Enter a name for the instance in the Instance Title box, and click Schedule.

### 7.1.2 Selecting a recurrence pattern

The recurrence pattern you choose determines when the BI platform runs an object.

1. Right-click an object and select **Schedule**.
2. In the Schedule dialog box, click **Recurrence**.
3. In the Run object list, select a recurrence pattern.
4. Click **Schedule**.

### 7.1.2.1 Recurrence pattern options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Now</strong></td>
<td>Runs the object one time, starting immediately</td>
</tr>
<tr>
<td><strong>Once</strong></td>
<td>Runs the object once, at the specified start time. If you schedule an object with events, the object will run once, if the event is triggered between the start and end times. Choose when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td><strong>Hourly</strong></td>
<td>Creates an instance every hour, at the specified time. The first instance will be created at the specified start time, and instances will be created hourly at that time, until the object stops running at the specified end time. Choose the time to run the object in the Hour(N) and Minute(X) lists, select when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td><strong>Daily</strong></td>
<td>Runs the object once daily, at the specified start time. The first instance will be created at the specified start time, and instances will be created daily at that time, until the object stops running at the specified end time. Choose the day of the week to run the object in the Days(N) box, select when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Weekly</td>
<td>Runs the object each week on the selected days, at the specified start time. The first instance will be created at the specified start time, and instances will be created each week on those days at that time, until the object stops running at the specified end time. Select the check box for each day on which to run the object, choose when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Runs the object on the specified date, at the specified start time, and at the specified monthly intervals. The first instance will be created at the specified start time, and instances will be created in monthly intervals at that time, until the object stops running at the specified end time. Choose the month in which to run the object in the Month(N) box, choose when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td>Nth Day of Month</td>
<td>Creates an instance each month on the specified day, at the specified start time. The first instance will be created at the specified start time, and instances will be created on the specified day of each month at that time, until the object stops running at the specified end time. Enter the time to start and to stop running the object and the day of the month on which to run the object.</td>
</tr>
<tr>
<td>1st Monday of Month</td>
<td>Creates an instance on the first Monday of each month, at the specified start time. Enter the time to start and to stop running the object.</td>
</tr>
<tr>
<td>Last Day of Month</td>
<td>Creates an instance on the last day of each month, at the specified start time. Enter the time to start and to stop running the object.</td>
</tr>
<tr>
<td>X Day of Nth Week of the Month</td>
<td>Creates an instance each month on the specified day and week, at the specified start time. Enter the time to start and to stop running the object, the day of the week, and the week in the month to run the object.</td>
</tr>
</tbody>
</table>
### 7.1.3 Specifying database logon information

Before you can specify database logon information, you must have access rights to an object’s data source.

1. On the **Documents** tab, right-click the object to specify database logon information for and select **Schedule**.
2. In the **Schedule** dialog box, click **Database Logon**.
3. Change the logon information for the object's data source as needed, and click **Schedule**.

### 7.1.4 Selecting an instance format

Depending on the type of object you are scheduling, you can select the format to save the object instance in, after the BI platform generates it.

1. On the **Documents** tab, right-click the object to select an instance format for and select **Schedule**.
2. In the **Schedule** dialog box, click **Formats**, and perform one of the following actions to select an output format:
   - For a Crystal report instance, select a format in the **Output Format** list.
   - For a Web Intelligence document instance, select a format in the **Format Options for Selected Document** list.
3. Set the remaining formatting options as needed.
   - You may need to specify additional options for some Crystal report instance formats.
4. Set the remaining scheduling options as needed, and click **Schedule**.

### 7.1.4.1 Output file formats for instances

You can send or schedule objects to different formats for each type of instance.

#### Crystal report file formats

The **Crystal Reports** option preserves more formatting than other file formats. When you select other file formats, the BI platform preserves as much formatting as the format allows. However, reports may lose some or all...
formatting. If you choose to print a report when it is scheduled, the report instance is automatically sent to the printer in *Crystal Reports* format. This file format does not conflict with the file format you select when scheduling the report.

For information about scheduling a Crystal report to a specific format, see exporting information in the *SAP Crystal Reports 2011 User’s Guide*.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Crystal Reports</em></td>
<td>This .rpt format preserves the most formatting of all output format options. It produces a normal, editable report.</td>
</tr>
<tr>
<td><em>Crystal Reports (RPTR)</em></td>
<td>This .rptr format produces a read-only Crystal report.</td>
</tr>
<tr>
<td><em>Microsoft Excel (97-2003)</em></td>
<td>This .xls format attempts to preserve the look and feel of the original report. It preserves data and does not merge cells. You must specify some formatting properties for the report.</td>
</tr>
<tr>
<td><em>Microsoft Excel (97-2003) (Data Only)</em></td>
<td>This .xls format saves only data, and each cell represents a field.</td>
</tr>
<tr>
<td><em>Microsoft Excel Workbook Data-only</em></td>
<td></td>
</tr>
<tr>
<td><em>Microsoft Word (97-2003)</em></td>
<td>This .doc format preserves as much formatting as possible, including graphics. Each object appears in an individual text field.</td>
</tr>
<tr>
<td><em>PDF</em></td>
<td>.pdf format</td>
</tr>
<tr>
<td><em>Rich Text Format (RTF)</em></td>
<td>This .rtf format preserves as much formatting as possible, including graphics. Each object appears in an individual text field. This option is available only from a web viewer.</td>
</tr>
<tr>
<td><em>Microsoft Word - Editable (RTF)</em></td>
<td>This .doc format preserves less formatting than the Microsoft Word (97-2003) option. Text appears in lines, and images are placed inline with text.</td>
</tr>
<tr>
<td><em>Plain Text</em></td>
<td></td>
</tr>
<tr>
<td><em>Paginated Text</em></td>
<td>You must specify some formatting properties for the report.</td>
</tr>
<tr>
<td><em>Tab Separated Text (TTX)</em></td>
<td>This format places a tab character between values. You must specify some formatting properties for the report.</td>
</tr>
<tr>
<td><em>Separated Values (CSV)</em></td>
<td>This .csv format places a specified character between values. You must specify some formatting properties for the report. For example, if you select this option, you must enter characters for the separator and delimiter.</td>
</tr>
<tr>
<td><em>XML</em></td>
<td>.xml format</td>
</tr>
</tbody>
</table>
## Web Intelligence file formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Intelligence</td>
<td>.wid format</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>.xlsx format</td>
</tr>
<tr>
<td>Adobe Acrobat</td>
<td>.pdf format</td>
</tr>
<tr>
<td>Comma Separated Values (CSV)</td>
<td>.csv format</td>
</tr>
<tr>
<td>Plain Text</td>
<td>.txt format</td>
</tr>
</tbody>
</table>

### 7.1.4.2 Crystal report instance formatting options

When you schedule a Crystal report instance to some output formats, you may need to set additional options.

**Table 1: Microsoft Excel (97-2003) format**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Range</strong></td>
<td>- To include all pages in a report, select <em>All</em>.</td>
</tr>
<tr>
<td></td>
<td>- To include a page range, select <em>Pages from</em>, enter the first page number to include, and enter the last page number to include in the <em>to</em> box.</td>
</tr>
<tr>
<td><strong>Use the export options defined in the report</strong></td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td><strong>Set Column Width</strong></td>
<td>- To set the width of Excel columns based on objects in a report, select <em>Column width based on objects in the</em>, and choose a report area from which to take the column width in the list.</td>
</tr>
<tr>
<td></td>
<td>- To set a constant column width, select <em>Constant column width (in points)</em>, and enter the width in the box.</td>
</tr>
<tr>
<td><strong>Export page header and page footer</strong></td>
<td>- To choose when to export page headers and footers in an instance, select <em>Once Per Report</em> or <em>On Each Page</em>.</td>
</tr>
<tr>
<td></td>
<td>- To exclude page headers and footers from an instance, select <em>None</em>.</td>
</tr>
<tr>
<td><strong>Create page breaks for each page</strong></td>
<td>Select this check box to create a page break after each page in a report</td>
</tr>
<tr>
<td><strong>Convert date values to strings</strong></td>
<td>Select this check box to export date values in a report as text strings</td>
</tr>
<tr>
<td><strong>Show gridlines</strong></td>
<td>Select this check box to view grid lines in exported documents</td>
</tr>
</tbody>
</table>
### Table 2: Microsoft Excel (97-2003) (Data Only) and Microsoft Excel Workbook Data-only formats

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the export options defined in the report</td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
</tbody>
</table>
| Set Column Width                            | • To set the width of Excel columns based on objects in a report, select *Column width based on objects in the*, and choose a report area from which to take the column width in the list.  
  • To set a constant column width, select *Constant column width (in points)*, and enter the width in the box. |
| Export object formatting                     | Select this check box to preserve the object formatting.                                                                                     |
| Export images                                | Select this check box to export the images in a report.                                                                                      |
| Use worksheet functions for summaries        | Select this check box to use summaries in a report to create worksheet functions in Excel.                                                     |
| Maintain relative object position            | Select this check box to maintain the position of objects, relative to one another.                                                           |
| Maintain column alignment                    | Select this check box to preserve the alignment of text in columns in a report.                                                               |
| Export page header and page footer           | Select this check box to include the header and footer in an instance.                                                                        |
| Simplify page headers                        | Select this check box to use simple page headers.                                                                                             |
| Show group outlines                          | Select this check box to show group outlines.                                                                                                |

### Table 3: Microsoft Word (97-2003) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Page Range                                  | • To include all pages in a report, select *All.*  
  • To include a page range, select *Pages from*, enter the first page number to include, and enter the last page number to include in the *to* box. |

### Table 4: PDF format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Page Range                                  | • To include all pages in a report, select *All.*  
  • To include a page range, select *Pages from*, enter the first page number to include, and enter the last page number to include in the *to* box. |
| Use the export options defined in the report | Select this check box to use the export options defined in a report. You cannot set any other formatting options.                          |
| Create bookmarks from group tree            | Select this check box to create bookmarks in a PDF file based on the tree structure of a report. This makes reports easier to navigate.       |
### Table 5: Rich Text Format (RTF) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Range</strong></td>
<td>● To include all pages in a report, select <em>All.</em>&lt;br&gt;● To include a page range, select <em>Pages from,</em> enter the first page number to include, and enter the last page number to include in the <em>to</em> box.</td>
</tr>
</tbody>
</table>

### Table 6: Microsoft Word—Editable (RTF) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Range</strong></td>
<td>● To include all pages in a report, select <em>All.</em>&lt;br&gt;● To include a page range, select <em>from,</em> enter the first page you want to include, and enter the last page you want to include in the <em>to</em> box.</td>
</tr>
<tr>
<td><strong>Use the export options defined in the report</strong></td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td><strong>Insert page break after each report page</strong></td>
<td>Select this check box to insert page breaks after each page in a report.</td>
</tr>
</tbody>
</table>

### Table 7: Plain Text format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use the export options defined in the report</strong></td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td><strong>Number of Characters per inch</strong></td>
<td>Enter a value between 8 and 16 to indicate the number of characters to include per inch. This setting determines how text files appear and are formatted.</td>
</tr>
</tbody>
</table>

### Table 8: Paginated Text format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use the export options defined in the report</strong></td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td><strong>Number of Lines per Page</strong></td>
<td>Enter the number of lines of text to include between page breaks.</td>
</tr>
<tr>
<td><strong>Number of Characters per Inch</strong></td>
<td>Enter a value between 8 and 16 to indicate the number of characters to include per inch. This setting determines how text files appear and are formatted.</td>
</tr>
</tbody>
</table>

### Table 9: Separated Values (CSV) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use the export options defined in the report</strong></td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td><strong>Delimiter</strong></td>
<td>Enter the character to use as the delimiter.</td>
</tr>
<tr>
<td><strong>Separator</strong></td>
<td>Enter the character to use to separate values, or select the <em>Tab</em> check box.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
**Mode** | Select *Standard Mode* or *Legacy Mode*. When you select *Standard Mode*, you can choose report, page, and group sections to include in an instance. When you select *Legacy Mode* mode, you cannot choose report, page, or group section options.

**Report and page sections** | If you chose *Standard Mode*, select *Export* or *Do not export* to indicate whether to export report and page sections. If you selected *Export*, select the *Isolate report/page sections* check box if you want to isolate the report and page sections.

**Group sections** | If you chose *Standard Mode*, select *Export* or *Do not export* to indicate whether to export group sections. If you selected *Export*, select the *Isolate group sections* check box if you want to isolate the group sections.

### Table 10: XML

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Use the export options defined in the report</em></td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td>XML Exporting Formats</td>
<td>Choose an XML export format, such as <em>Crystal Reports XML</em>.</td>
</tr>
</tbody>
</table>

### 7.1.5 Selecting a destination

You can schedule an object instance to be sent to a destination on your computer, on a network, at a default file location, in email, on a FTP server, or in SAP Jam or SAP StreamWork (if available).

The destinations available depend on which destinations your system administrator enabled and on your access rights. If your administrator specified a destination for an object, that destination option is listed in the *Schedule* dialog box. You may be able to set options for the destination or to select a different destination. For most destinations, you must provide additional information.

1. On the *Documents* tab, right-click the object to select a destination for and select *Schedule*.
2. In the *Schedule* dialog box, click *Destinations*.
   The *Destinations* dialog box appears. The options available depend on which destination you chose.
3. Select a destination in the *Destination* list.
4. To save a copy of the instance, select the *Keep an instance in the history* check box.
5. To use the default settings for the destination, select the *Use default settings* check box.
6. Set the remaining destination options as needed.
7. Click *Schedule*.
7.1.5.1 Publication destinations

These destinations are available for scheduled publications:

- Default Enterprise Location
- BI Inbox
- Email
- FTP Server
- File System
- SAP StreamWork (if enabled and configured)

The *Deliver objects to each user* check box is selected by default for all destinations. However, in some cases, you may not want to deliver objects to each user. For example, three recipients have identical personalization values so they receive the same data in publication instances. If you clear the *Deliver objects to each user* check box, one publication instance is generated and delivered to all three recipients. If you select the *Deliver objects to each user* check box, the same publication instance is delivered three times (once for each recipient).

Default Enterprise Location

If you send a publication to this location, choose a folder that is accessible to all recipients.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| The folder it was created in | ● Merge all exported PDF documents (Crystal reports only)  
● Package the publication as a compressed (.zip) file | Output File Repository Server  
Historical instances are saved to the default Enterprise server but not to any other destination. |
BI Inbox

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| Each recipient's BI Inbox | • Use the default settings for the destination  
• Deliver objects to individual users  
To quickly locate a user, you can search for a recipient's user name, full name, or email address in the Find title box.  
• Use the default file name, enter a file name, or add placeholders  
If you select Use Specific Name, enter a file extension or add the File Extension placeholder in the box.  
• Automatically add the extension to a file name  
If you do not add a file extension to a file name, you may be unable to open the document.  
• Send the publication as a shortcut or a copy  
If you send a publication to a recipient's BI Inbox shortcut, choose a folder that is accessible to all recipients. To send a publication shortcut to a BI Inbox, select both BI Inbox and Default Enterprise Location as the destination.  
• Merge all exported PDF documents (Crystal reports only)  
• Package the publication as a compressed (.zip) file | • Output File Repository Server  
• Specified BI Inboxes |

Email

Before you can schedule or send a report instance to this destination, you must enable and configure the email (SMTP) destination on the Adaptive Job Server.
<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| Each recipient via email | • Use the default settings for the destination  
• Deliver objects to individual users  
• (Required) Enter your email address in the **From** box  
If you do not enter your email address, the BI platform uses the email address associated with the publisher’s account. If the publisher’s account has no email address, the platform uses the email address for the Adaptive Job Server. If there is no email address in the **From** box, the publisher’s account, or the Adaptive Job Server, the publication will fail.  
• Enter recipient email addresses or add the **Email Address** placeholder to the **To** box  
• Enter recipient email addresses or add the **Email Address** placeholder to the **Cc** box  
• Enter recipient email addresses or add the **Email Address** placeholder to the **Bcc** box  
• Enter a subject or add placeholders to the **Subject** box  
• Enter information to deliver with the publication or add placeholders and embed a dynamic content document in the body of the email in the **Message** box  
• Attach source document instances to an email  
• Accept the default file name, enter a file name, or add placeholders  
If you select **Use Specific Name**, enter a file extension or add the **File Extension** placeholder to the box. | • Output File Repository Server  
• Specified email recipients |
### FTP Server

If you are sending the publication to the **FTP Server** destination and some recipients share identical personalization values, you can clear the **Deliver objects to each user** check box to decrease overall processing time. When you clear **Deliver objects to each user**, placeholders used when configuring destinations will contain the publisher’s (not the recipient’s) information.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| An FTP server           | • Use the default settings for the destination  
                          • Enter the port number, user name and password, and account  
                          • Enter a directory name  
                          • Accept the default file name, enter a file name, or add placeholders  
                          • If you select **Use Specific Name**, enter a file extension or add the **File Extension** placeholder to the box.  
                          • Automatically add the extension to file name  
                          • If you do not add a file extension to a file name, you may be unable to open the document.  
                          • Merge all exported PDF documents (Crystal reports only)  
                          • Package the publication as a compressed (.zip) file |  
                          • Output File Repository Server  
                          • Selected FTP server |
File System

If you are sending the publication to the File System destination and some recipients share identical personalization values, you can clear the Deliver objects to each user check box to decrease overall processing time. When you clear Deliver objects to each user, placeholders used when configuring destinations will contain the publisher’s (not the recipient’s) information.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| A directory on a file system (You must enter the directory for the publication.) | • Use the default settings for the destination  
• Enter a user name and password to access the file location  
• Deliver objects to individual users  
• Accept the default file name, enter a file name, or add placeholders  
If you select Use Specific Name, enter a file extension or add the File Extension placeholder to the box.  
• Automatically add the extension to file name  
If you do not add a file extension to a file name, you may be unable to open the document.  
• Merge all exported PDF documents (Crystal reports only)  
• Package the publication as a compressed (.zip) file | • Output File Repository Server  
• Selected file location |

SAP StreamWork

This destination is available if collaboration is configured and enabled in the BI platform.
<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| Sent for collaboration with other users. | • Send or schedule Crystal reports and Web Intelligence documents to collaboration activities  
• Monitor feeds  
• Follow documents and instances to track comments and discussions  
• Post comments on documents and instances and view comments posted by other users about public documents | One of the following collaboration applications:  
• SAP Jam  
• SAP StreamWork |

### 7.1.5.2 Options per destination

You can change options for the default Adaptive Job Server in the Servers area of the Central Management Console (CMC) in the BI platform.

For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

#### Default Enterprise Location options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination</td>
<td><strong>Default Enterprise Location</strong></td>
</tr>
<tr>
<td></td>
<td>The scheduled job will run on the Output File Repository Server (FRS). You do not need to set additional options for this destination. Historical instances are saved to the default Enterprise server but not to any other destination.</td>
</tr>
</tbody>
</table>

#### BI Inbox options

<p>| Option    | Description |
|-----------|-------------|-------------|
| Destination | BI Inbox    |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keep an instance in the history</strong></td>
<td>Select this check box to retain a copy of this instance in the object’s history. This check box is selected by default. Clear this check box if you want the BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server.</td>
</tr>
<tr>
<td><strong>Use default settings</strong></td>
<td>Select this check box to use the default Adaptive Job Server values for BI Inboxes. If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination recipient options that appear.</td>
</tr>
<tr>
<td><strong>Available Recipients and Selected Recipients</strong></td>
<td>In the Available Recipients list, select users or user groups to send the instance to, and click &gt; to add the users or groups to the Selected Recipients list.</td>
</tr>
<tr>
<td><strong>Find title (if available)</strong></td>
<td>Enter a recipient’s user name, full name, or email address in the Find title box to quickly locate the user in the Available Recipients list.</td>
</tr>
</tbody>
</table>
| **Target Name**                             | • To use a system-generated file name for the instance, select Use Automatically Generated Name.  
  • To choose a file name for the instance, select Use Specific Name, and enter a name or select variables for the file name from the Add placeholder list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, and (your) User Full Name, and File Extension. Select the Add File Extension check box to automatically add the file extension to the instance file name. If you do not add a file extension, you may be unable to open the document. |
| **Send As**                                 | • To send a shortcut to the instance to recipients, select Shortcut.  
  • To send a copy of the instance to recipients, select Copy.                                                                                                                                                                                                                                                                                                                                                     |

## Email options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination</strong></td>
<td>Email</td>
</tr>
<tr>
<td><strong>Keep an instance in the history</strong></td>
<td>Select this check box to retain a copy of this instance in the object’s history. This check box is selected by default. Clear this check box if you want the BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Use default settings** | Select this check box to use the default Adaptive Job Server values for email.  
If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination recipient options that appear. |
| **From**       | Enter a return email address, or select variables for the email address from the *Add placeholder* list. The available variables are *Title, ID, Owner, DateTime, (your) Email Address*, and *(your) User Full Name*. Click a variable to add it. Separate email addresses with a semicolon (;).  
This option may be unavailable, depending on your system configuration. |
| **To**         | Enter each email address that you want to send the instance to, or select variables for the email address from the *Add placeholder* list. The available variables are *Title, ID, Owner, DateTime, (your) Email Address*, and *(your) User Full Name*. Click a variable to add it. Separate email addresses with a semicolon (;). |
| **Cc**         | Enter each email address that you want to send a copy of the email and instance to, or select variables for the email address from the *Add placeholder* list. The available variables are *Title, ID, Owner, DateTime, (your) Email Address*, and *(your) User Full Name*. Click a variable to add it. Separate email addresses with a semicolon (;). |
| **Bcc**        | Enter the email address of each undisclosed recipient, or select variables for the email address from the *Add placeholder* list. The available variables are *Title, ID, Owner, DateTime, (your) Email Address*, and *(your) User Full Name*. Click a variable to add it. Separate email addresses with a semicolon (;). |
| **Subject**    | Enter the subject of the email, or select variables for the subject from the *Add placeholder* list. The available variables are *Title, ID, Owner, DateTime, (your) Email Address*, and *(your) User Full Name*. Click a variable to add it. |
| **Message**    | Enter the message for the body of the email, or select variables for the message from the *Add placeholder* list. The available variables are *Title, ID, Owner, DateTime, (your) Email Address*, *(your) User Full Name, Viewer*, and *Document Name*. Click a variable to add it. |
| **Add Attachment** | Select this check box if you want to add an attachment to the email message containing the instance. |
| **File Name**  |  
- To use a system-generated file name for the instance, select *Use Automatically Generated Name*.  
- To choose the file name for the instance, select *Use Specific Name*, and enter a name or select variables for the file name from the *Add placeholder* list. The available variables are *Title, ID, Owner, DateTime, (your) Email Address*, *(your) User Full Name*, and *File Extension*.  
Select the *Add File Extension* check box to automatically add the file extension to the instance file name. If you do not add a file extension, you may be unable to open the document. |
### FTP Server options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination</strong></td>
<td><strong>FTP Server</strong></td>
</tr>
<tr>
<td><strong>Keep an instance in the history</strong></td>
<td>Select this check box to retain a copy of this instance in the object’s history. This check box is selected by default. Clear this check box if you want the BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server.</td>
</tr>
<tr>
<td><strong>Use default settings</strong></td>
<td>Select this check box to use the default Adaptive Job Server values for FTP servers. If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination recipient options that appear. You can change the values in the Servers area of the CMC. For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.</td>
</tr>
<tr>
<td><strong>Host</strong></td>
<td>Enter the IP address of the FTP server host computer where you want to send the instance.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Enter the port of the FTP server where you want to send the instance. The default is 21.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>Enter a user name with access rights to upload the object to the FTP server.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Enter the password required to access the FTP server.</td>
</tr>
<tr>
<td><strong>Account</strong></td>
<td>Enter the account required to access the FTP server. The account is part of the standard FTP protocol but is rarely implemented. Enter an account only if your FTP server requires it.</td>
</tr>
<tr>
<td><strong>Directory</strong></td>
<td>Enter the path to the FTP directory where you want to send the instance.</td>
</tr>
<tr>
<td><strong>File Name</strong></td>
<td>- To use a system-generated file name for the instance, select <em>Use Automatically Generated Name</em>. &lt;br&gt;- To choose the file name for the instance, select <em>Use Specific Name</em>, and enter a name or select variables for the file name from the Add placeholder list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, (your) User Full Name, Document Name, and File Extension. Select the Add File Extension check box to automatically add the file extension to the instance file name. If you do not add a file extension, you may be unable to open the document.</td>
</tr>
</tbody>
</table>
File System options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination</td>
<td>File System</td>
</tr>
<tr>
<td>Keep an instance in the history</td>
<td>Select this check box to retain a copy of this instance in the object’s history. This check box is selected by default. Clear this check box if you want the BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server. Instances are required for auditing events. This check box is overruled if auditing is enabled for a scheduled object.</td>
</tr>
<tr>
<td>Use default settings</td>
<td>Select this check box to use the default Adaptive Job Server values for the file system. If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination recipient options that appear.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter a user name with access rights to save files to the destination directory. You can specify a user name and password only for servers on Windows.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the user password that is required to access the destination directory. You can specify a user name and password only for servers on Windows.</td>
</tr>
<tr>
<td>Directory</td>
<td>Enter the path to a local hard disk location or mapped location or a UNC path to the directory where you want to send the instance. If you are scheduling a Web Intelligence document and want to create folders based on variables (such as the title of the instance, owner, date and time, or user names), use a placeholder. The placeholder is inserted after the text in the box.</td>
</tr>
<tr>
<td>File Name</td>
<td>- To use a system-generated file name for the instance, select Use Automatically Generated Name. - To choose the file name for the instance, select Use Specific Name, and enter a name or select variables for the file name from the Add placeholder list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, (your) User Full Name, Document Name, and File Extension. Select the Add File Extension check box to automatically add the file extension to the instance file name. If you do not add a file extension, you may be unable to open the document.</td>
</tr>
</tbody>
</table>

SAP StreamWork options

The SAP StreamWork destination is available if collaboration is enabled and configured in the BI platform. Use the SAP StreamWork destination for both SAP Jam and SAP StreamWork.
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination</strong></td>
<td>SAP StreamWork</td>
</tr>
</tbody>
</table>
| **Keep an instance in the history** | Select this check box to retain a copy of this instance in the object’s history. This check box is selected by default.  
Clear this check box if you want the BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server. |
| **Use default settings**      | Select this check box to use the default Adaptive Job Server values for the collaboration application (SAP Jam or SAP StreamWork). If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination options that appear. |
| **File**                      | This box displays the file name. You cannot change the name here.                                                                           |
| **Select Destination**        | Select an existing or new activity as the destination of the report. Use the first list to filter activities by worklist.                     |
| **Select Worklist**           | Enter the name of the worklist, or select it in the list.                                                                                   |
| **Select Activity**           | Enter the name of the activity, or select it in the list.                                                                                   |
| **Activity Name**             | If the object will publish to a new activity, this box displays the name of the activity.                                                   |
| **Activity Objectives**       | This box displays the activity’s objectives, if available.                                                                                   |
| **Item Description**          | (Optional) Enter a description of the object’s content to help participants understand what the object is and how to use it.                |
| **Select Activity Type**      | (Optional) Select the type of activity you are scheduling.                                                                                   |
| **Add Participants**          | (Optional) If you are creating a new collaboration activity, enter the email address of each participant (user) to invite to the activity. Separate email addresses with a comma. |

### 7.1.6 Applying a record selection formula

Selection formulas help determine which data appears in a report and may improve performance by eliminating unwanted records.

If an object includes a record or group selection formula, you can modify the formula before scheduling the object. For more information about record selection formulas, see the *SAP Crystal Reports User Guide*.

1. On the *Documents* tab, right-click the object to apply a record or group selection formula to and select *Schedule*.
2. In the *Schedule* dialog box, click *Filters*.
3. Change the record or group selection formula as needed.
4. Click Schedule.

### 7.1.7 Scheduling an object with parameters (prompts)

Parameters (prompts) ask you to enter information. In report objects, the information you enter may determine which data appears in a report. For example, in a report used by sales, a parameter may ask users to choose a region. When a user chooses a region, the report displays only results for that region.

In Web Intelligence documents, parameters are called prompts. In Web Intelligence documents based on SAP Business Explorer (SAP BEx) queries, a prompt’s value can be fixed or obtained by a SAP Business Warehouse (SAP BW) data source variable when a scheduled document runs. Prompts can contain mandatory variables in SAP BW data sources.

1. On the Documents tab, right-click the object to schedule parameters (prompts) for and select Schedule.
2. In the Schedule dialog box, click Prompts.
   - The way that parameter (prompt) options appear may differ from object to object, depending on how your system administrator has configured the parameter. For example, program objects may appear in an Argument box.
   - If the Prompts button is not available, the object to schedule does not contain parameters (prompts).
3. (Crystal reports only) In the Prompts dialog box, click Edit Values to edit a parameter value.
4. (Web Intelligence documents based on SAP BEx queries only) In the Prompts dialog box, click Modify to edit a prompt value or Clear to remove the mandatory variable value for a prompt.
   - The SAP BW data source must be able to process the value provided for a prompt. If the data source cannot process a value, document execution will fail. For example, SAP BW exit or customer exit variables are often used as dynamic variables in prompts.
   - If the Clear button is not available, your administrator can enable it by setting bex.dynamic_variable.schedule=true in the `<InstallDir>\<WebAppServer>\webapps\boe\web-inf\config\custom\AnalyticalReporting.properties` file. For instructions, see the Business Intelligence Platform Administrator Guide.
5. Click Schedule.

### 7.1.8 Scheduling an object with events

When you schedule an object with events, the object runs after the specified event occurs in the BI platform.

Working with events consists of two steps—creating an event and scheduling an object. After you create an event, you can select it as a dependency when you schedule an object. The scheduled job is then processed when that event occurs.

You create events in the Central Management Console (CMC), and then select the events in the BI launch pad when you schedule objects. For more information about scheduling objects with events, see the SAP BusinessObjects Business Intelligence Platform User Guide.

1. On the Documents tab, right-click the object to schedule events for and select Schedule.
2. In the Schedule dialog box, click Events.
3. To specify an event that will trigger the scheduled object, select the event in the Available Events list, and click > to move the event to the Events to wait for list.
4. To specify an event that will be triggered by the completion of the scheduling job, select the scheduled event in the Available Schedule Events list, and click > to move the event to the Events to trigger on completion list.
5. Click Schedule.

7.1.9 Selecting the scheduling server group for an object

1. On the Documents tab, right-click the object to select a server group for and select Schedule.
2. In the Schedule dialog box, click Scheduling Server Group.
3. Perform one of the following actions:
   ○ (Default) Select Use the first available server to run the object on the server with the most resources free at the time of scheduling.
   ○ Select Give preference to servers belonging to the selected group to attempt to run the object on servers in a particular server group, and then select the server group in the list.
     If no servers in the selected server group are available, the object is run on the next available server.
   ○ Select Only use servers belonging to the selected group to run the object only on servers in a particular server group, and then select the server group in the list.
     If no servers in the selected server group are available, the object is not processed.
4. If your deployment of the BI platform uses federation and you want to run the object at the site where it is located, select the Run at origin site check box.
5. Click Schedule.

7.1.10 Selecting a cache format for a Web Intelligence document

When the BI platform runs a scheduled Web Intelligence document, an instance is generated and stored on the Output File Repository Server. You can select the format used to cache the document.

Before selecting a cache format:
- Confirm that a context is set in the Web Intelligence document. If there are multiple contexts, refresh the document with the correct context before scheduling it. Documents without a context cannot be scheduled.
- Confirm that Web Intelligence is selected as the output format for the object. If a different output format is selected, cache options will have no effect.

If you do not select a cache format, the platform will not cache the document.

1. On the Documents tab, right-click the object to select a cache format for and select Schedule.
2. In the Schedule dialog box, click Caching.
3. Under Select the formats to pre-load the cache with when scheduling, select one or more check boxes.
   You can select more than one format to cache.
4. Under **Available locales**, select one or more locales for the cache, and click > to move the locale(s) to the **Selected locales** list.

When you schedule the document, the platform preloads the format and locales you selected and generates cached versions of the document in the locale(s) you specified.

5. Click **Schedule**.

### 7.1.11 Selecting print settings for a Crystal report

When you schedule a Crystal report, you can print the object instance after it is generated.

1. On the **Documents** tab, right-click the Crystal report object to select print settings for and select **Schedule**.
2. In the **Schedule** dialog box, click **Print Settings**.
3. Select a print mode for the web viewer:
   - If you want to print the report in PDF, select **Always print to PDF (Preview)**.
   - If you want to use the report’s default print settings, select **Follow Crystal Reports preference setting**.
4. If you want to print the report after it runs, select the **Print Crystal reports when scheduling** check box, and perform the following actions:
   a) Under **You can use the default printer or specify a printer**, select **Default printer** to use your default printer, or select **Specify the printer** and select a printer in the list.
   b) In the **Number of Copies** box, enter the number of copies you want to print.
   c) Under **Page Range**, select **All** if you want to print every page in the report, or select **Pages** and enter the first page number to print in the **from** box and the last page number to print in the **to** box.
   d) In the **Set collate option to** list, select **Collate**, **Do not collate**, or **Use printer defaults** to indicate whether to collate printed copies of the instance.
   e) In the **Page Scaling** list, select **Scale to fit**, **Only shrink to fit**, or **Do not scale**.
   f) To center each page, select the **Center the page** check box.
   g) To force horizontal pages to fit the paper, select the **Fit horizontal pages into one page** check box.
5. (Optional) Under **Specify page layout**, beside **Set layout to**, choose the page layout:
   - To use the report’s page layout, select **Report file default**.
   - To use the printer’s page layout, select **Specify printer settings**, and select **Default printer** or **Specify the printer**.
     - If you chose **Specify the printer**, select a printer in the list.
   - If you want to choose the page layout, select **Custom settings**, and select **Use standard layout settings** or **Use custom layout settings**.
     - If you chose **Use custom layout settings**, select **Portrait** or **Landscape** orientation, and select the paper size in the **Paper Size** list.
6. Click **Schedule**.
7.1.12 Selecting a language for Crystal report instances

You can schedule a Crystal report to create instances in the default language set by the preferred viewing locale (PVL) or in multiple languages.

1. On the Documents tab, right-click the object for which to select a language for report instances and select Schedule.
2. In the Schedule dialog box, click Languages.
3. Perform one of the following actions:
   ○ To schedule the report according to the PVL set in your preferences and create instances using only that locale, select Schedule the report in Preferred Viewing Locale.
   ○ To schedule the report in multiple languages, select Schedule the report in Multiple Locales, select one or more locales in the All Locales list, and click > to move the locale(s) to the Selected Instance Locales list.
4. Click Schedule.
8 Scheduling object packages

An object package is an object that acts as a container for other objects (also called components). You can put any object type that can be scheduled in an object package. You create and edit object packages in the Central Management Console (CMC) in the BI platform.

To add objects to an object package, in the CMC, a user with appropriate access rights copies the object and pastes it in the object package. Components of an object package are separate from the object they were copied from; the objects are now components of the object package.

When you schedule an object package, instances are created for each component so that you can simultaneously schedule several objects. You cannot schedule one component in an object package without scheduling all components in the package. Scheduling an object package is slightly different from scheduling an individual object. You set the following scheduling options at an object-package level:

- Recurrence
- Destinations
- Events
- Server group settings

You set the following scheduling options for each component in the object package:

- Notification
- Database logon settings
- Filters (if applicable)
- Format
- Print settings
- Parameters or prompts
- Arguments (if applicable)

8.1 Scheduling an object package

1. Locate and select the object package to schedule.
2. On the toolbar, click Actions, and select Schedule in the list that appears.
3. In the Schedule dialog box, in the Instance Title box, enter a name for the instance.
4. Click Recurrence, and select a recurrence pattern in the Run object list for the object package.
5. Click Events, and select one or more events for the object package.
6. Click Scheduling Server Group, and select a server group option for the object package.
7. Click Destinations, and select a destination for the object package.
8. Click Components, click the name of a component, set the notification, database logon, filter, format, print, cache, and parameters or prompts for the component, and click OK.
9. Repeat step 8 for each component in the object package.
10. Click Schedule.

The object package will run at the scheduled time.
9 Working with instances

An instance is a single publication of a report. For each scheduled object that runs, the BI platform saves a history of its instances to the default Enterprise server.

The History dialog box chronologically lists the instances for an object, with the most recent instances at the top of the list. Depending on the type of object you are viewing, the following historical information may be available:

- Instance time
- Title
- Status
- Created by
- Type
- Locale
- Parameters

You can view discussions for an instance in the History dialog box or in the Collaboration drawer of the feed panel, if the BI launch pad is integrated with SAP Jam or SAP StreamWork.

Related Information

Collaboration [page 152]

Hosted on the web, SAP Jam or SAP StreamWork adds collaborative decision-making and social media to the BI launch pad.

9.1 Viewing the latest instance of an object

You can view the latest instance of objects such as Crystal reports, Web Intelligence documents, publications, and object packages.

1. Right-click the object and select View.

   The latest instance of the object appears in a viewer.

2. If you have the refresh rights on the object, click on the viewer toolbar to refresh the report or document with the latest information from the data source.

   The latest instance of the object appears in the viewer.

9.2 Viewing an historical instance of an object

1. Right-click the object and select History.
2. In the History dialog box, double-click a link in the Instance Time column to view the historical instance. Click 🔄 beside the Instance Time, Title, Status, or Created By column heading to sort and display all instances by that column’s information. The 🔄 icon appears when you point at a column heading.

9.3 Pausing or resuming an instance

For objects with a status of Pending or Recurring, you can pause and then resume an object’s scheduled instances.

For example, if a job server is down for maintenance, you can pause a scheduled instance to prevent the BI platform from running the object. Scheduled jobs fail when the job server is not running. When the job server is running again, you can resume the scheduled instance.

9.3.1 Pausing an instance

1. Right-click the object instance and select History.
2. In the History dialog box, select the scheduled instance to pause.
3. Click Pause.

9.3.2 Resuming a paused instance

1. Right-click the object instance and select History.
2. In the History dialog box, select the paused instance that you want to resume.
3. Click Resume.

9.4 Deleting instances from your BI Inbox

You can delete all instances from your BI Inbox.

1. On the Documents tab, expand the My Documents drawer, and click Inbox. The contents of your BI Inbox appear.
2. Click Organize ➔ Delete All Messages ➔
3. When prompted, click OK to confirm the deletion.
10 About publishing

Publishing makes documents (such as Crystal reports and Web Intelligence documents) automatically available via email or FTP server, saved to disk, and managed through the BI platform (for web viewing, archiving, retrieval, and scheduling).

In the BI launch pad or in the Central Management Console (CMC) in the platform, you can tailor documents to different users or recipients, schedule documents to run at intervals, and send the documents to multiple destinations, including BI Inboxes and email addresses.

10.1 What is a publication

A publication is a collection of documents intended for distribution to a mass audience. Before the documents are distributed, the publisher defines the publication using a collection of metadata. The metadata includes the publication source, its recipients, and the personalization applied.

Publications can help send information through your organization more efficiently. For example:

- They enable you to easily distribute information to users or groups of users and to personalize the information each user or group receives.
- They deliver targeted business information to users or groups of users through a password-protected portal or across an intranet, an extranet, or the Internet.
- They minimize database access by eliminating the need for users to send process requests.

You can create different types of publications based on Crystal reports or Web Intelligence documents.

10.2 Access rights required for publishing

<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document designer</td>
<td>Create a document to base a publication on</td>
<td>None</td>
</tr>
<tr>
<td>Document designer</td>
<td>Add a document to the BI platform</td>
<td>View right and Add right on the folder or category that the document will be added to</td>
</tr>
<tr>
<td>Document designer</td>
<td>Create a document to use as a dynamic recipient source</td>
<td>View right and Add right on the folder or category that the document will be added to</td>
</tr>
<tr>
<td>Role</td>
<td>Task</td>
<td>Rights required</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Publisher    | Create a publication | • Add right on the folder where the publication is saved  
|              |                    | • View right on the users and the user groups intended as recipients  
|              |                    | • View right on the profile that will be used for personalization  
|              |                    | • View right on documents in the publication  
|              |                    | • Schedule right on documents in the publication  
|              |                    | • Schedule right on Enterprise recipients |

© 2014 SAP SE or an SAP affiliate company. All rights reserved.
<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Schedule a publication</td>
<td>Only the publisher should have the Schedule a publication right.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View right, Schedule right, Add right, and Modify Security right on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Delete Instance right on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View right on the users and the user groups intended as recipients</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View right on the profile that will be used for personalization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View right and Schedule right on documents in the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View right and Refresh right on the dynamic recipient source</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- View right and Refresh right on the document that the delivery rule is set for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Data Access right on universes used by publication objects</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Data Access right on universe connections used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- When scheduling to a BI Inbox, Add right and View right on each recipient’s BI Inbox</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Modify the right users have to objects right on the folder containing the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Subscribe right on recipients</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- When a publisher wants to print publication instances, Print right on Crystal report source documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If you selected <strong>One database fetch per recipient</strong>, Schedule on behalf of other users right on Enterprise recipients</td>
</tr>
</tbody>
</table>

---

**Business Intelligence Launch Pad User Guide**

About publishing

© 2014 SAP SE or an SAP affiliate company. All rights reserved.

89
<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
</table>
| Publisher  | Retry a failed publication instance      | • Edit right on the publication instance  
• View right, Subscribe right, Add right, and Modify Security right on the publication  
• Delete Instance right on the publication  
• View right on the users and the user groups intended as recipients  
• View right on the profile that will be used for personalization  
• View right and Schedule right on documents in the publication  
• View right and Refresh right on the dynamic recipient source  
• View right and Refresh right on the document for which the delivery rule is set  
• Data Access right on universes used by publication objects  
• Data Access right on universe connections used  
• When scheduling to a BI Inbox, Add right and View right on each recipient’s BI Inbox  
• Modify the right users have to objects right on the folder containing the publication  
• Subscribe right on recipients  
• When a publisher wants to print publication instances, Print right on Crystal report source documents  
• If you selected *One database fetch per recipient*, Schedule on behalf of other users right on Enterprise recipients |
<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
</table>
| Publisher  | Redistribute a publication instance       | • View right, Schedule right, Add right, and Modify Security right on the publication  
|            |                                            | • When scheduling to a BI Inbox, Add right and View right on each recipient’s BI Inbox  
|            |                                            | • View Instance right and Edit right on the publication instance                   |
| Recipient  | View a publication                        | Rights that enable you to see a publication object in the BI platform:            |
|            |                                            | • View right on the publication                                                  |
|            |                                            | • View Instance right on the publication                                          |
|            |                                            | You do not need these rights to see content sent to a BI Inbox..                 |
| Recipient  | Subscribe to or unsubscribe from a publication | • View right on the publication                                           |
|            |                                            | • Subscribe right on Enterprise recipients                                      |

### 10.2.1 Publishers and recipients: Who has rights to view what

A publisher (the person who owns and schedules a publication) can view all publication instances for all recipients. Recipients can view only their own personalized publication instances.

These viewing rights ensure maximum security for publication data because only the publisher has rights to schedule publications and to view all publication instances.

If you are a publisher and want to add yourself to a publication as a recipient, create two user accounts for yourself: a Publisher account and a Recipient account. The Publisher account grants you access rights to design and to schedule publications, and the Recipient account grants you the access rights of a typical recipient.

### 10.3 Publishing concepts

#### 10.3.1 Report bursting

During publishing, data in documents is refreshed against data sources and personalized before a publication is delivered to recipients—this combined process is known as report bursting.

Depending on the size of a publication and how many recipients it is intended for, you can use the following report bursting methods:
• **One database fetch for all recipients**: All documents in a publication are refreshed once, personalized, and delivered to each recipient. This report bursting method uses the data source logon credentials of the publisher to refresh data.
This is the default option for Web Intelligence document publications and the recommended option to minimize the impact of publishing on your database. The performance of this option depends on the number of recipients.
This option is secure only when source documents are delivered as static documents. For example, a recipient who receives a Web Intelligence document in its original format can modify the document and view data associated with other recipients. However, if the document is delivered as a PDF file, data is secure. This option is secure for most Crystal reports, regardless of whether reports are delivered in their original format.

• **One database fetch for each batch of recipients**: A publication is refreshed, personalized, and delivered to recipients in batches, based on the personalization values specified for the recipients. The batch size depends on the specified personalization value and is non-configurable. This report bursting method uses the data source logon credentials of the publisher to refresh data.
This is the default option for Crystal report publications and the recommended option for high-volume scenarios. With this option, you can process batches concurrently on different servers, which can greatly decrease the processing load and time required for large publications.
This option is not available for Web Intelligence documents.

• **One database fetch per recipient**: Data in a document is refreshed for every recipient. This report bursting method uses the data source logon credentials of the recipient to refresh data. For example, if there are five recipients for a publication, the publication is refreshed five times.
This option is recommended to maximize security for delivered publications.
For Crystal reports based on universes or on Business Views support, select this option to maximize security.

**Related Information**

Selecting a report bursting method in the CMC [page 142]

Select a report bursting method to determine how source documents are personalized, processed, and delivered in a publication.

**10.3.2 Delivery rules**

Delivery rules affect how documents in publications are processed and distributed. When you set delivery rules on documents, the publication is delivered to recipients only if the content in the documents meets certain conditions.

**Note**

This feature is not available for Web Intelligence documents.

There are two types of delivery rules:
### Delivery rule

<table>
<thead>
<tr>
<th>Delivery rule</th>
<th>Description</th>
</tr>
</thead>
</table>
| Global delivery rule| If the data in a designated document meets the delivery rule, the publication is delivered to all recipients.  
The designated document for a global delivery rule can be different from the document or documents used in a publication. For example, you can set a global delivery rule on a document that is used as a dynamic recipient source, instead of on a document in the publication. |
| Recipient delivery rule | If the data in the recipient’s instance meets the delivery rule, the instance is delivered to all recipients.                                      |

If a publication has both a global delivery rule and recipient delivery rules, the global delivery rule is evaluated first to determine whether the publication will be processed. If the publication meets the global delivery rule, the BI platform evaluates the recipient delivery rules to determine which instances to process and distribute for each recipient.

How you set delivery rules depends on the document type that you want to publish. For Crystal reports, you specify a delivery rule based on a named alert that the report designer creates in the Crystal report. You can also set a delivery rule based on whether a personalized publication contains any data.

The following diagram illustrates how an alert-based global delivery rule works. The global delivery rule is set on a document in the publication. The Crystal report has a Revenue alert for values greater than 100,000. The publisher creates a global delivery rule based on the Revenue alert. The Crystal report will be delivered to recipients only if revenue exceeds 100,000. In this case, the delivery rule is met so the Crystal report is delivered.

![Figure 1: Global delivery rule is met](image)

The following diagram illustrates how a recipient delivery rule works. The publisher creates a recipient delivery rule by which a Crystal report will be delivered only to recipients for whom the report contains data. When the report is personalized for each recipient, Green Recipient has no data in the Crystal report and does not receive the publication. Blue Recipient and Orange Recipient have data in the report and, therefore, receive the publication.

![Figure 2: Recipient delivery rule is not met](image)
In publications that contain multiple documents and objects, each document can have its own recipient delivery rule. The following options are available for processing and delivery:

- If a document in a publication fails to meet its recipient delivery rule for a recipient, the entire publication is not delivered for that recipient.
- If a document in the publication fails to meet its recipient delivery rule for a recipient, that document is not delivered, but all other documents in the publication are delivered for that recipient.

Delivery rules are useful because they more efficiently process and distribute publications intended for many recipients. For example, a publisher at an insurance company creates a publication for its clients that contains the following objects:

- An insurance bill (personalized Crystal report)
- A monthly statement (personalized Crystal report)
- A payment methods brochure (PDF file)

In the insurance bill, there is an Amount Due alert for values greater than zero. The publisher creates an Amount Due recipient delivery rule for the insurance bill that publishes and distributes the insurance bill only when a client owes a payment. The publisher also specifies that the entire publication should not publish when the insurance bill fails to meet the delivery rule—he does not want clients to receive a monthly statement and a brochure when they do not owe a payment. When the publication runs, the publication is processed and distributed only to clients who owe payments.

If a Crystal reports publication is scheduled to print when the publication runs, the print job occurs, regardless of whether a document in the publication fails to meet a delivery rule and is not delivered to a recipient. This is because print jobs are processed during personalization, and delivery rules are applied to publications after personalization.
10.3.3 Dynamic recipients

Dynamic recipients are publication recipients who do not have user accounts in the BI platform but do have user information in an external data source, such as a database or an LDAP or AD directory.

To distribute a publication to dynamic recipients, use a dynamic recipient source—a document or custom data provider that provides information about publication recipients outside of the platform. You can use one dynamic recipient source per publication to link directly to an external data source and retrieve the latest data for dynamic recipients. Dynamic recipient sources decrease administrative costs because you do not have to create BI platform user accounts for dynamic recipients before distributing publications to them.

For example, when a billing company distributes bills to customers who are not BI platform users, the customer information exists in an external database. The publisher creates a document based on the external database and uses the document as a dynamic recipient source for a publication. Customers receive the billing publication, and the dynamic recipient source allows the publisher and the system administrator to maintain up-to-date contact information.

You can perform the following actions with a dynamic recipient source:

- Simultaneously deliver a single publication to dynamic recipients and to BI platform users
  Dynamic recipients cannot unsubscribe themselves automatically from a publication.
- Preview dynamic recipients list when you create a publication
- Specify whether to deliver a publication to all dynamic recipients or to exclude some dynamic recipients
- Deliver publications to external destinations, such as email or an FTP server
  BI Inbox is not a valid destination for dynamic recipients because they do not have a user account in the BI platform.

To use a dynamic recipient source, specify a column for each of the following values:

- Recipient ID (required)
- Full name of recipient
- Email address

The Recipient ID column determines the number of dynamic recipients who will receive the publication. Sort dynamic recipient sources by recipient ID.

For general information about creating reports, see the SAP Crystal Reports User Guide. For information about creating a custom-coded dynamic recipient source, see the SAP BusinessObjects Business Intelligence Platform Java SDK Developer Guide.
10.3.4 Publication delivery destinations

A destination is the location that a publication is delivered to. You can deliver a publication to multiple destinations.

A destination can be the BI platform location where a publication is stored, a BI Inbox, an email address, an FTP server, or a directory in the file system. You can specify multiple destinations for a publication. If you publish multiple Crystal reports, you can merge them, on a per-destination basis, into a single PDF file. If you publish a publication as a compressed (.zip) file, you can compress or extract instances on a per-destination basis. For example, you can compress instances for email recipients and extract instances for BI Inboxes.

10.3.4.1 Publication destinations

These destinations are available for scheduled publications:

- Default Enterprise Location
- BI Inbox
- Email
- FTP Server
- File System
- SAP StreamWork (if enabled and configured)

The **Deliver objects to each user** check box is selected by default for all destinations. However, in some cases, you may not want to deliver objects to each user. For example, three recipients have identical personalization values so they receive the same data in publication instances. If you clear the **Deliver objects to each user** check box, one publication instance is generated and delivered to all three recipients. If you select the **Deliver objects to each user** check box, the same publication instance is delivered three times (once for each recipient).

Default Enterprise Location

If you send a publication to this location, choose a folder that is accessible to all recipients.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| The folder it was created in | ● Merge all exported PDF documents (Crystal reports only)  
                                  ● Package the publication as a compressed (.zip) file | Output File Repository Server  
                                  Historical instances are saved to the default Enterprise server but not to any other destination. |
BI Inbox

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| Each recipient’s BI Inbox | ● Use the default settings for the destination  
● Deliver objects to individual users  
To quickly locate a user, you can search for a recipient’s user name, full name, or email address in the Find title box.  
● Use the default file name, enter a file name, or add placeholders  
If you select Use Specific Name, enter a file extension or add the File Extension placeholder in the box.  
● Automatically add the extension to a file name  
If you do not add a file extension to a file name, you may be unable to open the document.  
● Send the publication as a shortcut or a copy  
If you send a publication to a recipient’s BI Inbox shortcut, choose a folder that is accessible to all recipients. To send a publication shortcut to a BI Inbox, select both BI Inbox and Default Enterprise Location as the destination.  
● Merge all exported PDF documents (Crystal reports only)  
● Package the publication as a compressed (.zip) file | ● Output File Repository Server  
● Specified BI Inboxes |

Email

Before you can schedule or send a report instance to this destination, you must enable and configure the email (SMTP) destination on the Adaptive Job Server.
<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| Each recipient via email | ● Use the default settings for the destination  
● Deliver objects to individual users  
● (Required) Enter your email address in the From box  
If you do not enter your email address, the BI platform uses the email address associated with the publisher’s account. If the publisher’s account has no email address, the platform uses the email address for the Adaptive Job Server. If there is no email address in the From box, the publisher’s account, or the Adaptive Job Server, the publication will fail.  
● Enter recipient email addresses or add the Email Address placeholder to the To box  
● Enter recipient email addresses or add the Email Address placeholder to the Cc box  
● Enter recipient email addresses or add the Email Address placeholder to the Bcc box  
● Enter a subject or add placeholders to the Subject box  
● Enter information to deliver with the publication or add placeholders and embed a dynamic content document in the body of the email in the Message box  
● Attach source document instances to an email  
● Accept the default file name, enter a file name, or add placeholders  
If you select Use Specific Name, enter a file extension or add the File Extension placeholder to the box. | ● Output File Repository Server  
● Specified email recipients |
### FTP Server

If you are sending the publication to the **FTP Server** destination and some recipients share identical personalization values, you can clear the **Deliver objects to each user** check box to decrease overall processing time. When you clear **Deliver objects to each user**, placeholders used when configuring destinations will contain the publisher’s (not the recipient’s) information.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| An FTP server           | • Use the default settings for the destination  
                          • Enter the port number, user name and password, and account  
                          • Enter a directory name  
                          • Accept the default file name, enter a file name, or add placeholders  
                          If you select **Use Specific Name**, enter a file extension or add the **File Extension** placeholder to the box.  
                          • Automatically add the extension to file name  
                          If you do not add a file extension to a file name, you may be unable to open the document.  
                          • Merge all exported PDF documents (Crystal reports only)  
                          • Package the publication as a compressed (.zip) file | • Output File Repository Server  
                          • Selected FTP server |
File System

If you are sending the publication to the *File System* destination and some recipients share identical personalization values, you can clear the *Deliver objects to each user* check box to decrease overall processing time. When you clear *Deliver objects to each user*, placeholders used when configuring destinations will contain the publisher’s (not the recipient’s) information.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| A directory on a file system (You must enter the directory for the publication.) | ● Use the default settings for the destination  
● Enter a user name and password to access the file location  
● Deliver objects to individual users  
● Accept the default file name, enter a file name, or add placeholders  
If you select *Use Specific Name*, enter a file extension or add the *File Extension* placeholder to the box.  
● Automatically add the extension to file name  
If you do not add a file extension to a file name, you may be unable to open the document.  
● Merge all exported PDF documents (Crystal reports only)  
● Package the publication as a compressed (.zip) file | ● Output File Repository Server  
● Selected file location |

SAP StreamWork

This destination is available if collaboration is configured and enabled in the BI platform.
### 10.3.5 Publication formats

A format defines the file type for a document in a publication.

You can publish a single document in multiple formats; each format you choose will result in an instance of the document. Each instance can be delivered to multiple destinations. For publications with multiple documents, you can specify a different format for each document. For publications that contain Web Intelligence documents, you can publish a whole document or a report tab in a document to multiple formats.

The formats you choose for a document apply to all recipients of the publication. For example, you cannot publish a document as a Microsoft Excel file for one recipient and a PDF file for another recipient. If you want recipients to receive instances in both formats, each recipient must receive an Excel file and a PDF file.

#### Related Information

- **Selecting the publication format(s) for a Crystal report** [page 127]
  
  You select the publication format for a Crystal report in the Schedule dialog box.

- **Selecting the publication format for a Web Intelligence document** [page 137]
  
  You must select a publication format for each dynamic content source Web Intelligence document in a publication.

---

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| Sent for collaboration with other users. | ● Send or schedule Crystal reports and Web Intelligence documents to collaboration activities  
● Monitor feeds  
● Follow documents and instances to track comments and discussions  
● Post comments on documents and instances and view comments posted by other users about public documents | One of the following collaboration applications:  
● SAP Jam  
● SAP StreamWork |
## 10.3.5.1 Publication formatting options

<table>
<thead>
<tr>
<th>Document type</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All document types</td>
<td>mHTML</td>
<td>Publishes a document in mHTML format, which you can embed in an email. For Crystal reports, you can embed the content of one report in an email. For Web Intelligence documents, you can embed the content of one report tab in an email. Documents are output in the order that source documents are listed in the New Publication dialog box. For example, documents at the top of the dialog box appear at the top of the email.</td>
</tr>
<tr>
<td>PDF</td>
<td></td>
<td>Publishes a document as a static PDF file. When this option is used with PDF merging, documents are output in the order that source documents are listed in the New Publication dialog box. For example, documents at the top of the dialog box appear at the top of the merged PDF file.</td>
</tr>
<tr>
<td>Microsoft Excel (97-2003)</td>
<td></td>
<td>Publish a Crystal report as an Excel (.xls) file that contains only data</td>
</tr>
<tr>
<td>Microsoft Excel Workbook Data-only</td>
<td></td>
<td>Publishes a Crystal report in XML (.xml) format</td>
</tr>
<tr>
<td>XML</td>
<td></td>
<td>Publishes a Crystal report in its original (.rpt) format</td>
</tr>
<tr>
<td>Crystal Reports</td>
<td></td>
<td>Publishes a Crystal report in read-only (.rptr) format</td>
</tr>
<tr>
<td>Crystal Reports (RPTR)</td>
<td></td>
<td>Publishes a Crystal report as an Excel (.xls) file that contains only data</td>
</tr>
<tr>
<td>Microsoft Word (97-2003)</td>
<td></td>
<td>Publishes a Crystal report as a Microsoft Word (.doc) file and preserves the original formatting of the Crystal report. Use this option when you expect recipients to view a publication without making changes to it.</td>
</tr>
<tr>
<td>Microsoft Word - Editable (RTF)</td>
<td></td>
<td>Publishes a Crystal report as a Word (.rtf) file that recipients can edit. Use this option when you expect recipients to view a publication and edit its content.</td>
</tr>
<tr>
<td>Rich Text Format (RTF)</td>
<td></td>
<td>Publishes a Crystal report in Rich Text Format (.rtf)</td>
</tr>
<tr>
<td>Plain Text</td>
<td></td>
<td>Publishes a Crystal report in plain text (.txt) format</td>
</tr>
</tbody>
</table>
### 10.3.6 Personalization

Personalization is the process of filtering data in source documents so that only relevant data appears to publication recipients.

Personalization alters the view of data but does not change or secure the data being queried from the data source.

The following diagram illustrates how personalization works. For example, an unpersonalized report contains data types 1, 2, and 3. When personalization is applied to the report, users receive only data that is relevant to them. User 2 receives only data type 2, User 1 receives only data type 1, and User 3 receives only data type 3.

```
1 2 3  
    (2) (1) (3)  PERSONALIZATION

2

1

3
```

To personalize source documents:

- For Enterprise recipients, you must apply a profile when you design a publication. Before you can use profiles to personalize data for Enterprise recipients, the profiles must be configured in the BI platform. If you need profiles added to the platform, contact your system administrator.
- For dynamic recipients, you can map a data field or column in the source document to data in the dynamic recipient source. For example, you can map a Customer ID field in a source document to the Recipient ID field in the dynamic recipient source.
To view a list of recipients who will receive unpersonalized publication instances after personalization, select \(\text{Additional Options} \rightarrow \text{Advanced}\) in the \textit{New Publication} dialog box, and select the \textit{Display users who have no personalization applied} check box.

Related Information

- \textit{Personalizing a Crystal report using parameter values} [page 126]
  You personalize a Crystal report in the \textit{Schedule} dialog box.

- \textit{Personalizing a Crystal report by filtering fields} [page 126]
  You personalize a Crystal report in the \textit{Schedule} dialog box.

- \textit{Personalizing a Web Intelligence document with a global profile target} [page 137]
  You can personalize a Web Intelligence document for Enterprise recipients by filtering with a global profile target.

- \textit{Personalizing a Web Intelligence document by filtering fields} [page 138]

- \textit{Personalized placeholders for publication source document names} [page 104]
  A placeholder is a container for variable data. Adding personalized placeholders to source file names can help recipients identify filtered data.

10.3.6.1 Personalized placeholders for publication source document names

A placeholder is a container for variable data. Adding personalized placeholders to source file names can help recipients identify filtered data.

Recipients who belong to multiple user groups with different personalization values can distinguish between multiple versions of the same source document, without viewing its contents. If a publication contains more than one source document, the \textit{Add placeholder} list for \textit{Use Specific Name} contains personalized placeholders only if all source documents were filtered on the same field.

The following personalized placeholders are available for reports:

- \texttt{%fieldname\_VALUE%}
  For example, when you select the \textit{Email Address} placeholder, \texttt{%SI\_EMAIL\_ADDRESS%} appears in the \textit{Use Specific Name} box. At run-time, the placeholder is replaced by the value of the field used to filter the report. This placeholder is unique for each recipient.

- \texttt{%fieldname\_NAME%}
  For example, when you select the \textit{Title} placeholder, \texttt{%SI\_Name%} appears in the \textit{Use Specific Name} box. At run-time, the placeholder is replaced by the actual name of the field. This placeholder is the same for all recipients.

Related Information

- \textit{Selecting personalized placeholders for publication source documents} [page 124]
You select personalized placeholders for a publication in the Schedule dialog box.

10.3.6.2 Personalized placeholders for email fields

A placeholder is a container for variable data. You can use personalized placeholders in the Subject box and the Message box when sending a publication via email.

For each filter used in a report during personalization, the following placeholders appear in the Add placeholder list:

- **%Field - Query 1-VALUE%**
  At run-time, the placeholder is replaced by the personalized value used to filter the report. This placeholder is unique for each recipient.

- **%Field - Query 1-NAME%**
  At run-time, the placeholder is replaced by the name of the field. This placeholder is the same for all recipients.

Before you can use personalized placeholders in the Subject or Message box, all source documents for the publication must be personalized on the same field. If a publication contains several source documents, the Add placeholder list for the Subject and Message boxes displays personalization parameters only when all source documents are filtered on the same field(s).

10.3.7 Publication extensions

A publication extension is a library of code that applies business logic to publications.

Use a publication extension to automatically customize publications after processing or delivery. You can use publication extensions to perform the following tasks:

- Merge documents of the same type (for example, merge multiple Excel spreadsheets into a single Excel workbook)
- Add password protection to or encrypt a document
- Convert a document to a different format
- Create custom log files for a publication job

You add publication extensions to publications in the Central Management Console (CMC) of the BI platform. (You cannot use publication extensions when designing a publication in the BI launch pad.) However, before you can add a publication extension, the extension must be deployed on machines that run the Adaptive Processing Server. The location of the server varies, depending on the operating system:

- On Windows, the location is `<InstallDir>`\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\lib\.
- On Unix, the location is `<InstallDir>`/sap_bobj/enterprise_xi40/java/lib/.

Once an extension is deployed, you must restart the Adaptive Processing Server and any other servers that host a Publishing Service. For more information about publication extensions, see the SAP BusinessObjects Business Intelligence Platform Java SDK Developer Guide.
Related Information

Adding a publication extension in the CMC [page 140]
A publication extension is a library of code that applies business logic to publications. You must add a publication extension before you can use the extension in a publication.

10.3.8 Subscriptions

A subscription enables users who are not publication recipients to view the latest instance.

Enterprise recipients can unsubscribe from a publication at any time. Dynamic recipients can neither subscribe to or unsubscribe from a publication.

Users with the appropriate access rights can subscribe and unsubscribe other users. To subscribe to or unsubscribe from a publication, the following items are required:

- A BI platform account
- Access to the BI launch pad or to the Central Management Console (CMC) in the platform
- View rights to see the publication
- Subscriber rights for the user account (Enterprise recipients)

Related Information

Subscribing to or unsubscribing from a publication [page 144]
To subscribe to a publication after it is scheduled, subscribe to its recurring instance—or reschedule the publication.

10.3.9 PDF-file merging for Crystal reports

You can merge PDF instances of Crystal reports and static PDF documents into a single PDF file and then perform the following tasks on the merged PDF file:

- Add and format a table of contents
- Insert running page numbers
- Add user and owner passwords to view and edit the PDF file
- Set restrictions on what recipients can do with the PDF file

All static PDF source documents are included in the merged PDF file. Static source documents that are not PDF files are excluded.
10.4 Publication results—how to view

Publication results can be viewed by the publisher, by recipients, or in a log file for the publication job.

Viewing results as a publisher

You can view the results of a publication in various ways. After a publication runs, the publication history appears, listing publication instances, the times when the publication ran, and whether the publication succeeded or failed. In the Instance Time column, you can click a link to a publication instance to view instances generated for all recipients when the publication ran.

Viewing log files for publication jobs

Log files are useful for troubleshooting a publication and for identifying which recipients did not receive a publication instance. The BI platform logs publication job information as each batch of personalized publication instances is processed and then consolidates the details into one or more log files. The maximum log file size is 10 MB and is non-configurable. If you run a high-volume publication with many details, the publication instance may have several log files.

You can view log files for a publication instance in the following ways in the History dialog box:

- To view the last log file in a series, in the Status column, click the status (Success, Failed, or Running), and click View Log File at the bottom of the Instance Details dialog box. You can view the last log file while a publication is running.
- To view all log files, in the Instance Time column, click the link for a publication instance. Log files are listed after the personalized instances.

Log files are updated with new information every two minutes. If a publication job has been running less than two minutes, the log file may have a status of Pending.

Viewing results as a recipient

The following table summarizes the ways you can view a publication:
<table>
<thead>
<tr>
<th>Destination</th>
<th>How to view the publication result</th>
</tr>
</thead>
</table>
| **Default Enterprise Location** | Dynamic recipients cannot log on to the BI platform to view publication results.  
As a recipient, you can view only your own personalized publication instances in the platform. You cannot view publication instances that are personalized for other recipients. |
| **BI Inbox**                | Dynamic recipients cannot log on to the BI launch pad to view publication results. |
| **Email**                   | Log on to your email to view embedded publication content or to download the attachment or attachments. |
| **FTP server**              | Log on to your FTP host. |
| **Local disk**              | Go to the location specified when the publication was designed. |
11 Working with publications

11.1 Creating a publication in the BI launch pad

1. On the Documents tab, expand the Folders drawer, and locate the folder to create a publication in.
2. Right-click the folder and select New Publication. The New Publication dialog box appears, with general property options displayed.
3. (Required) In the Title box, enter the title of the publication.
4. (Optional) In the Description box, enter a description of the publication.
5. (Optional) In the Keywords box, enter keywords that are associated with the publication’s content.
6. Click Source Documents in the navigation list, and then click the Add button.
7. In the Select Source Documents dialog box, select one or more source documents to add to the publication, and click OK. The Refresh At Runtime check box is selected by default for each source document. It refreshes the document against its data source when the publication runs.
8. If you do not want to refresh source documents at runtime, clear the Refresh At Runtime check box.
9. Click Save & Close.

You must specify other information required for the publication—recipients, delivery formats and destinations, and how documents are personalized.

11.2 Creating a publication in the CMC

1. Under Folders in the Central Management Console (CMC) in the BI platform, click the group tree, and locate the folder to create a publication in.
2. Right-click the folder and select New Publication. The New Publication dialog box appears, with general property options displayed.
3. (Required) In the Title box, enter the title of the publication.
4. (Optional) In the Description box, enter a description of the publication.
5. (Optional) In the Keywords box, enter keywords that are associated with the publication’s content.
6. Click Source Documents in the navigation list, and then click the Add button.
7. In the Select Source Documents dialog box, select one or more source documents to add to the publication, and click OK. The Refresh At Runtime check box is selected by default for each source document. It refreshes the document against its data source when the publication runs.
8. If you do not want to refresh a source document when the publication runs, clear the Refresh At Runtime check box for the document.
9. Click Save & Close.
11.3 Publications for Enterprise or dynamic recipients

You can send publications to Enterprise recipients via a BI Inbox, email, FTP, the file system, or collaboration or to dynamic recipients via email.

Enterprise recipients are users who are part of the BI platform system. You can send reports for these users to their BI Inbox or via email, FTP, the file system, or collaboration.

Dynamic recipients are non-Enterprise users, either outside of your network or not configured with users, groups, profiles, security, and so on. For example, dynamic recipients might be suppliers of your company’s monthly office supplies and inventory. A BI Inbox is not a valid destination for dynamic recipients because they do not have a BusinessObjects Enterprise user account.

Dynamic recipients are different from Enterprise recipients in the following ways:

- Publications can be sent to dynamic recipients only via email.
- Dynamic recipients can be used only with local profiles.

To create publications, you create a source file and a recipient file, set up the publication in the BI launch pad, and then schedule the publication.

The source file contains raw data for the publication; a publication can include more than one source file. For example, for a monthly report on suppliers, the source file might list inventory SKU numbers and categories and include a unique ID/supplier defined in a “Supplier ID” field. The recipient file must contain the same unique ID/supplier as the source file as well as recipient email addresses to map to the source file. In the example, the recipient file should include the same ID in a “Supplier ID” field, supplier names, and supplier email addresses.

11.3.1 Creating a publication for Enterprise recipients

Enterprise recipients are users who are part of the BI platform system. For Enterprise recipients, you must create prompts to define filtering in the source file.

1. In the Central Management Console (CMC) in the BI platform, click Profiles.
2. Create users and add them to user groups as needed.
3. Select Manage New New Profile.
4. In the Create New Profile dialog box, enter a title and description for the profile, and click OK.
5. Double-click the profile you created to configure its properties.
6. Click User Security in the navigation list, and assign access rights to users or user groups.
7. Click Profile Targets in the navigation list, and define targets to filter source files:
   a) Locate the profile target to use in the Object column, select the check box beside it, and click Edit.
      The local profile is derived from the source file, and the global profile comes from the universe.
   b) Select Filter Expression, and click Edit.
      A dialog box appears, displaying the profile options.
   c) In the User/Group column, locate the user or the user group to define profile targets for, and select the check box beside it.
      Prompts are defined. You can create the publication in BI launch pad.
8. In the BI launch pad, on the Documents tab, expand the Folders drawer, and locate the folder to create the publication in.
a) Right-click the folder and select New Publication.
b) In the New Publication dialog box, enter the title of the publication in the Title box.
c) Click Source Documents in the navigation list, and click the Add button.
d) In the Select Source Documents dialog box, select the source file(s) for the publication, and click OK.

9. Click Enterprise Recipients in the navigation list.
10. For each user or group who should receive the publication, under Available, select the user or user group, and click > to move the user or group to the Selected area.
11. Click Personalization in the navigation list.
12. Under Global Profiles, for each source document for the publication, select the profile you created from the list in the Enterprise Recipient Mapping column.
13. Click Formats in the navigation list, and perform the following actions:
   a) Under Documents, select a report.
   b) Under Format Options for Selected Document, select the check box beside the delivery format required for the publication.
   c) Under Output Format Details, select All reports to use the same format for all reports in the publication, or choose Select one report and choose a report in the list.
14. Click Destinations in the navigation list, and select a destination:
   a) Under Select Destinations, select the Email check box.
   b) (Optional) Select the Package As ZIP File check box.
   c) Select the Deliver objects to each user check box.
   d) In the From box, enter the sender’s email address or select a placeholder in the list.
   e) In the To box, select %SI_EMAIL_ADDRESS% in the list.
   f) In the Subject box, enter the subject or select a placeholder.
   g) (Optional) In the Message box, enter a message to recipients about the publication or select a placeholder.
15. Click Prompts in the navigation list, and click Modify.
   The users or user groups you defined are listed in the User/Group column, and the prompt values you defined in steps 1-6 are listed in the Profile Value(s) column.
16. Select the check box beside each user or group who should receive the publication.
17. Click Save & Close.
   Schedule the publication to run.

11.3.2 Creating a publication for dynamic recipients

Dynamic recipients are non-Enterprise users, either outside of your network or not configured with users, groups, profiles, security, and so on.

The source file and dynamic-recipient file must be created.

1. On the Documents tab in the BI launch pad, expand the Folders drawer, and locate the folder to create a publication in.
2. Right-click the folder and select New Publication.
3. In the New Publication dialog box, enter the title of the publication in the Title box.
4. Click **Source Documents** in the navigation list, and click the **Add** button.
5. In the **Select Source Documents** dialog box, select the source file(s) for the publication, and click **OK**.
6. Click **Dynamic Recipients** in the navigation list.
7. In the **Choose the Source for Dynamic Recipients** list, select **Web Intelligence Report Dynamic Recipient Provider** or **Crystal Reports Dynamic Recipient Provider**.
8. Under **Choose the Source for Dynamic Recipients**, click **Browse**, and locate and select the recipient file.
9. Map fields from the recipient file (that is, the source document) to the publication:
   a) In the **Recipient Identifier (required)** list, select a field from the recipient file to map to the publication.
   b) In the **Full name** list, select a field from the recipient file to map to the recipient.
   c) In the **Email** list, select **Email ID** to map email addresses from the recipient file to the publication.
      You can select the **User entire list** check box to send the publication to all recipients defined in the dynamic-recipient file.
10. Click **Personalization** in the navigation list, and configure personalization for recipients:
    a) Under **Parameters**, select a report field to personalize.
    b) In the **Dynamic Recipient Mapping** column, select a field in the recipient file to map to the report field you selected.
    c) Repeat steps 10a and 10b for each field that should be sent to specific recipients.
11. Click **Formats** in the navigation list, and select a delivery format for the publication.
12. Click **Destinations** in the navigation list, and select a destination:
    a) Under **Select Destinations**, select the **Email** check box.
    b) (Optional) Select the **Package as ZIP File** check box.
    c) Select the **Deliver objects to each user** check box.
    d) In the **From** box, enter the sender’s email address or select a placeholder in the list.
    e) In the **To** box, select **%SI_EMAIL_ADDRESS%** in the list.
    f) In the **Subject** box, enter the subject or select a placeholder.
    g) (Optional) In the **Message** box, enter a message to recipients about the publication or select a placeholder.
13. Click **Save & Close**.

Schedule the publication to run.

### 11.4 Publications for SAP recipients

A publication intended for SAP recipients works the same way as a publication intended for Enterprise or dynamic recipients.

However, SAP recipients have the following differences in a publishing workflow:

- You do not use personalization to design source documents for SAP recipients. Each SAP recipient has a profile value mapped to a user account outside of the BI platform, and the profile value serves as built-in personalization. You do not need to create profiles and profile values for SAP recipients in the platform or to map profiles to source document fields.
- The only report bursting method that works for a publication intended for SAP recipients is **One database fetch per recipient**. It maximizes security and individually processes the database logon credentials of each publication recipient.
For information about single sign-on configuration and authentication, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

### 11.5 Publications for Live Office

When you design publications for use with SAP BusinessObjects Live Office, consider this information.

- Dynamic content documents can consist only of Crystal reports or Web Intelligence documents in the original format.
- Dynamic recipients are not supported.
- The only destination option available is *Default Enterprise Location*.
- If recipients receive multiple publication instances after personalization, they can view only the first publication instance in the Live Office Client. Recipients who inherit multiple profile values from group membership may receive multiple instances. To avoid sending multiple instances, assign only necessary profile values to recipients.

**Related Information**

*Personalization [page 103]*

> Personalization is the process of filtering data in source documents so that only relevant data appears to publication recipients.

### 11.6 Designing publications

To design a new publication, use the publishing feature in the BI platform.

You can access publishing in the Central Management Console (CMC) in the platform or in the BI launch pad, depending on your access rights and on your access to BI platform web-based applications.

At any point during publication design, you can save changes made to a publication, close it, reopen it, and make further changes.

#### 11.6.1 Opening a publication

1. Locate the publication:
   - In the BI launch pad, on the *Documents* tab, expand the *Folders* drawer.
   - In the Central Management Console (CMC) in the BI platform, go to the *Folders* management area.
2. Right-click the publication and select *View*.

The publication opens in a new window.
11.6.2 Defining general properties for a publication

You define properties for a publication in the Properties dialog box.

1. Right-click the publication to enter general properties for and select Properties.
   The Properties dialog box appears, displaying the publication's general properties and title.
2. (Optional) In the Description box, enter a description of the publication.
3. (Optional) In the Keywords box, enter keywords that are associated with the publication's content.
4. Click Save & Close.

11.6.3 Adding source documents

You add source documents to a publication in the New Publication dialog box.

You can add source documents to a publication when you create the publication; you cannot add them later.

When choosing source documents, the dynamic content document type determines which options are available.

When sending source documents as an attachment or a merged PDF file, you can set the order in which documents appear. In the New Publication dialog box, in the Source Documents area, select a document in the Selected list, and click Move Up or Move Down to move the document to a different place in the order.

1. In the New Publication dialog box, click Source Documents.
2. Click Add.
3. In the Select Source Documents dialog box, locate and select dynamic content documents of the same document type to include in the publication, and click OK.
   Double-click a source document to select it. To simultaneously select several source documents, hold down the SHIFT or CTRL key and click each folder.
   The source documents you selected appear in the Selected list in the New Publication dialog box. The check box in the Refresh At Runtime column is selected by default for the source document. When this check box is selected, the document is refreshed against its data source when the publication runs.
4. If you do not want to refresh a source document against its data source when the publication runs, clear the check box for that document in the Refresh At Runtime column.
   To improve system performance, clear the check box in the Refresh At Runtime column for each document you do not need to refresh.
5. Click Save & Close.

11.6.4 Selecting a destination for a publication

You select a destination for a publication in the Schedule dialog box.

1. Right-click the publication to select a destination for and select Schedule.
2. In the Schedule dialog box, click Destinations.
3. (Optional) To avoid storing publication instances on your system, clear the Default Enterprise Location check box under Select Destinations.
4. Set a low instance limit on the publication object.
   For instructions, see the SAP BusinessObjects Business Intelligence Platform User Guide.

5. Under Select Destinations, select the check box beside each destination that you want to send the publication to.
   If you want to create a shortcut to the publication, select both BI Inbox and Default Enterprise Location as destinations.
   If the publication will be sent to email recipients and you want to embed a link to the Enterprise location in the email body, select both Email and Default Enterprise Location as destinations.
   The destination you chose appears in the Show options for selected destinations list. If you selected multiple destinations, options appear for the last check box you selected.

6. If necessary, select a destination to configure in the Show options for selected destinations list.
   Options for the destination appear.

7. (Optional) To choose a name for the publication, select Use Specific Name, and enter a name or select a placeholder in the Add placeholder list.
   If you do not choose a name, a system-generated name is assigned to a publication. When the publication runs, a value will be inserted in each placeholder.

8. (Optional) If you selected Use Specific Name and the publication contains multiple documents that you want to assign individual names to, select the Specific Name per Document check box, and enter a name or select a placeholder in the Add placeholder list for each document.
   If you do not choose a name, the same system-generated name is assigned to each document.

9. (Email only) To embed a link to the Enterprise location in the email body, position the cursor in the Message box, and select Viewer in the Add placeholder list under the box.
   The placeholder %SI_VIEWER_URL% is inserted in the email body. It will be replaced by a link when the publication runs. If you are unable to embed a link, confirm that you selected both Email and Default Enterprise Location as the destination.

10. (BI Inbox only) Under Send As, click Shortcut to create a shortcut to the publication or Copy to create a copy of the publication.
    If you are unable to create a shortcut, confirm that you selected both BI Inbox and Default Enterprise Location as the destination.

11. If you selected multiple destinations, repeat steps 5 to 10 for each destination to select and configure the destination.

12. Click OK.

### 11.6.4.1 Publication destinations

These destinations are available for scheduled publications:

- Default Enterprise Location
- BI Inbox
- Email
- FTP Server
- File System
- SAP StreamWork (if enabled and configured)
The **Deliver objects to each user** check box is selected by default for all destinations. However, in some cases, you may not want to deliver objects to each user. For example, three recipients have identical personalization values so they receive the same data in publication instances. If you clear the **Deliver objects to each user** check box, one publication instance is generated and delivered to all three recipients. If you select the **Deliver objects to each user** check box, the same publication instance is delivered three times (once for each recipient).

### Default Enterprise Location

If you send a publication to this location, choose a folder that is accessible to all recipients.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| The folder it was created in | ● Merge all exported PDF documents (Crystal reports only)  
● Package the publication as a compressed (.zip) file | Output File Repository Server  
Historical instances are saved to the default Enterprise server but not to any other destination. |
## BI Inbox

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| Each recipient’s BI Inbox | - Use the default settings for the destination  
  - Deliver objects to individual users  
    To quickly locate a user, you can search for a recipient’s user name, full name, or email address in the Find title box.  
  - Use the default file name, enter a file name, or add placeholders  
    If you select Use Specific Name, enter a file extension or add the File Extension placeholder in the box.  
  - Automatically add the extension to a file name  
    If you do not add a file extension to a file name, you may be unable to open the document.  
  - Send the publication as a shortcut or a copy  
    If you send a publication to a recipient’s BI Inbox shortcut, choose a folder that is accessible to all recipients. To send a publication shortcut to a BI Inbox, select both BI Inbox and Default Enterprise Location as the destination.  
  - Merge all exported PDF documents (Crystal reports only)  
  - Package the publication as a compressed (.zip) file | - Output File Repository Server  
  - Specified BI Inboxes |

## Email

Before you can schedule or send a report instance to this destination, you must enable and configure the email (SMTP) destination on the Adaptive Job Server.
<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each recipient via email</td>
<td>• Use the default settings for the destination &lt;br&gt;• Deliver objects to individual users &lt;br&gt;• (Required) Enter your email address in the <em>From</em> box  &lt;br&gt;  If you do not enter your email address, the BI platform uses the email address associated with the publisher’s account. If the publisher’s account has no email address, the platform uses the email address for the Adaptive Job Server. If there is no email address in the <em>From</em> box, the publisher’s account, or the Adaptive Job Server, the publication will fail.  &lt;br&gt;• Enter recipient email addresses or add the <em>Email Address</em> placeholder to the <em>To</em> box  &lt;br&gt;• Enter recipient email addresses or add the <em>Email Address</em> placeholder to the <em>Cc</em> box  &lt;br&gt;• Enter recipient email addresses or add the <em>Email Address</em> placeholder to the <em>Bcc</em> box  &lt;br&gt;• Enter a subject or add placeholders to the <em>Subject</em> box  &lt;br&gt;• Enter information to deliver with the publication or add placeholders and embed a dynamic content document in the body of the email in the <em>Message</em> box  &lt;br&gt;• Attach source document instances to an email  &lt;br&gt;• Accept the default file name, enter a file name, or add placeholders  &lt;br&gt;  If you select <em>Use Specific Name</em>, enter a file extension or add the <em>File Extension</em> placeholder to the box.</td>
<td>• Output File Repository Server  &lt;br&gt;• Specified email recipients</td>
</tr>
</tbody>
</table>
### FTP Server

If you are sending the publication to the **FTP Server** destination and some recipients share identical personalization values, you can clear the **Deliver objects to each user** check box to decrease overall processing time. When you clear **Deliver objects to each user**, placeholders used when configuring destinations will contain the publisher’s (not the recipient’s) information.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| An FTP server (You must enter the FTP server location in the Host box. If you do not, the platform uses the FTP server configured for the Adaptive Job Server.) | • Use the default settings for the destination  
• Enter the port number, user name and password, and account  
• Enter a directory name  
• Accept the default file name, enter a file name, or add placeholders  
If you select **Use Specific Name**, enter a file extension or add the **File Extension** placeholder to the box.  
• Automatically add the extension to file name  
If you do not add a file extension to a file name, you may be unable to open the document.  
• Merge all exported PDF documents (Crystal reports only)  
• Package the publication as a compressed (.zip) file | • Output File Repository Server  
• Selected FTP server |
**File System**

If you are sending the publication to the *File System* destination and some recipients share identical personalization values, you can clear the *Deliver objects to each user* check box to decrease overall processing time. When you clear *Deliver objects to each user*, placeholders used when configuring destinations will contain the publisher's (not the recipient's) information.

<table>
<thead>
<tr>
<th>Publication destination</th>
<th>Actions you can perform on the publication</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
| A directory on a file system (You must enter the directory for the publication.) | ● Use the default settings for the destination  
● Enter a user name and password to access the file location  
● Deliver objects to individual users  
● Accept the default file name, enter a file name, or add placeholders  
   If you select *Use Specific Name*, enter a file extension or add the *File Extension* placeholder to the box.  
● Automatically add the extension to file name  
   If you do not add a file extension to a file name, you may be unable to open the document.  
● Merge all exported PDF documents (Crystal reports only)  
● Package the publication as a compressed (.zip) file | ● Output File Repository Server  
● Selected file location |

**SAP StreamWork**

This destination is available if collaboration is configured and enabled in the BI platform.
11.6.5 Selecting a recurrence pattern

The recurrence pattern determines how often a publication runs. You select a recurrence pattern for a publication in the Schedule dialog box.

1. Right-click the publication to set a recurrence pattern for and select Schedule.
2. In the Schedule dialog box, click Recurrence.
3. In the Run object list, select a recurrence pattern.
4. In the Number of retries allowed box, enter the number of times the server should attempt to rerun a failed job.
5. In the Retry interval in seconds box, enter how long the server should wait before attempting to rerun a job.
6. Click Schedule.

The publication runs at the scheduled times.

11.6.5.1 Recurrence pattern options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now</td>
<td>Runs the object one time, starting immediately</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| *Once* | Runs the object once, at the specified start time. If you schedule an object with events, the object will run once, if the event is triggered between the start and end times.  
Choose when to start and to stop running the object in the *Start Date/Time* and *End Date/Time* lists, and enter the date of the start and the stop times. |
| *Hourly* | Creates an instance every hour, at the specified time. The first instance will be created at the specified start time, and instances will be created hourly at that time, until the object stops running at the specified end time.  
Choose the time to run the object in the *Hour(N)* and *Minute(X)* lists, select when to start and to stop running the object in the *Start Date/Time* and *End Date/Time* lists, and enter the date of the start and the stop times. |
| *Daily* | Runs the object once daily, at the specified start time. The first instance will be created at the specified start time, and instances will be created daily at that time, until the object stops running at the specified end time.  
Choose the day of the week to run the object in the *Days(N)* box, select when to start and to stop running the object in the *Start Date/Time* and *End Date/Time* lists, and enter the date of the start and the stop times. |
| *Weekly* | Runs the object each week on the selected days, at the specified start time. The first instance will be created at the specified start time, and instances will be created each week on those days at that time, until the object stops running at the specified end time.  
Select the check box for each day on which to run the object, choose when to start and to stop running the object in the *Start Date/Time* and *End Date/Time* lists, and enter the date of the start and the stop times. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Monthly</strong></td>
<td>Runs the object on the specified date, at the specified start time, and at the specified monthly intervals. The first instance will be created at the specified start time, and instances will be created in monthly intervals at that time, until the object stops running at the specified end time. Choose the month in which to run the object in the Month(N) box, choose when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td><strong>Nth Day of Month</strong></td>
<td>Creates an instance each month on the specified day, at the specified start time. The first instance will be created at the specified start time, and instances will be created on the specified day of each month at that time, until the object stops running at the specified end time. Enter the time to start and to stop running the object and the day of the month on which to run the object.</td>
</tr>
<tr>
<td><strong>1st Monday of Month</strong></td>
<td>Creates an instance on the first Monday of each month, at the specified start time. Enter the time to start and to stop running the object.</td>
</tr>
<tr>
<td><strong>Last Day of Month</strong></td>
<td>Creates an instance on the last day of each month, at the specified start time. Enter the time to start and to stop running the object.</td>
</tr>
<tr>
<td><strong>X Day of Nth Week of the Month</strong></td>
<td>Creates an instance each month on the specified day and week, at the specified start time. Enter the time to start and to stop running the object, the day of the week, and the week in the month to run the object.</td>
</tr>
<tr>
<td><strong>Calendar</strong></td>
<td>Creates an instance on each calendar date you specify, at the specified start time. Enter the time to start and to stop running the object, and select the calendar dates when you want to run the object.</td>
</tr>
</tbody>
</table>
11.6.6 Selecting personalized placeholders for publication source documents

You select personalized placeholders for a publication in the Schedule dialog box.

Before you can use personalized placeholders in publication instance names, the publication’s source documents must use personalization to filter data.

When scheduling a publication instance, you can use placeholders in the Use Specific Name field for source documents, and you can combine text and placeholders—and use multiple placeholders—in a publication name.

1. Right-click the publication to select placeholders for and select Schedule.
2. In the Schedule dialog box, click Destinations in the navigation list.
3. Under Show options for selected destinations, select Use Specific Name and choose a placeholder for the publication name from the Add placeholder list.
   The placeholders you select appear in the Specific Name box for the document title.
4. To add individual documents:
   a) Under Target Name, select Specific Name per Document.
   b) For each document title, select a placeholder from the Add placeholder list.
   The placeholders you select appear in the Specific Name box for each document title.
5. Click OK.

After personalization is set up for a publication, personalized placeholders appear in the Add placeholder list in the Destinations dialog box.

11.6.7 Selecting personalized placeholders for email fields

You select personalized placeholders for a publication in the Schedule dialog box.

You can combine text and placeholders—and use multiple placeholders—in any email field. When scheduling a publication to an email destination, you can use placeholders in the From, To, Cc, Bcc, Subject, Message, and Use Specific Name fields.

1. Right-click the publication to select placeholders for and select Schedule.
2. In the Schedule dialog box, click Destinations in the navigation list.
3. In the Destination list, select Email.
4. Set the destination options, including placeholders, as needed.
5. Click OK.
11.6.8 Embedding content from a dynamic source document in an email

You embed content from a source document for a publication in the Schedule dialog box.

You can embed content from dynamic content documents in the body of an email. For Crystal reports, you can embed content from a report. For Web Intelligence documents, you can embed an entire document or a single report tab.

1. Right-click the publication to take the content from and select Schedule.
2. In the Schedule dialog box, click Formats in the navigation list.
3. (Crystal reports only) Under Format Options for Selected Document, select the mHTML check box.
4. (Web Intelligence documents only) Choose whether to publish the entire document or one report tab:
   a) Under Output Format, select the mHTML check box.
   b) Under Output Format Details, select All reports to publish the entire document or Select one report and choose a report tab in the list.
5. Click Destinations in the navigation list.
6. In the Destinations dialog box, under Select Destinations, select the Email check box. The email configuration options appear.
7. In the From box, enter a name or email address or select Email Address in the Add placeholder list. For example, you can enter Robert.Publisher or publisher@sap.com. If you enter a name, the name is appended to your email server—for example, Publisher<EmailServer>.
8. In the Subject box, enter a subject or select a placeholder.
   If you personalized the report, personalized placeholders are available in the Add placeholder list.
9. In the Message box, enter the message that you want to appear in the body of the mail.
10. To embed dynamic content in the Message box, position the cursor in the Message box where you want to embed content, and select Report HTML Content in the Add placeholder list. %SI_DOCUMENT_HTML_CONTENT% appears in the Message box. When the publication runs, the placeholder is replaced by personalized content from the dynamic content document.
11. If the publication contains other source documents, select the Add Attachment check box.
   Other source documents in the publication will be added to the email as attachments when the publication runs.
12. Click OK.

11.6.9 Designing Crystal reports

11.6.9.1 Personalization in Crystal reports

You can personalize a Crystal report for recipients with parameters or by filtering fields.

Personalize Crystal reports with local profile targets when possible. Parameter-based personalization requires one database fetch per recipient when the parameter is used in a record selection formula, command, table, or stored procedure, which can increase publication processing time.
For example, if a profile is mapped to a parameter and the profile value for an Enterprise recipient conflicts with the parameter value, the profile value will override the parameter value when the publication runs. Similarly, if a personalization value in the dynamic recipient source conflicts with a parameter value for a dynamic recipient, the parameter value will be overridden when the publication runs.

Personalization that is based on parameters is overridden by other personalization methods.

### 11.6.9.1.1 Personalizing a Crystal report using parameter values

You personalize a Crystal report in the Schedule dialog box.

- Before you can use profiles to personalize data for Enterprise recipients, the profiles must be configured in the BI platform.
- Before you can perform this task, the Crystal report must contain parameters.

1. Right-click the Crystal report to personalize and select **Schedule**.
2. In the **Schedule** dialog box, click **Personalization** in the navigation list.
3. Review the parameter values under **Parameters** and note any values that need to be changed.
4. To change a default value, click the **Edit Values** button beside the default parameter value, select or enter the parameter value, and click **OK**.

5. Perform one of the following actions:
   - To override the default parameter personalization with Enterprise-recipient profile values, in the **Enterprise Recipient Mapping** column, select a profile in the list.
     - If this profile is not configured in the BI platform, personalization will fail. If you need profiles added to the BI platform, contact your system administrator.
   - If you are using only default parameter values to personalize a report, select **Default value for all recipients** in the **Enterprise Recipient Mapping** column.

   *The **Enterprise Recipient Mapping** column appears only if the publication is intended for Enterprise recipients.*

6. To override the default parameter personalization with dynamic recipient personalization values, in the **Dynamic Recipient Mapping** column, select a dynamic recipient source in the list.

   *The **Dynamic Recipient Mapping** column appears only if the publication is intended for dynamic recipients.*

   If you are using default parameter values to personalize a report, select **Not Specified** in the **Dynamic Recipient Mapping** column.

7. Click **OK**.

### 11.6.9.1.2 Personalizing a Crystal report by filtering fields

You personalize a Crystal report in the Schedule dialog box.

Before you can use profiles to personalize data for Enterprise recipients, the profiles must be configured in the BI platform.

When you use filters, a ViewTime selection formula is added to a report to filter data. The formula is applied when the publication runs and is not saved in the report. You can filter multiple fields in Crystal reports. Static-value...
profiles can filter only string fields in Crystal reports. To filter other types of fields, use expression profile values. If you map the incorrect type of field to the profile, personalization will fail.

This feature is not available for Crystal reports in .rptr format.

1. Right-click the Crystal report to personalize and select **Schedule**.
2. In the **Schedule** dialog box, click **Personalization** in the navigation list.
3. Under **Local Profiles**, in the **Report Field** column, select a Crystal report field in the list. The list of available fields includes all database fields and recurring formulas in the main report and in not-on-demand subreports.
4. In the **Enterprise Recipient Mapping** column, select a profile in the list. This profile maps the report to profile values defined for Enterprise recipients. If the profile is not configured in the BI platform, personalization will fail. If you need profiles added, contact your system administrator.
5. In the **Dynamic Recipient Mapping** column, select a dynamic recipient source in the list. The report field is mapped to a column in the dynamic recipient source that contains corresponding values. The **Dynamic Recipient Mapping** column appears only for publications intended for dynamic recipients.
6. Repeat steps 2 to 5 for each report field you want to filter.
7. Click **OK**.

### 11.6.9.2 Selecting the publication format(s) for a Crystal report

You select the publication format for a Crystal report in the **Schedule** dialog box.

You can select and configure more than one publication format for a Crystal report. When you select a format, the available formatting options appear. For some options, such as **Crystal Reports** and **Crystal Reports (RPTR)**, no formatting options appear and the default source document formatting is applied.

1. Right-click the Crystal report to select a publication format for and select **Schedule**.
2. In the **Schedule** dialog box, click **Formats** in the navigation list.
4. Configure the formatting options as needed.
5. When the **Use the export options defined in the report** check box is available, perform one of the following actions:
   - Select the check box to use the default export options defined in the source document.
   - Clear the check box to configure export options for the format you selected, and then configure the options that appear.
6. Repeat steps 3 to 5 for each format in which you want to publish this Crystal report.
7. Click **OK**.

Repeat this task for each Crystal report in the publication.
11.6.9.2.1 Crystal report formatting options

No additional options appear when you choose *Tab Separated Text (TTX)* as the formatting option. *PDF* options apply to source documents published as PDF files.

**Microsoft Excel (97-2003)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Page Range**             | • To publish an entire report as an Excel file, select *All*.  
  • To publish specific report pages, select *Pages*, enter the first page number in the *from* box, and enter the last page in the *to* box. |
| **Set Column Width**       | • To define column widths relative to objects in a report, select *Column width based on objects in the*, and select an option in the list—*Whole report, Report Header, Page Header, Group Header #, Details, Group Footer #, Page Footer, or Report Footer*.  
  • To define a constant width for all report columns, select *Constant column width (in points)*, and enter a number in the box. |
| **Export page header and page footer** | Select this check box to choose how frequently headers and footers appear in Excel files, and select an option in the list—*None, Once Per Report, or On Each Page*. |
| **Create page breaks for each page** | Select this check box to create page breaks that reflect the page breaks in a report. |
| **Convert date values to strings** | Select this check box to convert date values to text strings. |
| **Show gridlines**        | Select this check box to include grid lines in Excel files. |

If you clear the *Use the export options defined in the report* check box, the following options are available:
**Microsoft Excel (97-2003) (Data Only)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Set Column Width**                | **●** To define column widths relative to objects in a report, select *Column width based on objects in the* and select an option in the list—Whole report, Report Header, Page Header, Group Header #, Details, Group Footer #, Page Footer, or Report Footer.  
 **●** To define a constant width for all report columns, select *Constant column width (in points)*, and enter a number in the box. |
| **Export object formatting**        | Select this check box to preserve object formatting from a report.                                                                                                                                           |
| **Export images**                   | Select this check box to publish report images in Excel files.                                                                                                                                              |
| **Use worksheet functions for summaries** | Select this check box to use report summaries to create worksheet functions for Excel files.                                                                                                               |
| **Maintain relative object position** | Select this check box to preserve the relative position of report objects.                                                                                                                                     |
| **Maintain column alignment**       | Select this check box to preserve the column alignment from a report.                                                                                                                                       |
| **Export page header and page footer** | Select this check box to choose how frequently headers and footers appear in Excel files, and select an option in the list—None, Once Per Report, or On Each Page.                                             |
| **Simplify page headers**           | Select this check box to simplify page headers in a report.                                                                                                                                                 |
| **Show group outlines**             | Select this check box to show group outlines from a report.                                                                                                                                                 |
### Microsoft Excel Workbook Data-only

If you clear the *Use the export options defined in the report* check box, the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Set Column Width**           | • To define column widths relative to objects in a report, select `Column width based on objects in the`, and select an option in the list—Whole report, Report Header, Page Header, Group Header #, Details, Group Footer #, Page Footer, or Report Footer.  
• To define a constant width for all report columns, select `Constant column width (in points)`, and enter a number in the box. |
| **Export object formatting**   | Select this check box to preserve object formatting in a report.             |
| **Export images**              | Select this check box to publish report images in Excel files.               |
| **Use worksheet functions for summaries** | Select this check box to use report summaries to create worksheet functions for Excel files. |
| **Maintain relative object position** | Select this check box to preserve the relative position of report objects. |
| **Maintain column alignment**  | Select this check box to preserve the column alignment from a report.       |
| **Export page header and page footer** | Select this check box to choose how frequently headers and footers appear in Excel files, and select an option in the list—`None`, *Once Per Report*, or *On Each Page*. |
| **Simplify page headers**      | Select this check box to simplify page headers in a report.                 |
| **Show group outlines**        | Select this check box to show group outlines from a report.                 |
Microsoft Word (97-2003)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Page Range**   | • To publish an entire report as a Word file, select *All*.  
                   • To publish specific report pages, select *Pages*, enter the first page number in the *from* box, and enter the last page in the *to* box. |
### Microsoft Word - Editable (RTF)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Page Range**          | ● To publish an entire report as a Word file, select *All.*  
                           ● To publish specific report pages, select *Pages,* enter the first page number in the *from* box, and enter the last page in the *to* box. |

If you clear the *Use the export options defined in the report* check box, the following option is available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Insert page break after each report page</strong></td>
<td>Select this check box to create page breaks that reflect the page breaks in a report.</td>
</tr>
</tbody>
</table>

### Plain Text

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>

If you clear the *Use the export options defined in the report* check box, the following option is available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of Characters per Inch</strong></td>
<td>Enter the number of characters that should appear per inch in a plain text file. The recommended range is between 8 and 16.</td>
</tr>
</tbody>
</table>

### Paginated Text

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>

If you clear the *Use the export options defined in the report* check box, the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of Lines per Page</strong></td>
<td>Enter the number of lines that should appear on each page of a paginated text file.</td>
</tr>
<tr>
<td><strong>Number of Characters per Inch</strong></td>
<td>Enter the number of characters that should appear per inch in a paginated text file. The recommended range is between 8 and 16.</td>
</tr>
</tbody>
</table>
## Separated Values (CSV)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delimiter</strong></td>
<td>Enter the character to use as a delimiter.</td>
</tr>
<tr>
<td><strong>Separator</strong></td>
<td>Enter the character to use to separate values, or select the Tab check box to separate values with tabs.</td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td>Select <em>Standard Mode</em> (the default) or <em>Legacy Mode</em>. In standard mode, you can control how report pages and group headers and footers appear in CSV output.</td>
</tr>
</tbody>
</table>
| **Report and page sections** | • To export report and page sections, select *Export*.  
                          | • If you do not want to export report or page sections, select *Do not export*.  
                          | • To isolate report and page sections, select the Isolate report/page sections check box.                                                |
| **Group sections**      | • To export group sections, select *Export*.  
                          | • If you do not want to export group sections, select *Do not export*.  
                          | • To isolate group sections, select the Isolate report/page sections check box.                                                      |

## XML

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>XML Exporting Formats</strong></td>
<td>To specify the XML format, select an option in the list.</td>
</tr>
</tbody>
</table>

## 11.6.9.3 (Optional) Selecting print options for a Crystal report in a publication

You select print options for a Crystal report in the **Schedule** dialog box.

Before you can set print options for the default printer:

- The printer must be installed and configured properly.
- The Crystal Reports Job Server must be running on an account that has sufficient privileges to access the printer you specify.
For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

You can print instances in Crystal reports format each time a publication runs, using the Crystal Reports Job Server’s default printer or a different printer. The BI platform prints instances after the publication is personalized but before delivery.

1. Right-click the Crystal report to set print options for and select Schedule.
2. In the Schedule dialog box, click Print Settings in the navigation list.
3. Under Documents, select the Crystal report that you want to print when the publication runs.
4. Select the Print Crystal reports when scheduling check box.
   The Crystal report print options appear.
5. Select Default printer to print to the Job Server’s default printer, or select Specify the printer and select the printer’s path and name:
   ○ If the job server runs on Windows, in the Specify the printer box, enter \\
   Replace <PrintServer> with the name of your printer server and <PrinterName> with the name of your printer.
   ○ If the job server runs on Unix, confirm that the Unix is shown (not hidden), and enter the print command that you usually use in the Specify a printer box.
   For example, enter lp -d <PrinterName>
6. In the Number of Copies box, enter the number of copies to print.
7. Under Page Range, select All to print all pages in the publication or Pages and enter the page range to print.
8. (Optional) In the Set collate option to list, select Collate, Do not collate, or Use printer defaults.
9. (Optional) In the Page Scaling list, select Scale to fit, Only shrink to fit, or Do not scale.
10. (Optional) To center report content on the page, select the Center the page check box.
11. (Optional) If the Crystal report is wide and you want it to print on one page, select the Fit horizontal pages into one page check box.
12. Click Schedule.

11.6.9.4 (Optional) Selecting a recipient delivery rule for a Crystal report

You select a recipient delivery rule for a Crystal report in the Schedule dialog box.

Recipient delivery rules determine whether a publication is delivered to a particular recipient after processing and personalization. After creating a publication, you can open the publication and change the delivery rules for it.

1. Right-click the Crystal report to set a recipient delivery rule for and select Schedule.
2. In the Schedule dialog box, expand Additional Options, and click Delivery Rules in the navigation list.
3. Under Recipient Delivery Rule, select Deliver individual document when condition is met or Deliver all documents only when all conditions are met.
4. In the Condition column beside each document, select the condition that must be met before the publication will be delivered.
5. Click Save & Close.
11.6.9.5 (Optional) Selecting a global delivery rule for a Crystal report

You select a global delivery rule for a Crystal report in the Schedule dialog box.

The Crystal report must contain an alert before you can set a global delivery rule.

Global delivery rules determine whether a publication will be processed and delivered to all recipients. You can set a global delivery rule on any Crystal report in the BI platform.

1. Right-click the Crystal report to select a global delivery rule for and select Schedule.
2. In the Schedule dialog box, click Delivery Rules in the navigation list.
   The Select a report that contains an alert window appears, where you can select the Crystal report on which to set the global delivery rule.
4. Locate and select the Crystal report, and click OK.
5. In the Condition list, select the alert value that the report must include in order to meet the global delivery rule.
6. Click Schedule.

11.6.9.6 (Optional) Formatting a merged PDF file from Crystal reports

You format a merged PDF file from Crystal report in the Schedule dialog box.

Before you can format a merged PDF file:

- Crystal reports must have titles in order to be included in a merged PDF file. To set the title for a report, open the report in SAP Crystal Reports, select File > Summary Info, and enter a title for the report in the Title box on the Summary tab. Save the report and re-export it to the repository.
- In the BI launch pad, in the Schedule dialog box, under Source Documents, the Crystal reports and PDF files that you want to merge must appear in the correct order.
- In the launch pad, in the Schedule dialog box, under Formats, the PDF check box must be selected as a format for each Crystal report that you want to include in the merged PDF file.
- In the launch pad, in the Schedule dialog box, under Destinations, the Merge Exported PDF check box must be selected for each destination that you want to send the merged PDF file to.
- To ensure that Crystal reports will appear in the table of contents of the merged PDF file, for each Crystal report listed, select the report in the Documents list in the Formats area, clear the Use the export options defined in the report check box, and select the Create bookmarks from group tree check box.

1. Right-click a Crystal report to format a merged PDF file for and select Schedule.
2. In the Schedule dialog box, click Merged PDF Options in the navigation list.
3. Create a table of contents for the merged PDF file:
   a) Select the Create Table of Contents check box.
      The format options for the table of contents appear.
   b) In the Title box, enter a title for the table of contents.
   c) In the Title Font list, select the font, font size (in points), and font color for the title of the table of contents.
d) In the **Item Font** list, select the font, font size (in points), and font color for items in the table of contents.

4. Set the page number format for the merged PDF file:
   a) Select the **Apply Running Page Numbers** check box.
      The format options for page numbers appear.
   b) In the **Number Format** box, enter a format for page numbers.
      By default, the format is set to `Page &p of &P`. You can change the format, but you must use `&p` as a placeholder for the current page number and `&P` as a placeholder for the total number of pages.
   c) In the **Number Location** list, select the page number orientation for the merged PDF file.
   d) In the **Number Font** list, select the font, font size (in points), and font color for the page numbers.
   e) If you want the table of contents to have page numbers, select the **Apply page numbers to Table of Contents pages** check box.

5. Set recipient logon credentials and permissions for recipient actions:
   a) Select the **Set Restrictions** check box.
   b) In the **User Password** box, enter the password that recipients must enter to view the merged PDF file.
   c) In the **Owner Password** box, enter the password that recipients must enter to edit the merged PDF file.
   d) To allow recipients to print the PDF file, select the **Allow Printing** check box.
   e) To allow recipients to modify the PDF file, select the **Allow Modification of Contents** check box.
   f) To allow recipients to copy and paste PDF contents, select the **Allow Copy and Paste (Required for Embedded Flash Objects to Run)** check box.
   g) To allow recipients to modify annotations in the PDF file, select the **Allow Modification of Annotations** check box.

6. Click **OK**.

### 11.6.9.7 (Optional) Configuring database logon information for a Crystal report

You can configure the database logon information that recipients use to log on to the database and refresh the data in the Crystal report. You configure database logon information in the **Schedule** dialog box.

Confirm that database settings for the Crystal report are correct. In the CMC, select **Folders**, select the Crystal report, and select **Manage** ➤ **Default Settings** ➤ **Database Configuration** to check the database information or to enter new information.

You may need to modify data source information that a Crystal report references in the report itself. Open the Crystal report in SAP Crystal Reports, select **Database** ➤ **Set Datasource Location**, and select a connection or create a new connection in the **Set Datasource Location** dialog box.

1. Right-click the Crystal report to configure database logon information for and select **Schedule**.
2. In the **Schedule** dialog box, click **Database Logon** in the navigation list.
3. In the **Title** list, select a Crystal report.
   The database information for the Crystal report appears below the **Title** list.
4. Confirm that the information in the **Database Server** box and the **Database** box is correct.
5. In the **User** box, enter the user name that recipients must use to log on.
6. In the **Password** box, enter a password that recipients must use to log on.
11.6.10 Designing Web Intelligence documents

11.6.10.1 Selecting the publication format for a Web Intelligence document

You must select a publication format for each dynamic content source Web Intelligence document in a publication.

1. Right-click the Web Intelligence document to specify a publication format for and select Schedule.
2. In the Schedule dialog box, click Formats in the navigation list.
3. Under Output Format, select the check box beside the format to publish the Web Intelligence document in:
   - Web Intelligence
   - Microsoft Excel
   - Adobe Acrobat
   - mHTML
4. If you selected Comma Separated Values (CSV), under Format Options and Settings, perform the following actions:
   a) In the Text qualifier list, select a text qualifier.
   b) In the Column delimiter list, select a column delimiter.
   c) In the Charset list, select the character set.
   d) If you want to enter a new character set, select the Enter a new charset check box, and enter the character set in the box.
   e) If you want to use the settings configured as the default, select the Set as default values check box.
   f) If you want to generate a comma-separated value for each data source, select the Generate separate CSV per Data Provider check box.
5. Repeat steps 3 to 4 for each format in which to publish the document.
6. Click OK.

11.6.10.2 Personalizing a Web Intelligence document with a global profile target

You can personalize a Web Intelligence document for Enterprise recipients by filtering with a global profile target.

- Before you can use a profile to personalize data for Enterprise recipients, the profile must be configured in the BI platform. If a profile is not configured in the platform, personalization will fail.
- Before personalizing a Web Intelligence document, ensure that the profile has a global profile target.

When you define personalization under Global Profiles, you do not need to set personalization options under Filters. If you need profiles added to the BI platform, contact your system administrator.

1. Right-click the Web Intelligence document to personalize and select Schedule.
2. In the Schedule dialog box, click Personalization in the navigation list.
   This profile maps the document to the universe field (global profile target) that is filtered for Enterprise recipients.
4. Click OK.

11.6.10.3 Personalizing a Web Intelligence document by filtering fields

Before you can use a profile to personalize data, the profile must be configured in the BI platform. If a profile is not configured in the platform, personalization will fail.

Static-value profiles can filter only string fields in source documents. To filter other types of fields, use expression profile values. If you map an incorrect type of field to the profile, personalization will fail. If you need profiles added to the platform, contact your system administrator.

Scheduling and publishing a Web Intelligence document to .wid format generates a .wid file. Filters in .wid files can be removed by any recipient with appropriate security rights. When the .wid file is sent to recipients or destinations, use filters carefully. For example, if you filter a Web Intelligence document to limit the information that recipients can see and then send the published .wid file to recipients, any recipient with security rights to edit the document can remove or update the filter and access data that should not be visible.

1. Right-click the Web Intelligence document to personalize and select Schedule.
2. In the Schedule dialog box, click Personalization in the navigation list.
3. Under Local Profiles, for each profile listed in the Title column, select a profile from the list in the Report Field column.
   This profile maps the report field to profile values for Enterprise recipients.
4. Under Local Profiles, in the Enterprise Recipient Mapping column, select a profile from the list.
   This profile maps the document to the universe field (global profile target) that is filtered for Enterprise recipients.
5. In the Dynamic Recipient Mapping column, select a profile in the list.
   The field in the source document is mapped to the column that contains corresponding values in the dynamic recipient source.
6. Repeat steps 3 to 5 for each field to filter.
7. Click OK.

11.6.11 Optional publication tasks

The tasks in this section are optional (not required to design and schedule a publication) but can improve publication performance.
11.6.11.1 Editing parameter (prompt) values for an object

If you don't want to use the default parameter (prompt) values in a content object, you can edit the values. Before editing parameter (prompt) values, confirm that the content object contains parameters or prompts.

Parameters (prompts) ask you to enter information. In report objects, the information you enter may determine which data appears in a report. For example, in a report used by sales, a parameter may ask users to choose a region. When a user chooses a region, the report displays only results for that region.

In Web Intelligence documents, parameters are called prompts. In Web Intelligence documents based on SAP Business Explorer (SAP BEx) queries, a prompt's value can be fixed or obtained by a SAP Business Warehouse (SAP BW) data source variable when a scheduled document runs. Prompts can contain mandatory variables in SAP BW data sources.

1. On the Documents tab, right-click the object to edit parameter (prompt) values for and select Schedule.
2. In the Schedule dialog box, click Prompts in the navigation list.

   The way that parameter (prompt) options appear may differ from object to object, depending on how your system administrator has configured the parameter or prompt. For example, program objects may appear in an Argument box.

   If the Prompts button is not available, the content object does not contain parameters or prompts.
3. (Crystal reports only) In the Prompts dialog box, click Edit Values, and edit a parameter value.
4. (Web Intelligence documents based on SAP BEx queries only) In the Prompts dialog box, click Modify to edit a prompt value or Clear to remove the value.

   The SAP BW data source must be able to process the value provided for a prompt. If the data source cannot process a value, document execution will fail. For example, SAP BW exit or customer exit variables are often used as dynamic variables in prompts.

   If the Clear button is not available, your administrator can enable it by setting bex.dynamic_variable.schedule=true in the <InstallDir>\<WebAppServer>\webapps\boe\web-inf\config\custom\AnalyticalReporting.properties file. For instructions, see the Business Intelligence Platform Administrator Guide.
5. Click Schedule.

11.6.11.2 Selecting events to trigger a publication

Event-based scheduling gives you additional control over when a publication runs. Use events to trigger a publication to run or use a publication job to trigger an event.

For information about events, see the SAP BusinessObjects Business Intelligence Platform User Guide.

1. Right-click the publication to select events for and select Schedule.
2. In the Schedule dialog box, click Events in the navigation list.
3. To specify file-based and custom events for a publication, click the > button to move events from the Available Events list to the Events to wait for list.

   The events trigger the publication job to run.
4. To specify schedule events for a publication, click the > button to move events from the Available Schedule Events list to the Events to trigger on completion list.
The events occur after the publication job runs.

5. Click **Schedule**.

### 11.6.11.3 Selecting a server group for a publication

You cannot schedule publications across sites in a federation. For information about server groups, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

1. Right-click the publication to select a server group for and select **Schedule**.
2. In the **Schedule** dialog box, click **Scheduling Server Group**.
3. To run the publication job at its site of origin, select the **Run at origin site** check box.
4. Select a server group option, and click **Schedule**.

### 11.6.11.4 Adding a publication extension in the CMC

A publication extension is a library of code that applies business logic to publications. You must add a publication extension before you can use the extension in a publication.

Before you can use a publication extension, deploy the extension on all computers that run the Adaptive Processing Server, and then restart the Adaptive Processing Server and other servers that host a Publishing Service. The location of the server varies, depending on the operating system:

- In Windows, the server is located at `<InstallDir>\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\lib`
- In Unix, the server is located at `<InstallDir>/sap_bobj/enterprise_xi40/java/lib/`

You can add publication extensions only in the Central Management Console (CMC). (You cannot add them when designing a publication in the BI launch pad.)

To define the order in which to execute publication extensions, click **Move Up** or **Move Down** under the **Before Publication Delivery** list or the **After Publication Delivery** list. For more information about publication extensions, see the SAP BusinessObjects Business Intelligence Platform Java SDK Developer Guide.

1. In the CMC, go to the **Folders** management area, and locate the publication to add a publication extension to.
2. Right-click the publication and select **Properties**
3. In the **Properties** dialog box, expand **Additional Options** in the navigation list, and select **Publication Extension**.
4. In the **Publication Extension Name** box, enter a name for the extension.
5. In the **Class Name** box, enter the fully qualified class name for the extension.
6. (Optional) In the **Parameter** box, enter a parameter name.
7. To use the extension after processing but before delivery, above the **Before Publication Delivery** list, click the **Add** button.
   The extension is added to the **Before Publication Delivery** list.
8. To use the extension after delivery, above the **After Publication Delivery** list, click the **Add** button.
   The extension is added to the **After Publication Delivery** list.
9. Click **Save**.
11.6.11.5 Enabling email notification for a publication job in the CMC

Enable email notification when you want to receive an email message after a publication job runs.
Before enabling email notification, confirm that the Adaptive Job Server is properly configured.
You can enable email notification only in the Central Management Console (CMC). (You cannot enable it when designing a publication in the BI launch pad.)

1. In the CMC, go to the Folders management area, and locate the publication job to enable email notification for.
2. Right-click the publication job and select Schedule.
3. In the Schedule dialog box, click Notification in the navigation list, and expand Email Notification: Not in use.
4. For successful publication jobs, to receive email notification at default recipient email addresses, select the A job ran successfully check box, and select Use the Job Server’s defaults to use the default addresses on the Adaptive Job Server.
5. For successful publication jobs, to receive email notification at specified recipient mail addresses, select the A job ran successfully check box, select Set the values to be used here, and perform the following actions:
   a) In the From box, enter the email address or a name to send the notification from.
   b) In the To box, enter the email address of each recipient who should receive the notification.
   c) In the Cc box, enter the email address of each additional recipient who should be copied on the notification.
   d) In the Subject box, enter the subject of the notification.
   e) In the Message box, enter a message to accompany the notification.
6. For failed publication jobs, to receive email notification at default recipient email addresses, select the A job failed to run check box, and select Use the Job Server’s defaults to use the default addresses on the Adaptive Job Server.
7. For failed publication jobs, to receive email notification at specified recipient mail addresses, select the A job failed to run check box, select Set the values to be used here, and perform the following actions:
   a) In the From box, enter the email address or a name to send the notification from.
   b) In the To box, enter the email address of each recipient who should receive the notification.
   c) In the Cc box, enter the email address of each additional recipient who should be copied on the notification.
   d) In the Subject box, enter the subject of the notification.
   e) In the Message box, enter a message to accompany the notification.
8. Click Schedule.

11.6.11.6 Enabling auditing notification for a publication job in the CMC

Enable audit notification when you want to audit successful or failed publication jobs.
You can enable auditing notification only in the Central Management Console (CMC). (You cannot enable it when designing a publication in the BI launch pad.) For more information about auditing, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

Business Intelligence Launch Pad User Guide
Working with publications
© 2014 SAP SE or an SAP affiliate company. All rights reserved.
1. In the CMC, go to the Folders management area, and locate the publication job to enable auditing notification for.

2. Right-click the publication job and select Schedule.

3. In the Schedule dialog box, expand Additional Options, click Notification, and expand Audit Notification: Not in use.

4. To audit successful publication jobs, select A job ran successfully.

5. To audit failed publication jobs, select A job failed to run.

6. Click Schedule.

11.6.11.7 Selecting a profile resolution method in the CMC

Select a profile resolution method so that, when a profile conflict occurs, the profile resolution determines whether instances will be merged or delivered as separate documents in a publication.

You can select a profile resolution method only in the Central Management Console (CMC). (You cannot select it when designing a publication in the BI launch pad.)

1. In the CMC, go to the Folders management area, and locate the publication to select a profile resolution method for.

2. Right-click the publication job and select Schedule.

3. In the Schedule dialog box, expand Additional Options, and click Advanced.

4. Under Profile Resolution Method, perform either of the following actions:
   ○ Select Do not merge if you want profiles from multiple user groups to result in separate documents.
   ○ Select Merge if you want to apply profiles from multiple user groups to the same document.

5. Click Schedule.

11.6.11.8 Selecting a report bursting method in the CMC

Select a report bursting method to determine how source documents are personalized, processed, and delivered in a publication.

Before selecting a report bursting method, ensure that the publication contains Web Intelligence documents intended for Enterprise recipients and that profiles used for personalization have filter expressions.

Report bursting methods use different filter types to personalize and process documents. For example, the One database fetch for all recipients option uses a report filter and the One database fetch per recipient option uses a query filter. Each filter type supports a different set of operators. If a filter expression uses an operator that the report bursting method does not support, the publication may fail.

You can select a report bursting method only in the Central Management Console (CMC). (You cannot select it when designing a publication in the BI launch pad.)

1. In the CMC, go to the Folders management area, and locate the publication to select a report bursting method for.

2. Right-click the publication job and select Schedule.
3. In the Schedule dialog box, expand Additional Options, and click Advanced.


5. Click Schedule.

### 11.7 Running publications and working with published instances

At any point during or after publication design, you can view a publication’s properties in the Summary dialog box—including the publication’s title, location, description, source documents, the number of recipients who will receive the publication (sorted by recipient type, Enterprise or dynamic), how the publication is personalized, the distribution format, and the destination.

Click Summary to open the Summary dialog box. You can use other options on the navigation panel to change the properties of and to save or schedule a publication.

#### 11.7.1 Testing a publication

Use test mode in the BI launch pad to send a publication to yourself before sending it to recipients.

You receive the same information that recipients will receive. Destinations are automatically updated so that your BI Inbox or your email address is used instead of publication recipients’ BI Inbox or email address. If necessary, you can exclude selected recipients from the original group of recipients in test mode.

1. Right-click the publication to test and select Test Mode.
2. (Optional) In the Test Mode dialog box, modify the list of Enterprise recipients:
   a) Click Enterprise Recipients.
   b) Under Available, select users or groups, and click the > button to move the users or groups to the Selected list or the Excluded list.
3. (Optional) Modify the list of dynamic recipients:
   a) Click Dynamic Recipients.
   b) Under Choose the source for the dynamic recipients, select Web Intelligence Report Dynamic Recipient Provider or Crystal Reports Dynamic Recipient Provider in the list.
4. Click Test.

The publication runs in test mode and, once done, is sent to intended “test” recipients.

#### 11.7.2 Scheduling a publication to run

When scheduling a publication, you can use the default recurrence pattern or enter new values, and you can change the recipients each time you schedule a publication.

A publication must be designed and saved before it can be scheduled to run.
1. Right-click the publication to schedule and select **Schedule**.
2. In the **Schedule** dialog box, click **Recurrence**, and confirm that the option selected in the **Run object** list is correct.
3. Click **Schedule**.

### 11.7.2.1 Viewing the progress or history of a publication job

1. Right-click the publication job and select **History**.
   The **History** dialog box appears and shows the status (Success, Failed, or Running) of the job in the **Status** column.
2. To view the log file for the job, click **View Log File** at the bottom of the dialog box.

### 11.7.3 Subscribing to or unsubscribing from a publication

To subscribe to a publication after it is scheduled, subscribe to its recurring instance—or reschedule the publication.

You must have appropriate access rights to a publication before you can subscribe to it.

Only Enterprise recipients can subscribe to or unsubscribe from a publication. Dynamic recipients cannot subscribe to or from publications.

1. In the **Folders** drawer on the **Documents** tab, locate and select the publication to subscribe to or unsubscribe from.
2. Perform one of the following actions:
   ○ In the BI launch pad, right-click the publication and select **Subscribe** or **Unsubscribe**.
   ○ In the Central Management Console (CMC), select **Actions** ➤ **Subscribe** or **Unsubscribe**.

### 11.7.3.1 Subscribing to or unsubscribing from a publication instance

After a recurring publication has been scheduled, Enterprise recipients can subscribe to its first recurring instance. For example, when a publication is scheduled to run twice a week, you can subscribe to the first publication instance but not the second one.

You must have appropriate access rights to a publication before you can subscribe to its instances.

Only Enterprise recipients can subscribe to or unsubscribe from a publication instance. Dynamic recipients cannot subscribe to or from publication instances.

1. Perform one of the following actions:
   ○ In the BI launch pad, right-click a publication and select **History**.
   ○ In the Central Management Console (CMC), select **Actions** ➤ **History**.
2. In the History dialog box, perform one of the following actions:
   ○ In the launch pad, right-click the instance and select Subscribe or Unsubscribe.
   ○ In the CMC, right-click the instance and select Actions > Subscribe or Unsubscribe.

11.7.4 Viewing publications sent to the Default Enterprise Location

As a recipient, you can view only your own personalized publication instances in the BI platform.

1. Perform either of the following actions to start the Central Management Console (CMC):
   ○ In Windows, select Start > Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console.
   ○ In a web browser, enter http://<ServerName>:<ConnectionPort>/CMC, replacing <ServerName> with your CMS name and <ConnectionPort> with your connection port number (specified during installation). The default connection port number is 8080.

2. Enter your logon credentials:
   a) In the System box, confirm that the CMS name and CMS port are correct.
   b) Enter your user name and password.
   c) In the Authentication list, select the authentication type.

3. Click Log On.

4. Under Folders, right-click the publication and select History.

5. In the History dialog box, click the link in the Instance Time column.

6. Double-click the instance to view.

11.7.5 Viewing publications sent to a BI Inbox

Dynamic recipients can view publications sent to a BI Inbox. They cannot log on to the BI launch pad to view publication results.

1. Perform either of the following actions to start the BI launch pad:
   ○ In Windows, select Start > Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Java BI Launch Pad.
   ○ In a web browser, enter http://<ServerName>:<ConnectionPort>/BOE/BI, replacing <ServerName> with your CMS name and <ConnectionPort> with your connection port number (specified during installation). The default connection port number is 8080.

2. Enter your logon credentials:
   a) In the System box, confirm that the CMS name is correct.
   b) Enter your user name and password.
   c) In the Authentication list, select the authentication type.

3. Click Log On.
4. Click *My Inbox*.
5. Double-click the instance to view.

### 11.7.6 Redistributing a publication instance

When you want to resend an instance to a recipient but do not want to rerun an entire publication, you can redistribute successful publication instances to all or some of the original recipients.

Only recipients specified when the publication was originally run can receive redistributed instances.

1. Perform one of the following actions:
   ○ In the BI launch pad, right-click a publication and select *History*.
   ○ In the Central Management Console (CMC), right-click a publication and select *Actions > History*.
2. In the *History* dialog box, select a successful publication instance.
3. Perform one of the following actions:
   ○ In the launch pad, select *More Actions > Reschedule*.
   ○ In the CMC, select *Actions > Reschedule*.
4. Choose which recipients will receive redistributed instances:
   ○ To redistribute an instance to Enterprise recipients, click *Enterprise Recipients*, and click the > button to move recipients from the *Available* list to the *Selected* list.
   ○ To redistribute an instance to dynamic recipients:
     a) Click *Dynamic Recipients*, and confirm that columns mapped to recipient IDs, full names, and email addresses are correct.
     b) To redistribute the publication to all dynamic recipients, select *Use entire list*.
     c) To redistribute the publication to selected dynamic recipients, click the > button to move recipients from the *Available* list to the *Selected* list.
5. Click *Redistribute*.
   The publication history appears, and the redistributed instance has a status of Running. The date in the *Instance Time* column is updated to reflect the redistribution time.

### 11.7.7 Retrying a failed publication

Before retrying a failed publication, view the log file for the publication instance, address any errors, and reschedule the publication.

1. Select the failed publication instance.
2. Perform either of the following actions:
   ○ In the BI launch pad, select *More Actions > History*.
   ○ In the Central Management Console (CMC), select *Actions > History*.
   The instance status changes to Running.

If the publication fails again, review the new log file and fix any errors that occurred.
11.8 Publication performance

You can improve publication performance by modifying the Adaptive Processing Server, the Publishing Service, and the Publishing Post Processing Service.

Adaptive Processing Server

<table>
<thead>
<tr>
<th>Area</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU and memory</td>
<td>Move the Adaptive Processing Server to a faster machine that has more available CPUs and BI platform Feature Pack 3 or later installed. The server will automatically scale to use more CPUs. Isolate the Publishing Service and the Publication Post Processing Service on dedicated Adaptive Processing Servers and remove unused services hosted on those servers. Each service will consume more shared resources (requests to thread pool, memory, and CPU consumption) on an Adaptive Processing Server, and publishing performance may improve.</td>
</tr>
</tbody>
</table>

Publishing Service

Because publishing is a hard-drive-intensive process, the Publishing Service should be installed on a machine with fast I/O or SAN disks for the FRS.

<table>
<thead>
<tr>
<th>Area</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Many publication instances that execute concurrently</td>
<td>If the underlying CMS, FRS, Adaptive Job Server, and report processing servers have been scaled appropriately, horizontally scale out the Publishing Service across multiple Adaptive Processing Servers, on one or more machines, to concurrently process more publication instances. A single publication job (for example, with one million recipients) is not shared across Publishing Services hosted on different Adaptive Processing Servers. Horizontally scaling out the Publishing Service will not improve processing time for a single publication, regardless of the number of recipients.</td>
</tr>
<tr>
<td>Area</td>
<td>Consideration</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Publications with many recipients                | Vertically scale the Adaptive Processing Server on machines with more CPUs and RAM to concurrently process more recipients and to generate more jobs on the Adaptive Processing Server.  
You may need to scale the Adaptive Job Server and report processing servers accordingly to increase throughput.  
You may need to increase the Adaptive Processing Server’s heap size (that is, set `-Xmx` to 2 GB or more) when the server runs on a machine with more than eight CPU cores. The larger number of CPU cores enables the Adaptive Processing Server to spawn more threads and increase throughput. Note that more threads require more RAM. |
| Publishing cleanup option                        | For a large publication that does not need redistribution or to view artifacts in the report, do not select the default destination. |
| Crystal report publications                      | If you do not need to apply unique security for each recipient, select `One database fetch for each batch of recipients`. Database access will be batched in multiple, smaller, concurrent queries. |
| Web Intelligence publications                    | Select `One database fetch for all recipients` or `One database fetch per recipient`.  
When you select `One database fetch for all recipients` for a large publication, to break the database query into multiple, smaller queries, add the following command line option to speed disk delivery to all Adaptive Processing Servers that host the Publishing Service:  
   ```bash  
   -Dcom.businessobjects.publisher.scopebatch.max.recipients=<integer>  
   ``` |
| Large publications with slow disk delivery to a single folder on Windows | Search for "disable short file name generation" (article ID 210638) or for "NtfsDisable8dot3NameCreation" on Microsoft TechNet at [http://technet.microsoft.com](http://technet.microsoft.com) and follow the instructions. |
| Large publications with slow disk delivery to a single folder that contains more than 300,000 files on Windows | Search for "how NTFS works" at [http://technet.microsoft.com](http://technet.microsoft.com) and follow the instructions. |
Publishing Post Processing Service

The Publishing Post Processing Service is called when the Package as ZIP File check box (in the Schedule dialog box) and/or the Merge Exported PDF check box (in the Destinations dialog box) is selected or when custom post-processing plugins are enabled on a publication.

<table>
<thead>
<tr>
<th>Area</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publications with both Package as ZIP File and Merge Exported PDF selected</td>
<td>Horizontally scale out the Publishing Post Processing Service to spread the ZIP- and PDF-merging workloads across multiple Publishing Post Processing Services hosted on different Adaptive Processing Servers.</td>
</tr>
</tbody>
</table>

11.8.1  Recommendations for adding source documents

This section contains recommendations for adding dynamic content documents to publications.

Use publication log files to troubleshoot errors in failed publications

When you schedule publications to run, log files are generated to record errors that may occur when the publications are processed. To view all log files for a publication instance, select More Actions History. In the History dialog box, click the link for the instance in the Instance Time column. The instance details appear in a new window.

If using parameter-based personalization for Crystal reports, set parameters to default

Parameter-based personalization may lead to slower publication performance. To significantly speed performance, personalize Crystal report publications by mapping fields to Enterprise recipient profiles or to dynamic recipient personalization values.

If you must personalize Crystal reports using parameters, in the Personalization section, set parameters to their default value.

Note

Before you can use Enterprise recipient profiles in publications, the profiles must be configured in BI platform.
View and schedule individual dynamic content documents before adding them to a publication

If you can view and schedule dynamic content documents successfully, the data source connection is working properly and the source document data can be refreshed when the publication is scheduled. If you cannot view and schedule dynamic content documents, confirm that the data source connection settings are correct. The following table summarizes how to check the settings:

<table>
<thead>
<tr>
<th>Document type</th>
<th>How to check data source connection settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal report</td>
<td>In the CMC, select the Crystal report, and select Manage Default Settings. In the Default Settings dialog box, click Database Configuration on the navigation panel.</td>
</tr>
<tr>
<td>Web Intelligence document</td>
<td>In the CMC, select the Web Intelligence document, and select Manage Default Settings. In the Default Settings dialog box, click Report Universes on the navigation panel.</td>
</tr>
</tbody>
</table>

In some cases, you may have to open a dynamic content document in the designer to configure the data source connection and to re-export the file to the CMS repository and overwrite the previous copy. For more information about configuring data source connections for dynamic content documents, see the designer documentation.

Avoid unnecessary data refreshes

If a data refresh is unnecessary for a dynamic content document, in the Source Documents section, clear the Refresh At Runtime check box for that document to improve overall publication performance.

11.8.2 Recommendations for using dynamic recipient sources

Sort dynamic recipient sources according to the recipient ID column

In general, you should sort dynamic recipient sources by the Recipient ID column. This is especially important when you are running a high-volume publication or when you selected One database fetch for each batch of recipients because it can reduce the number of deliveries to recipients with multiple personalization values.

For Crystal report dynamic recipient sources, confirm that database configuration information is correct

In the CMC, select the dynamic recipient source, select Manage Default Settings, and confirm the following settings:
Under **Database Configuration**, confirm the database logon information is correct and **Use same database logon as when report is run** is selected.

Under **Parameters**, confirm that all parameters have values and all **Prompt when viewing** check boxes for parameters are cleared.

**If using Crystal report dynamic recipient sources, contact your administrator and confirm that the RAS is configured correctly**

The Report Application Server (RAS) must be configured to read at least the same number of database records as the number of recipients in the dynamic recipient source. For example, to process a dynamic recipient source with data for 100,000 recipients, the RAS must be set to read more than 100,000 database records.

**11.8.3 Recommendations for sending and receiving email publication instances**

**If possible, view embedded-content email-publication instances in Outlook 2003**

View embedded content in email publication instances in Outlook 2003 whenever possible. Embedded content in email publication instances may have formatting issues when viewed in Outlook 2007 or in web email accounts, such as Hotmail or Gmail.

**Contact your administrator to confirm that the email settings are configured properly for the Destination Job Server**

You must ensure that email settings are properly configured for the Destination Job Server. Publications intended for email destinations may fail because email has not been configured properly as a destination for the Adaptive Job Server. For more information, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*. 
12 Collaboration

Hosted on the web, SAP Jam or SAP StreamWork adds collaborative decision-making and social media to the BI launch pad.

Before you can use collaboration, the BI platform must be configured for it. If no collaboration application is available in the launch pad, contact your system administrator.

You can use collaboration to perform the following tasks:

- Send or schedule Crystal reports and Web Intelligence documents to SAP StreamWork activities
- Monitor SAP StreamWork feeds
- Follow documents and instances to track comments and discussions
- Post comments on documents and instances and view comments posted by other SAP Jam or SAP StreamWork users about public documents

You view and post comments for feeds on the **feed** panel.

SAP Jam does not support Microsoft Internet Explorer 11.

12.1 Collaboration column

Collaboration options appear on the **Documents** tab in the BI launch pad.

When someone makes a comment on a document or an instance, tooltips in the **Collaboration** column on the tab describe the status of feeds, and icons indicate whether a document has comments and whether you are following a feed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>feed panel</td>
<td>Displays comments posted by other users for documents or instances that you have view or comment rights to. This is where you participate in discussions.</td>
</tr>
<tr>
<td><strong>Collaboration</strong> drawer</td>
<td>Click this drawer to open or close the feed panel.</td>
</tr>
<tr>
<td><strong>Collaboration</strong> column</td>
<td>This column displays icons that indicate the status of feeds and of your participation in them.</td>
</tr>
<tr>
<td><strong>Follow</strong> and <strong>Unfollow</strong></td>
<td>Select these menu options to follow or to stop following a feed. For convenience, you can also select the options on the <strong>More Actions</strong> menu.</td>
</tr>
<tr>
<td><strong>Collaboration</strong> destination</td>
<td>Choose this destination from the <strong>Send</strong> menu to send or from the <strong>Schedule</strong> menu to schedule documents for collaboration.</td>
</tr>
</tbody>
</table>
12.1.1 Icons in the Collaboration column

<table>
<thead>
<tr>
<th>Icon</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>📣</td>
<td>You are following the feed for this document or instance.</td>
</tr>
<tr>
<td>📣💬</td>
<td>Comments are posted for this document or its instances.</td>
</tr>
<tr>
<td>📣💬</td>
<td>No comments are posted for this document or its instances.</td>
</tr>
</tbody>
</table>

12.1.2 Showing the Collaboration column

The Collaboration column appears by default if you administrator enabled it in the Central Management Console (CMC) in the BI platform. If it is not enabled, you can display the column.

1. On the header panel, click Preferences.
2. In the Preferences dialog box, click General.
3. Under Choose columns displayed in Documents tab, select the Collaboration / Discussion Status check box.
4. Click Save & Close.

The Collaboration column appears on the Documents tab.

12.1.3 Hiding the Collaboration column

1. On the header panel, click Preferences.
2. In the Preferences dialog box, click General.
3. Under Choose columns displayed in Documents tab, clear the Collaboration / Discussion Status check box.
4. Click Save & Close.

The Collaboration column no longer appears on the Documents tab.

12.2 Feed panel

The Collaboration drawer provides access to the feed panel, where you can see and post comments about documents that you have view or comment access rights to.

You can perform the following tasks in the feed panel:

- Follow or unfollow a feed
Monitor comments about the feeds you follow
Reply to posted comments
Post news or start a discussion thread

When a document has multiple instances, the feed panel lists the instance names and run times. You select an instance in the list to display its feed. If the feed has comments, the comments appear on the feed panel.

12.2.1 Collaboration drawer

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop-down list of instance names and run times</td>
<td>Chronologically lists instance names and run times, with the most recent instance at the top. Select an instance to view its feed.</td>
</tr>
<tr>
<td>Say something box</td>
<td>Enter a comment about a feed.</td>
</tr>
<tr>
<td>☁ button</td>
<td>Click to refresh a feed to view the latest comments.</td>
</tr>
<tr>
<td>Post button</td>
<td>After entering a comment in the Say something box, click this button to add the comment to the feed.</td>
</tr>
<tr>
<td>+ button</td>
<td>Click to follow a feed.</td>
</tr>
<tr>
<td>- button</td>
<td>Click to stop following a feed.</td>
</tr>
</tbody>
</table>

12.2.2 Opening the feed panel

You can open the feed panel from anywhere in the BI launch pad—for example, on a new tab or when viewing a document via an OpenDocument link.

1. Select a document, and click < on the details panel.
   The details panel opens, with the Summary drawer open.
2. Click the Collaboration drawer at the bottom of the panel.
   The Collaboration drawer opens, showing the feed panel.
   If you are using SAP Jam, you are automatically logged on to it.
3. If you are using SAP StreamWork and this is the first time you are accessing the feed, log on to SAP StreamWork.
   After you are logged on, comments on documents and instances appear in the feed panel in the launch pad.
   To be notified about new comments on the document, you must follow the feed.
12.2.3 Resizing the feed panel

Resize the feed panel when you need more reading space. Click the left edge of the feed panel and drag it to the width you want.

12.3 Access rights for collaboration applications

<table>
<thead>
<tr>
<th>To perform this task</th>
<th>You need this access right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment on a document or an instance</td>
<td>Comment on documents</td>
</tr>
<tr>
<td>Comment on a document or an instance that you own</td>
<td>Comment on documents owned by the user</td>
</tr>
<tr>
<td>See a document or an instance</td>
<td>View comments on documents</td>
</tr>
<tr>
<td>See comments on a document or an instance that you own</td>
<td>View comments on documents owned by the user</td>
</tr>
</tbody>
</table>

12.4 Displaying an SAP StreamWork custom home page

You can monitor updates to the feeds you follow on an SAP StreamWork custom home page in the BI launch pad. Before you can display an SAP StreamWork custom home page, you must have the appropriate access rights.

When you add a module to a BI workspace in the launch pad and select the SAP StreamWork workspace, an SAP StreamWork custom home page appears by default beside the Home and Documents pages.

1. Select Applications ➤ BI workspace ➤.
2. Click Module Library to display all available modules, and click the BI launch pad modules icon to display a list of the modules you can add.
3. Drag the SAP StreamWork Feed module to the main pane of the window. An SAP StreamWork custom home page is added to the launch pad.
4. Click Exit Edit Mode in the upper-right corner, and click Yes to exit. The Save As dialog box appears.
5. In the Filename box, enter a title for the page. This text appears as the label on the SAP StreamWork page.
6. Beside Assign Category, select Personal Categories or Corporate Categories.
7. Click Save.
12.5 Document feeds

Document feeds enable you to monitor comments posted by other users and to participate in discussions.

You can monitor feeds on the Documents tab, on the feed panel, or on an SAP StreamWork tab (if available).

- For each document or instance for which you have the View comments on documents right and the View comments on documents owned by the user right, you can view discussions on the feed panel.
- For each document or instance for which you have the Comment on documents right and the Comment on documents owned by the user right, you can comment on discussions on the feed panel.

If you do not have the access right(s) needed for a document or an instance, contact your system administrator.

12.5.1 Refreshing a feed

You can refresh a feed to see the latest comments on a document or instance, without refreshing the entire document.

For example, this is helpful when a report is pinned to a tab in the BI launch pad and you want to refresh feeds for the report without refreshing the report.

Click 🔄 beside the Post button at the top of the feed panel.

12.5.2 Following a feed

If you want to be notified about new comments on the document, you must follow the feed.

Before you can follow a feed, you must have the following rights for the document or instance:

- View comments on documents
- View comments on documents owned by the user

Existing comments on a document appear the first time you view the feed for a document or an instance. When you follow a feed on the feed panel, you automatically follow all related instances of the document. When you follow a recurring instance, you follow each instance that results from the original instance.

On the Documents tab, right-click a document or instance and select Follow.

Comments for the feed appear on the feed panel, and the Collaboration column displays the 🔄 icon for the document or instance.

12.5.3 Viewing collaboration comments for an instance on a new tab

1. On the Documents tab, right-click an instance in a folder and select History.
2. In the History dialog box, right-click the instance and select View Latest Instance. The instance opens on a new tab in the default viewer.

3. In the viewer, click < on the left side of the details panel to open the panel.

4. Click the Collaboration drawer to open it.

12.5.3.1 Following a feed for an instance on a tab

When you follow a feed, you automatically follow all related instances of the document. When you follow a recurring instance, you follow each instance that results from the original instance.

While viewing a document or instance on a tab, click at the top of the feed panel.

The feed appears in the feed panel, you receive updates on the instance, and appears in the Collaboration column on the Documents tab in the BI launch pad.

12.5.4 Viewing collaboration comments via an OpenDocument link

Once a document or instance is open, you can view comments for the document or instance by expanding the Collaboration drawer on the feed panel.

You can view an OpenDocument link on a tab or by clicking the link. For example, it can be helpful when you need to open several instances at the same time.

1. Right-click an OpenDocument link and select Open in a new tab. The document or instance opens on a new tab in the browser.

2. If the feed panel is closed, click < on the left side of the panel to open it. The feed panel opens on the tab beside the document or instance.

3. Click the Collaboration drawer to open it.

The drawer opens, showing comments for the document or instance.

12.5.4.1 Following a feed from an OpenDocument link

When you follow a feed, you automatically follow all related instances of the document. When you follow a recurring instance, you follow each instance that results from the original instance.

While viewing a document or instance via an OpenDocument link, click at the top of the feed panel.

The feed appears in the feed panel, you receive updates on the document or instance, and appears in the Collaboration column on the Documents tab in the BI launch pad.
12.5.5  Posting a comment to a feed

You can post comments to a feed about a document or an instance and view the discussion on the feed panel.

Before you can comment on a document or instance, you must have the following rights for it:

- Comment on documents
- Comment on documents the user owns

When you comment on an instance of a report, the comment is posted only for the instance (not the entire report) and a new discussion is started for that instance. Comments and replies are not private. Any BI launch pad user with the appropriate view rights to a document or instance can see your comments, and any user who with appropriate comment rights can reply to your comments.

1. In the Collaboration drawer on the feed panel, select an instance in the list.
2. Enter a comment in the Say something box, and click Post.

The comment appears on the feed panel, and 🤷‍♂️ appears in the Collaboration column to indicate this feed has a comment.

12.5.6  Stopping following a feed

When you no longer want to follow comments for a document or instance, you can stop following its feed.

On the Documents tab, right-click a document or instance and select Unfollow.

You no longer receive updates on the document or its instances, and 🤷‍♂️ no longer appears in the Collaboration column.

12.5.6.1  Stopping following a feed from an OpenDocument link

While viewing a document or instance via an OpenDocument link, click 📝 at the top of the feed panel.

You no longer receive updates on the document or its instances, and 🤷‍♂️ no longer appears in the Collaboration column on the Documents tab.

12.6  Scheduling content to SAP StreamWork

You can schedule Crystal reports, Web Intelligence documents, and PDF files to SAP StreamWork.

1. On the Documents tab, right-click the document or the instance that you want to schedule and select Schedule.
The Schedule dialog box appears.

2. Click Destinations, and then select Collaboration in the Destination list.
   The file name appears in the File box.

3. To save this instance in the History dialog box, select the Keep an instance in the history check box.

4. In the Select Worklist list, enter the name of the worklist to schedule or select a name in the list.

5. In the Select Activity list, enter the name of the activity to schedule or select a name in the list.
   As you type, the list of available activities is sorted by your entry.
   The activity you selected appears in the Activity Name box, and the activity objectives, if defined, appear in the Activity Objectives box.

6. (Optional) In the Item Description box, enter a description of the content you are scheduling.

7. (Optional) In the Select Activity Type box, select the type of activity you are scheduling.

8. (Optional) In the Add Participants box, enter each email address to invite to the activity, separating the email addresses with a comma.
   SAP StreamWork sends an invitation to each email address you enter.

9. Click Schedule.

   The History dialog box appears, displaying the scheduled job as an instance with a status of Running.

12.7 Sending content to SAP StreamWork

   You can send Crystal reports, Web Intelligence documents, and PDF files to SAP StreamWork, where you can choose an existing activity or create one. The activity determines where a document appears in SAP StreamWork.

   To save the instance in the History dialog box, select Keep an instance in the history.

1. On the Documents tab, right-click the document or the instance that you want to send and select Send Collaboration.
   The first time you choose this option, the SAP StreamWork logon window appears. The next time you choose it, SAP StreamWork opens in the BI launch pad and displays your recent activities.

2. If necessary, log on to SAP StreamWork.
   Your account is authenticated.

3. In the Select Worklist list, enter the name of the worklist to send or select a name in the list.

4. In the Select Activity list, enter the name of the activity to send or select a name in the list.
   As you type, the list of available activities is sorted by your entry.
   The activity appears in the Activity Name box, and the activity objectives, if defined, appear in the Activity Objectives box.

5. (Optional) In the Item Description box, enter a description of the content you are sending.

6. (Optional) In the Select Activity Type box, select the enter of activity you are sending.

7. (Optional) In the Add Participants box, enter each email address that you want to invite to the activity, separating the email addresses with a comma.
   SAP StreamWork sends an invitation to each email address you enter.

8. Click Send.
   A summary dialog box appears, showing which activity was created, which file was included, which participants were invited to join, and a link to the activity in SAP StreamWork.
9. Click the link to go to the activity.

SAP StreamWork opens in a new browser window. New activities may take several minutes to appear, depending on the server load. The window displays a document icon for the activity. To open the document, you may need a viewer. To return to the launch pad, click the OpenDocument link.
13 Alerting

13.1 Alerting concepts

Alerts notify you about changes and notify users and administrators when events are triggered. Use alerting to manage objects and events on the basis of exception.

Subscribing to alerts

In the BI platform, users and administrators can subscribe to alerts in the BI launch pad or in the Central Management Console (CMC).

Enabling alerts

When new reports are created, report designers enable alerts. As events are triggered, notifications are sent to subscriber email addresses or to a BI system destination (for example, a launch pad account).

Viewing alert notifications

In the platform, users and administrators view notifications in the launch pad or in an email.

Right-click an alert and select See More to display alert information, including the alert's title, message, and trigger time.

Managing alerts

Content administrators and power users manage alerts in the launch pad or in the CMC.

System administrators manage alerts in the CMC and control user access by assigning access rights.

Example

Alerting and Crystal reports

For example, Julie works at an auto insurance company and tracks the number of claims filed using a Crystal report. Julie subscribes to the daily Claim Number alert and chooses to receive her alert notification by email. After a week, the number of auto insurance claims reaches 10,000, meeting the alert's condition and triggering the alert. Julie receives an email notification and realizes that auto insurance claims have increased dramatically. She informs her manager and recommends launching a campaign to promote safer driving habits.
13.1.1 Alert sources

Monitoring uses alerting to notify system administrators of changes in the overall health of the BI platform.

Alerts based on monitoring probes are located in the Monitoring Events folder, in the Events area of the CMC. For more information about monitoring, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

Objects created in applications such as Information Steward and Event Insight also use alerting. For more information, see the application’s documentation.

<table>
<thead>
<tr>
<th>Object that supports alerting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal reports</td>
<td>Crystal reports can contain multiple alerts. When you add a report containing alerts to the repository, the BI platform automatically creates event objects that correspond to each alert in the report. Event objects are located in the Crystal Reports Events folder, under Events, in the Central Management Console (CMC). You can search for alerts using Content Search. Only reports created in the platform support alerting and allow users to subscribe to alert notifications when the reports are added. To subscribe, locate the report, and perform the subscription task on the report object.</td>
</tr>
<tr>
<td>Events (file-based, schedule-based, and custom)</td>
<td>You can enable alerting for any event.</td>
</tr>
</tbody>
</table>

13.1.2 Differences between alerting and Crystal report alert notifications

In earlier versions of the BI platform, you could configure Crystal report alert notifications when you scheduled reports. The platform still supports this functionality for reports created in SAP Crystal Reports.

<table>
<thead>
<tr>
<th>Key difference</th>
<th>Alert notifications in Crystal reports</th>
<th>Alerting in BI launch pad</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported objects</td>
<td>Reports created in Crystal Reports</td>
<td>• Reports created only in Crystal Reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitoring probes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Information Steward alerts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Event Insight alerts</td>
</tr>
<tr>
<td>Supported destinations</td>
<td>Email</td>
<td>• <strong>My Alerts</strong> in BI launch pad</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Email</td>
</tr>
</tbody>
</table>
13.1.3 Alerting workflow

Alerting workflow for Crystal reports

1. The report creator designs a report that contains alerts in SAP Crystal Reports for Enterprise.
2. The report creator or a content administrator adds the Crystal report to a folder in the Folders or Personal Folders area of the Central Management Console (CMC). When the report is added, the BI platform automatically creates report event objects, based on the alerts in the report.
3. A user logs on to the CMC or to the BI launch pad, locates the Crystal report, and subscribes to the alert.
4. The report creator or a content administrator schedules the Crystal report to run. If the alert condition is met, the alert is triggered and the user receives notification according to the subscription settings.

Alerting workflow for events

1. The content administrator creates an event in the CMC and enables alerting on the new event.
2. The user sees the alert in the Events area of the CMC or searches for the alert in the launch pad, and subscribes to it.
3. The event occurs, triggering the alert.
4. The user receives notification that the event occurred according to the subscription settings.
### 13.1.4 Access rights required for alerting

Depending on your role in the alerting workflow and your responsibilities, the access rights you need may vary.

**Table 11: Document alert rights**

<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
</table>
| User            | Subscribe to a document alert         | • View rights on the document  
|                 |                                      | • View rights on the corresponding event  
|                 |                                      | • Subscribe rights on the user's own account  
|                 |                                      | To view an instance via a document link in an alert notification, you must also have View Instance rights on the document. |
| User            | Unsubscribe from a document alert     | • View rights on the corresponding event  
|                 |                                      | • Subscribe rights on the user's own account  
| User            | Receive notification about a document alert | • View rights on the corresponding event  
|                 |                                      | • View rights on the document  
| Content administrator | Manage destination and parameter settings for a document alert | • Edit rights on the document  
|                 |                                      | • Edit rights on the event  
| Content administrator | Manage alerting settings for a document | • View rights and Edit rights on the document  
|                 |                                      | • View rights and Edit rights on the corresponding event  
|                 |                                      | • View rights and Subscribe rights on the users or groups to add as subscribers  
|                 |                                      | To add a user group to the list of subscribers, you must also have View rights and Subscribe rights on the user group object. Having View rights and Subscribe rights on individual users in a group is not sufficient. |
| Content administrator | Unsubscribe a user from a document alert | • View rights on the document  
|                 |                                      | • View rights on the corresponding event  
|                 |                                      | • View rights and Subscribe rights on the user  
| Content administrator | Trigger a document alert | • View rights and Schedule rights on the document  
|                 |                                      | • View rights and Trigger rights on the corresponding event  

© 2014 SAP SE or an SAP affiliate company. All rights reserved.
Table 12: Event alert rights

<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Subscribe to an event alert</td>
<td>• View rights on the event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subscribe rights on the user’s own account. By default, each user has Subscribe rights on her or his own account.</td>
</tr>
<tr>
<td>User</td>
<td>Unsubscribe from an event alert</td>
<td>• View rights on the event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subscribe rights on the user’s own account. By default, each user has Subscribe rights on her or his own account.</td>
</tr>
<tr>
<td>Content administrator</td>
<td>Manage alerting settings for an event</td>
<td>• View rights and Edit rights on the event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights and Subscribe rights on users or groups to add as subscribers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To add a user group to the list of subscribers, you must also have View rights and Subscribe rights on the user group object. Having View rights and Subscribe rights on individual users in a group is not sufficient.</td>
</tr>
<tr>
<td>Content administrator</td>
<td>Trigger an event</td>
<td>View rights and Trigger rights on the event</td>
</tr>
</tbody>
</table>

Table 13: Alert notification rights

<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Receive an alert notification</td>
<td>View rights on the corresponding event</td>
</tr>
<tr>
<td>User</td>
<td>Mark an alert notification as read or unread</td>
<td>• View rights on the alert notification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subscribe rights on the user account</td>
</tr>
<tr>
<td>User</td>
<td>Reread an alert notification</td>
<td>View rights on the alert notification</td>
</tr>
<tr>
<td>User</td>
<td>Delete an alert notification in BI launch pad</td>
<td>• View rights on the alert notification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subscribe rights on the user account</td>
</tr>
</tbody>
</table>

13.1.5 Alert source objects

The way that you view alert sources depends on the object type of the alert source.

The following table summarizes where alert sources are located:
Crystal report can be stored in personal folders or in public folders.

- To view a Crystal report in a personal folder, on the Documents tab, click the My Documents drawer, and click the Favorites node. The Crystal report appears.
- To view a Crystal report in a public folder, on the Documents tab, click the Browse Folders drawer, and locate the folder containing the report.

If you subscribe to an alert, you can quickly view it. On the Documents tab, expand the My Documents drawer, and click Subscribed Alerts.

### 13.1.6 Alert notifications

Alert notifications can be sent to a destination in the BI launch pad or to a subscriber email address.

You can view alert notifications in two ways in the launch pad:

- On the Home tab, click Unread Alerts to display a list of your last 10 unread alert notifications.
- On the Documents tab, click the My Documents drawer, and click My Alerts to display alert notifications.

The Alert Information dialog box displays the alert message and the date and time when the alert was triggered. To display alert information, perform any of the following actions:

- On the Home tab, click a notification under Unread Alerts.
- In My Alerts, double-click an alert title.
- In My Alerts, right-click an alert title and select See More.

### 13.2 Subscribing to an alert

1. Right-click the alert source in the public folder and select Subscribe.
2. In the Subscribe to Publication dialog box, under Destinations:
   - To send the alert notification to a destination in the Business Intelligence (BI) system, such as the BI launch pad, select the InfoView Inbox check box.
   - To send the alert notification to the email address specified for your user account in the BI platform, select the Email check box, and confirm that your email address is entered correctly. This destination is available if an email address is specified for your user account. If your email address is specified but is incorrect or not entered, you will not receive the alert notification.
3. To specify a parameter for the alert, under **Parameters**, click **Edit**, and modify the parameter value. If a document is personalized, personalization details appear when you hover the mouse over an alert check box.

4. If multiple documents are listed under **Alert**, select the check box beside each alert you want to receive. Depending on the alert source, you may need to configure additional settings.

5. Click **OK**.

The next time the alert is triggered, a notification will be sent to the destination you selected. Notifications are sent using the destination defaults for alerting in the CMC, unless you specify custom settings for an alert source.

To change which destinations an alert notification will be sent to, on the **Documents** tab, expand the **My Documents** drawer, and click **Subscribed Alerts**. Right-click an alert source and select **Modify Subscription**. You can also select **More Actions** > **Modify Subscription** to modify your subscription to multiple Crystal report alerts from the same report or to edit parameters for EDBI alerts.

### 13.2.1 Unsubscribing from an alert

1. On the **Documents** tab, expand the **My Documents** drawer, and click **Subscribed Alerts**.
2. Right-click the alert from which to unsubscribe and select **Unsubscribe**.
3. When prompted for confirmation, click **OK**.

### 13.3 Subscribing other users to an alert

1. Right-click the alert source and select **Manage Subscribers**.
2. In the **Manage Subscribers** dialog box, click **Subscriber List** in the navigation panel.
3. To add new subscribers:
   a) Click **Add**.
   b) In the **Add** dialog box, move users and user groups from the **Available** list to the **Subscribed** list
   c) Click **Add Default Subscription(s)**.
   d) In the **Edit Subscriptions** dialog box, configure the alert and destination options as needed.

   For example, you can modify which alerts to subscribe to (if the alert source contains multiple alerts). Depending on the alert source, other settings may be available.

4. To edit settings for a subscriber:
   a) Select a user in the **Subscriber** column, and click **Edit**.
   b) To edit which alerts the user will receive, in the **Edit Subscriptions** dialog box, click **Alerts** in the navigation panel, and select the check box for each alert you want to subscribe the user to.

   If the alert source contains multiple alerts, each alert is listed. Otherwise, only one alert appears.
   c) To edit which destinations an alert will be sent to, click **Destinations** in the navigation panel, and select the check box for each destination you want to send the alert to.

   Only email destinations that are enabled and configured on the Adaptive Job Server are available. If no email destination is configured, only the **My Alerts** check box appears.
d) If available, configure other alerting options as needed.
   Depending on the alert source, additional options may be available.
e) Click Save & Close.

5. Click Save & Close.

### 13.4 Excluding users from an alert

You can exclude users from an alert when you want to subscribe most, but not all, users in a group to the alert. First, you subscribe the entire group, and then you exclude users who do not need to receive alert notifications.

The **Excluded** list overrides all other subscription settings for a user.

1. Right-click the alert source and select **Manage Subscribers**.
2. In the **Manage Subscribers** dialog box, click **Excluded List** in the navigation panel.
3. Move users from the **Available** list to the **Excluded** list.
4. Click Save & Close.

### 13.5 Managing custom alerting settings for an alert source

Notifications are typically sent using the default destination settings for alerting.

1. Right-click the alert source and select **Manage Alerting Settings**.
2. In the **Manage Alerting Settings** dialog box, select the **Enable My Alerts** check box to choose the BI launch pad as a destination.
   Alert notifications will be sent to the subscriber’s BI launch pad accounts. In the launch pad, subscribers can view alerts in **My Alerts** on the **Documents** tab.
3. To choose email as a destination, select the **Enable Email** check box.
4. Select **Use default email settings** to use the default alerting settings for email, or select **Use custom email settings** and perform the following actions as needed:
   a) In the **From** box, enter a return email address, or select variables for the email address from the **Add placeholder** list.
   b) In the **To** box, enter each email address that you want to send alert notifications to, or select variables for the email address from the **Add placeholder** list.
   c) In the **Cc** box, enter each email address that you want to send alert notifications to, or select variables for the email address from the **Add placeholder** list.
   d) In the **Bcc** box, enter the email address of each undisclosed recipient that you want to send alert notifications to, or select variables for the email address from the **Add placeholder** list.
   e) In the **Subject** box, enter the subject of the alert notification, or select variables for the subject from the **Add placeholder** list.
   f) In the **Message** box, enter the message for the body of the alert notification, or select variables for the message from the **Add placeholder** list.
g) Select the Add Attachment check box to add an attachment to the alert notification.

h) Under File Name, select Use Automatically Generated Name or Use Specific Name. If you select Use Specific Name, enter a file name or select a placeholder in the list.

i) Select the Add File Extension check box to automatically a file extension to file names. If you do not add a file extension to a file name, the document cannot be opened.

5. Click Save & Close.
14 Applications and the BI launch pad

14.1 Working with applications in the BI launch pad

The BI launch pad is an integration point between the repository and these SAP BusinessObjects applications:

- Analysis, edition for OLAP
- BEx Web
- BI workspaces
- Crystal Reports for Enterprise
- Web Intelligence

In the launch pad, you can start an application and then create, view, and edit corresponding objects and save your changes or new objects directly to the repository. The applications available and the tasks you can perform in them are determined by your access rights, which your system administrator assigns.

14.2 Starting an application in the BI launch pad

There are two ways to start an application in the BI launch pad.

Perform either of the following actions:

- On the **Home** tab, click the application in the **My Applications** module.
- On the **header** panel, from the **Applications** menu, select the application.

The application you selected opens in a new window.

14.3 BEx web applications in the BI launch pad

You can use BEx web applications in the Business Explorer (BEx) of Business Warehouse (BW) for data analysis, reporting, and analytical tasks.

BEx is the SAP Business Intelligence suite. It provides flexible reporting and query, reporting, and analysis tools for strategic decision-making support in a business. As an employee with access authorization, you can use BEx web applications to evaluate historical or current data at various levels of detail and from different perspectives, on the web and in Microsoft Excel. You can access data from the SAP Enterprise portal or from the BI launch pad in the BI platform.

Before you can open BEx web applications in the launch pad, your system administrator must configure a platform server and a connection to a BW system. Authors of BEx web applications format data from SAP BW in the BEx Web Application Designer, using web items (analysis, filter pane, chart, map, document, and so on). Once the platform server and connection to a BW system are configured, you can open BEx web applications in the launch pad, navigate the data, and save the navigational state of BEx web applications as bookmarks in your browser favorites.
14.3.1 Accessing BEx web applications in the BI launch pad

**Note**

You can use information broadcasting only in BEx web applications that run in a SAP NetWeaver landscape (not in BI launch pad or BI platform). Information broadcasting requires SAP NetWeaver components, such as the Enterprise Portal and Knowledge Management.

1. Log on to the BI launch pad.
2. Perform one of the following actions:
   - On the *Home* tab, click *BEx Web Applications* in the *My Applications* module.
   - On the header panel, click *Applications ➤ BEx Web Applications*.
3. Log on to the NetWeaver Business Warehouse (BW) system.
4. In the *Open* dialog box, select a BEx web template.
   - You can select only BEx web templates with data sources that are stored in the BW master system. Your system administrator defines which BW system is configured as the BW master system in BI platform.
   - The BEx Web application opens, and you can navigate data in it.

14.3.2 Saving BEx web applications as bookmarks

Before creating a bookmark, choose which BEx navigational state to bookmark for later use. To decide, on a *BEx* tab in the BI launch pad, navigate to the data and select a navigational state.

1. In the context menu for the BEx web application, select *Distribute and Export ➤ Bookmark*.
   - Depending on the BEx configuration, the *Bookmark* option may be available on the context menu or as a button.
2. Save the BEx web application in a favorites folder in your browser.

After logging on to the BW system, you can access the BEx bookmark in your favorites or send it as a link to other users. For information about BEx Web Application Designer, web items, and web design API commands, go to the SAP Help Portal at [http://help.sap.com](http://help.sap.com), and click *SAP NetWeaver*. 
15 Working with discussions

You can use discussions to post notes to other BI platform users about reports, hyperlinks, programs, and BI platform objects. You can add notes or create a discussion thread for any object you can access. Related notes are organized in a hierarchy.

Discussions are disabled by default. Before you can use discussions, your system administrator must enable discussions for the BI launch pad and assign view rights to objects and associated notes that you can view. For more information, contact your system administrator.

Users with appropriate access rights can view your notes and add comments to a discussion thread.

15.1 Opening the Discussions drawer

Discussions notes and threads for each object are located in the Discussions drawer on the details panel.

1. On the Documents tab, select an object, and click < on the details panel.
   The details panel opens.
2. Expand the Discussions drawer.
   The drawer displays all notes and threads for the object you selected.

15.2 Adding a note

In order to add notes to an object, you must have the appropriate access rights for the object.

1. Open discussions.
2. Click .
3. In the Subject box, type the subject of the note.
   The maximum length of the subject is 255 characters.
4. In the Message box, type the body text of the note.
   The maximum length of the message is 1000 characters.
5. (Optional) Click to flag the note as very important or to flag the note as less important.
6. Click Post.
15.3 Editing a note

You can edit the notes that you create. However, you cannot edit notes created by other users or that have replies in a discussion thread, unless you have administrative rights.

1. Open discussions.
2. Locate and select the note to edit.
3. In the Subject box, edit the subject line of the note as needed.
4. In the Message box, edit the body text of the note as needed.
5. Click Post.

15.4 Replying to a note

You can post a reply to an entire group or to the user who posted the note. Notes that you have not read appear in bold.

Before you can reply to a note, you must have the appropriate access rights for the object.

1. Open discussions.
2. Locate and select the note to reply to.
   
   Click the plus sign (+) to view additional levels of the note’s discussion.
3. Click to post a reply that is visible to all users with access rights to view notes associated with the object, or click to post a reply to the user who posted the note.
4. In the Subject box, edit the subject line of the note as needed.
5. In the Message box, edit the body text of the note as needed.
6. Click Post.

15.5 Deleting a note

You cannot delete notes created by other users or notes containing replies to a discussion thread, unless you have administrative rights.

1. Open discussions.
2. Locate and select the note to delete, and click .
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of wilful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with “you”, or a gender-neutral noun (such as “sales person” or “working days”) is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or wilful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).